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PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

A. PENGENALAN CLOUD COMPUTING

Menurut National Institute of Standards and Technology (NIST), Cloud computing
merupakan suatu model yang memungkinkan akses jaringan dari mana pun berdasarkan
permintaan terhadap shared pool sumber daya komputasi yang dapat dikonfigurasi sebagai
contoh jaringan, server, penyimpanan, aplikasi dan layanan dan dapat dengan cepat
ditetapkan serta dilepas melalui usaha manajemen atau interaksi dengan penyedia layanan

yang minimal.
Terdapat 5 (lima) karakteristik dasar dari Cloud Computing yaitu:
1. On-demand self-service.

Pengguna dapat secara sepihak atau mandiri dalam mengelola kemampuan komputasi,
seperti waktu server dan penyimpanan jaringan, disesuaikan dengan kebutuhan secara

otomatis tanpa memerlukan interaksi dengan penyedia layanan.
2. Broad network access.

Kapabilitas tersedia melalui jaringan dan dapat diakses melalui mekanisme standar baik
menggunakan platform thin maupun thick seperti mobile phone, tablet, laptop dan

workstation.
3. Resource pooling.

Sumber daya komputasi penyedia Cloud dikumpulkan untuk melayani banyak konsumen
menggunakan model multi-tenant, dengan sumber daya fisik dan virtual yang berbeda
secara dinamis dapat ditetapkan dan dilepas kembali sesuai dengan permintaan

konsumen.
4. Rapid elasticity.

Kapabilitas dapat secara elastis diatur. Pada beberapa kasus dapat secara otomatis

ditambahkan atau dikurangi sesuai dengan permintaan konsumen.
5. Measured service.

Sistem cloud secara otomatis dapat mengontrol dan mengoptimalkan penggunaan sumber

daya dengan memanfaatkan kemampuan pengukuran pada beberapa tingkat abstraksi
'
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sesuai dengan jenis layanan. Sebagai contoh penyimpanan, pemrosesan, bandwidth, dan
akun pengguna aktif. Penggunaan sumber daya dapat dipantau, dikendalikan dan
dilaporkan sehingga transparan baik bagi penyedia layanan maupun konsumen sebagai

pengguna layanan.
NIST membagi model layanan cloud computing menjadi 3 (tiga) jenis yaitu:

1. Software as a Service (SaaS)
Kemampuan yang diberikan kepada pengguna untuk menggunakan aplikasi yang
berjalan pada infrastruktur cloud dan tanpa melakukan pengaturan atau pengontrolan
pada infrastruktur dasar dari cloud meliputi jaringan, server, sistem operasi,
penyimpanan, dengan kemungkinan pengecualian pengaturan konfigurasi pada
aplikasi pengguna tertentu secara terbatas.

2. Platform as a Service (PaaS)
Kemampuan yang diberikan kepada pengguna untuk mengembangkan aplikasi yang
berjalan pada infrastruktur cloud atau aplikasi yang diperoleh dibuat menggunakan
bahasa pemrograman, library, layanan dan tools yang didukung oleh penyedia layanan
serta tanpa melakukan pengaturan atau pengontrolan pada infrastruktur dasar dari
cloud tetapi memiliki control terhadap pengembangan aplikasi.

3. Infrastructure as a Service (laaS)
Kemampuan yang disediakan bagi pengguna untuk mengembangkan pemrosesan,
penyimpanan, jaringan dan sumber daya komputasi dasar lainnya sehingga pengguna
mampu mengembangkan dan menjalankan program dengan leluasa termasuk sistem
operasi dan aplikasi. Pengguna tidak perlu melakukan pengaturan atau pengontrolan
pada infrastruktur dasar dari cloud tetapi memiliki kontrol terhadap sistem operasi,

penyimpanan dan aplikasi yang dikembangkan.
Menurut NIST, terdapat 4 (empat) model pengembangan cloud computing antara lain:

1. Private Cloud
Infrastruktur cloud yang ditetapkan untuk digunakan secara ekslusif oleh satu
organisasi yang terdiri dari beberapa konsumen seperti unit bisnis dan dimiliki,
dimanajemen, dioperasikan oleh organisasi, pihak ketiga, atau gabungannya serta

dapat bertempat di dalam atau diluar lokasi pengguna.
-
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2. Community Cloud
Infrastruktur cloud yang ditetapkan untuk digunakan oleh komunitas pengguna
tertentu dari organisasi-organisasi dengan urusan yang sama dan dimiliki,
dimanajemen, dioperasikan oleh organisasi pada komunitas, pihak ketiga, atau
gabungannya serta dapat bertempat di dalam atau diluar lokasi pengguna.

3. Public Cloud
Infrastruktur cloud yang ditetapkan untuk digunakan secara terbuka oleh publik atau
masyarakat umum dan dimiliki, dimanajemen, dioperasikan oleh perusahaan,
akademik, atau organisasi pemerintah atau kombinasinya serta bertempat di penyedia
layanan cloud.

4. Hybrid Cloud
Gabungan dua atau lebih infrastruktur cloud berupa private, community, atau public
yang tetap merupakan entitas unik namun dikaitkan bersama oleh standar atau
teknologi tertutup (proprietary) sehingga memungkinkan portabilitas data dan

aplikasi.

B. PENGENALAN OPENSTACK

OpenStack merupakan perangkat lunak yang dapat digunakan untuk membangun
Cloud Computing dengan jenis Infrastructure as a Service (laaS). Openstack memiliki
kemampuan dalam mengontrol sekumpulan sumber daya virtual baik komputasi,
penyimpanan maupun jaringan pada pusat data yang dikelola dan disediakan melalui
Application Programming Interface (API) dengan mekanisme otentikasi. APl merupakan
antarmuka perangkat lunak yang memungkinkan sebuah aplikasi memberikan akses ke

aplikasi lainnya dengan fungsi dan struktur data yang telah didefinisikan.

Pengguna dapat berinteraksi dengan OpenStack melalui berbagai cara meliputi antar
muka berbasis web Horizon Dashboard, Command Line Interface (CLI) maupun Software
Developmenet Kit (SDK). Selain fungsionalitas infrastruktur sebagai layanan standar,
OpenStack juga memiliki komponen tambahan sehingga menyediakan fitur orkestrasi,
manajemen kegagalan dan manajemen antar layanan yang ada untuk memastikan

ketersediaan yang tinggi bagi pengguna.
- -
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Deploy third party services such as Or use built in tools

(oo [ eee ]
OpenStack SDK

Kubernetes CloudFoundry Terraform Horizon Web Ul

-
o

Containers

Virtual Machines

Bare Metal

1] Shared networking and storage resources @

¢_: openstack.

Sumber gambar: openstack.org/software

Arsitektur OpenStack terdiri dari berbagai komponen, seperti terlihat pada gambar

berikut:
OPENSTACK
CLIENT TOOLS ] WEB FRONTEND ————— =2 API PROXIES
@ Horizon EC2API
PERATIONS TOOLING
OpenStackClient & e o] O 0
— Qo 'WORKLOAD PROVISIONING ——— =~ APPLICATION LIFECYCLE “' ORCHESTRATION . O MONITORING SERVICES —
Magnum  Trove Murano Freezer Heat Mistral Aodh p
————— & SDKs X i Ceilometer
Sahara Solum Masakari Senlin Zagar Blazar
Python SDK Monasca  Venus
—— == COMPUTE Sstorace
= s — (@) RESOURCE OPTIMIZATION —
.m. Watcher Vitrage
Nova Zun Swift Cinder Manila
INTEGRATION ENABLERS -
. - @ BILLING / BUSINESS LOGIC —
i) CONTAINER SERVICES LIFECYCLE . ’
'*' ETNOR: il Adjutant  CloudKitty
Kuryr =
Neutron Octavia Designate Ironic Cyborg § TESTING / BENCHMARK
.
I8INFV
* Tempest Patrole
Tacker @ SHARED SERVICES Rally
| _ioenmiy | | screouuinG | | imaces | | secrers |
Keystone Placement Glance Barbican
LIFECYCLE MANAGEMENT
” - P DEPLOYMENT / LIFECYCLE TOOLS — - *' PACKAGING RECIPES FOR...
Kolla-Ansible OpenStack-Charms TripleO Bifrost Kayobe Puppet

Version 2022.10.01

OpenStack-Helm OpenStack-Ansible OpenStack-Chef

Containers (LOCI, Kolla)

Sumber gambar: openstack.org/software

Terdapat 6 (enam) komponen inti dari OpenStack meliputi:
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a)

b)

c)

d)

f)

Nova merupakan komponen layanan komputasi (compute) yang digunakan untuk
mengelola sumber daya di lingkungan virtual seperti Virtual Machine (VM) atau
instance.

Keystone merupakan komponen layanan identity yang digunakan untuk menyediakan
otentikasi dan otorisasi terhadap seluruh layanan OpenStack.

Neutron merupakan komponen yang mengelola layanan jaringan (networking) seperti
pengalokasian alamat Internet Protocol (IP) baik secara statik maupun dinamis melalui
Dynamic Host Configuration Protocol (DHCP), router dan memastikan agar antar
komponen pada OpenStack dapat terhubung atau terkoneksi.

Glance merupakan komponen yang menyediakan layanan penemuan, registrasi dan
pengiriman disk images. Ketika instance di boot maka memerlukan penyediaan disk
image yang memuat sistem operasi, sebagai contoh cirros.

Swift merupakan komponen yang menyediakan layanan object storage dengan
toleransi kegagalan yang tinggi sehingga dapat digunakan untuk menyimpan dan
mengakses objek data tidak terstruktur melalui API.

Cinder merupakan komponen yang menyediakan layanan block storage sehingga

dapat digunakan untuk memberikan penyimpanan virtual bagi instance pada sistem.

Informasi lebih lanjut terkait OpenStack dapat diakses di alamat www.openstack.org.

Untuk memperluas wawasan dan pengetahuan maka pada panduan ini akan dibahas

tentang praktik mengadministrasi Cloud Computing berbasis OpenStack menggunakan studi

kasus berbentuk skenario.

C. STUDI KASUS ADMINISTRASI SUMBER DAYA VIRTUAL CLOUD COMPUTING BERBASIS

OPENSTACK MELALUI HORIZON DASHBOARD DAN COMMAND LINE INTERFACE (CLI)

Lakukan administrasi sumber daya virtual cloud computing berbasis OpenStack baik

melalui Horizon Dashboard maupun melalui Command Line Interface dengan skenario studi

kasus, seperti terlihat pada gambar berikut:
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Domain Default

Project admin 8
provider-network-belajar admin

O NIM
) (0827068001)

network2-belajar

Project belajar-NIM
(belajar-0827068001)

networkl-belajar

router-belajar

Pool: .50-.75 Pool: .225-.250 |
b o
;g Floating IP: 172.16.0.123 Floating IP: 172.16.0.234 gj
instance123 instance234

Adapun ketentuan administrasi sumber daya virtual yang dilakukan pada OpenStack adalah

sebagai berikut:

1. Login sebagai user “admin” dan dan password “admin” serta lakukan pembuatan
project dengan nama "belajar-NIM". Ganti kata NIM dengan Nomor Induk Mahasiswa
masing-masing, sebagai contoh 0827068001.

2. Buat user dengan ketentuan sbg berikut:

e Nama login: "NIM". Ganti kata NIM dengan nim masing-masing.
e Sandi: "12345678".
e Project: belajar-NIM.

e Role: _member._.
Ganti kata NIM dengan Nomor Induk Mahasiswa masing-masing.

3. Buat provider network untuk project “belajar-NIM” agar dapat mengkoneksikan ke
Internet atau external dengan nama "provider-network-belajar" dan subnet bernama
"provider-subnet-belajar" dengan alamat 172.16.0.0/24 serta alokasi pengalamatan
ke instance secara manual atau statik. Ganti kata NIM dengan Nomor Induk Mahasiswa
masing-masing.

4. Buat 2 (dua) floating IP dengan alamat IP 172.16.0.123 dan 172.16.0.234 pada

provider-network-belajar.
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5.

10.

Login sebagai user "NIM" ke OpenStack dan lakukan screenshot hasil pembuatan
provider network dan subnet dengan mengakses network topology. Ganti kata NIM
dengan Nomor Induk Mahasiswa masing-masing.

Mengupload image cirros terbaru dengan ketentuan sebagai berikut:

e Nama image: cirros-belajar

e Description: Image Cirros untuk pembelajaran
e File: cirros-0.4.0-x86_64-disk.img

e Format: QCOW?2.

e Disk size: 1GB

e Memory: 512MB.

e Visibility: Private

e Protected: No.

Buat 2 (dua) internal network dengan ketentuan sebagai berikut:

a) Nama network menggunakan "network1-belajar", dengan nama subnet "subnet1-
belajar" dan alamat subnet 192.168.123.0/24 serta mengalokasikan alamat ke
instance secara DHCP mulai dari 192.168.123.50 sampai dengan 192.168.123.75.

b) Nama network menggunakan "network2-belajar", dengan nama subnet "subnet2-
belajar" dan alamat subnet 192.168.234.0/24 serta mengalokasikan alamat ke
instance secara DHCP mulai dari 192.168.234.225 sampai dengan
192.168.234.250.

Buat router dengan nama '"router-belajar" untuk menghubungkan ke external

network dan ke 2 (dua) internal network yg telah dibuat sebelumnya. Lakukan verifikasi

hasil pembuatan provider network dan subnet dengan mengakses network topology.

Buat 2 (dua) security group dengan nama "allow-ping" yang memiliki rule untuk

mengijinkan akses ICMP ke instance dan "allow-ssh" yang memiliki rule untuk

mengijinkan akses SSH ke instance.

Membuat 2 (dua) instance masing-masing dengan nama instance123 pada network1-

belajar dan instance234 pada network2-belajar. Kedua instance tersebut wajib

menggunakan image cirros-uas, flavor m1.tiny dan security group default, allow-icmp
dan allow-ssh. Selain itu mengatur asosiasi floating IP 172.16.0.123 untuk instance123

dan 172.16.0.234 untuk instance234.

|
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11. Memverifikasi akses ping ke 2 (dua) instance pada OpenStack menggunakan referensi
alamat floating IP 172.16.0.123 dan 172.16.0.234 melalui terminal Bitvise SSH Client.
12. Memverifikasi akses SSH ke 2 (dua) instance pada OpenStack menggunakan referensi
alamat floating IP 172.16.0.123 dan 172.16.0.234 serta login menggunakan user cirros
dan password “gocubsgo”. Setelah berhasil login ke instance maka lakukan verifikasi
alamat IP menggunakan perintah ip address dan ping ke salah satu situs di Internet

sebagai contoh google.com.

D. MENGIMPORT OPEN VIRTUAL APPLIANCE (OVA) OPENSTACK KE ORACLE VIRTUALBOX

Sebelum dapat mengerjakan solusi dari studi kasus administrasi sumber daya virtual
pada OpenStack baik melalui Horizon Dashboard maupun Command Line Interface (CLI)
maka diperlukan proses import file Open Virtual Appliance (OVA) dari OpenStack dengan
nama “coa-aio-newton.ova” ke Oracle VirtualBox. File OVA tersebut dibuat oleh Matt Dorn

yang merupakan pengarang dari buku Preparing for the Certified OpenStack Administrator

Exam. Adapun langkah-langkah untuk mengimport file OVA dari OpenStack ke Oracle

VirtualBox adalah sebagai berikut:

1. Mengunduh file OVA melalui GitHub pada alamat

https://github.com/PacktPublishing /Preparing-for-the-Certified-OpenStack-

Administrator-Exam/blob/master/coa-aio-newton.ova. Sebagai contoh file OVA yang

telah diunduh disimpan pada Drive D di direktori COA (D:\COA), seperti terlihat pada

gambar berikut:

f — O x|
COA X +
@ Newv g @ B ® W Nsotv = View
| &« > v N « DATA (D) » COA v G Search COA PR
> Home I Name
> OneDrive D cirros-0.4.0-x86_64-diskimg %
“ coa-aio-newton.ova
@l Desktop »
2items 1 item selected 672 MB E O
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2. Mengunduh dan menginstalasi aplikasi Oracle VirtualBox dari situs

https://www.virtualbox.org. Pada halaman homepage dari situs VirtualBox, klik

tombol Download VirtualBox 7.0 untuk mengunduh versi terbaru dari VirtualBox,
seperti terlihat pada gambar berikut:

ol Oracle VM VirtualBox X+

& > C & virtualboxorg e vw ®» 0O '

I r u a ox Laks
Login  Preferences
Welcome to VirtualBox.org!

VirtualBox is a powerful x86 and AMD64/Intel64 virtualization product for enterprise as well as home use. Not only is | yews Flash
VirtualBox an extremely feature rich, high performance product for enterprise customers, it is also the only

professional solution that is freely available as Open Source Software under the terms of the GNU General Public . mlanuary 17th, 2023
About License (GPL) version 3. See "About VirtualBox" for an introduction. VirtualBox 7.0.6 released!
Oracle today released a 7.0
Screenshots Presently, VirtualBox runs on Windows, Linux, macOS, and Solaris hosts and supports a large number of guest "ﬁ‘:‘bf“ﬁf"/‘aa’:‘?ﬁr:é‘;ars:g‘:‘g;‘;’gr'lfgpsfgzes
Downloads operating systems including but not limited to Windows (NT 4.0, 2000, XP, Server 2003, Vista, Windows 7, Windows the Changelog for detals.

8, Windows 10), DOS/Windows 3.x, Linux (2.4, 2.6, 3.x and 4.x), Solaris and OpenSolaris, 0S/2, and OpenBSD.

Documentation [ January 17th, 2023

VirtualBox is being actively developed with frequent releases and has an ever growing list of features, supported VirtualBox 6.1.42 released!
End-user docs guest operating systems and platforms it runs on. VirtualBox is a community effort backed by a dedicated company: Oracle today released 2 6.1
everyone is encouraged to contribute while Oracle ensures the product always meets professional quality criteria. maintenance release which improves

stability and fixes regressions. See
the Changelog for details.

Contribute - [ november 18th, 2022
VirtualBox 7.0.4 released!
Oracle today released a 7.0
maintenance release which improves

Download
stability and fixes regressions. See

] the Changelog for details.
= B october 20th, 2022
. VirtualBox 7.0.2 released!
Oracle today released a 7.0
maintenance release which improves

stability and fixes regressions. See
the Chanaslon for detail

Technical docs

Panduan praktikum ini menggunakan VirtualBox versi 6.1. Untuk mengunduh versi
yang sama dengan panduan maka lakukan klik tautan atau /ink Downloads dari menu
navigasi sebelah kiri pada homepage VirtualBox. Tampil halaman Download
VirtualBox dan lakukan klik tautan atau link VirtualBox 6.1 builds untuk mengarahkan
ke halaman unduh versi tersebut, seperti terlihat pada gambar berikut:

ol Downloads - Oracle YM Virtuale: X 4

< C @& virtualbox.org/wiki/Downloads e v #» 0O '

I r y ﬂ o s
1 Login  Preferences
Download VirtualBox

Here you will find links to VirtualBox binaries and its source code.

About VirtualBox binaries

Screenshots By downloading, you agree to the terms and conditions of the respective license.

|D0Wﬂ‘06d5| If you're leoking for the latest VirtualBox 6.1 packages, sgeuirtua\Box 6.1 bui\ds]\/ers'\on 6.1 will remain supported until December 2023.

Documentation

VirtualBox 7.0.6 platform packages
End-user docs
= Windows hosts

Technical docs « =macOS / Intel hosts
) « = Developer preview for macOS / Arm64 (M1/M2) hosts
Contribute « Linux distributions
Community e = Solaris hosts
« =+ Solaris 11 IPS hosts

The binaries are released under the terms of the GPL version 3.
See the changelog for what has changed.

You might want to compare the checksums to verify the integrity of downloaded packages. The SHA256 checksums should be favored as the MD5
algorithm must be treated as insecure! b

Tampil halaman VirtualBox (Old Builds): VirtualBox 6.1 dan klik tautan atau link

Windows hosts, seperti terlihat pada gambar berikut:
'
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. v — (m] X |
pll Download_Old_Builds 6_1-Orac X =

< C' @ virtualbox.org/wiki/Download_Old_Builds_6_1 1 2 w ®» 0O '

Contribute

Technical docs

Community

[ ]
VI rt!('%l 9!
Download VirtualBox (Ol uilds): VirtualBox 6.1

The Extension Packs in this section are released under the VirtualBox Personal Use and Evaluation License. All other binaries are released under the terms
of the GPL version 2. By downloading, you agree to the terms and conditions of the respective license.

About o 6.1 SDK (6.1.42)
Screenshots « Virtug pleased January 17 2023)
Downloads 0 TMRosts
Documentation = Solaris hosts
o =+Solaris 11 IPS hosts
End-user docs o Linux Hosts:

= = Qracle Linux 9 / Red Hat Enterprise Linux 9
= = Oracle Linux 8 / Red Hat Enterprise Linux 8
= G Qracle Linux 7 / Red Hat Enterprise Linux 7 / CentOS 7

= = Ubuntu 20.04

= =Ubuntu 18.04 / 18.10 / 19.04

= Debian 11

= Debian 10

= = Debian 9

= =ropenSUSE 15.3/ 15.4

= =ropenSUSE 15.0

= =20penSUSE 13.2 / Leap 42 -
= Fadar: A 4

Atau dapat pula mengakses tautan berikut:

https://download.virtualbox.org/virtualbox/6.1.42/VirtualBox-6.1.42-155177-

Win.exe

Tunggu hingga proses unduh selesai dilakukan. Jika proses unduh tersebut telah selesai
maka lakukan eksekusi file installer VirtualBox-6.1.42-155177-Win.exe untuk
menginstalasi aplikasi tersebut.

Menjalankan aplikasi VirtualBox dengan mengakses shortcut Oracle VM VirtualBox
pada Desktop atau melalui icon Start pada taskbar Windows dan memilih menu Oracle
VM VirtualBox > Oracle VM VirtualBox, seperti yang ditunjukkan pada gambar
berikut:

N OneNote

- Oracle VM VirtualBox

"uE License (English)

§/ Oracle VM VirtualBox

D

E* User manual (CHM, English)

User manual (PDF, English)

£ fiype here to search

Menambahkan Network Address Translation (NAT) Network untuk menjembatani
Virtual Machine (VM) dapat terkoneksi ke Internet dengan mengakses menu File >
Preferences pada Oracle VM VirtualBox Manager, seperti yang ditunjukkan pada

gambar berikut:
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V¢ Oracle VM VirtualBox Manager

File Machine Help

Preferences.. Cirl+G |
4 Import Appliance... Ctrl+l
[Ry Export Appliance... Ctrl+E
&) New Cloud VM...
@ Virtual Media Manager... Ctrl+D
'E]J Host Network Manager... Ctrl+H
g Network Operations Manager...
@ Check for Updates...
A\ Reset All Warnings

@ Exit Ctrl+Q
Tampil kotak dialog VirtualBox — Preferences dan pada panel menu sebelah kiri pilih
Network. Pada panel detail dari Network di sebelah kanan, pilih icon Adds new NAT

Network, seperti yang ditunjukkan pada gambar berikut:

(55 VirtualBox - Preferences ? *

E\ General ‘ Network

%} Input NAT Netwiorks

fr) Active N
@ Update ive Name

@ Language
!I Display
E Network
D Extensions
EE| Proxy

| oK | | Cancel |

Terbentuk “NatNetwork” yang telah aktif, seperti terlihat pada gambar berikut:

(f’ VirtualBox - Preferences ? it

E\ General ‘ Network

@} Input NAT Networks

@ Update Active Name E
- | NatNetwork ] E
@ Language @

I oisplay
B Network
.| Extensions
L] oo {

| o | ‘ Cancel

Klik tombok OK untuk menutup kotak dialog VirtualBox - Preferences.
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5. Pada kotak dialog Oracle VM VirtualBox Manager yang tampil lakukan import file coa-
aio-newton.ova dari OpenStack yang telah diunduh sebelumnya dengan memilih
menu File > Import Appliance, seperti yang ditunjukkan pada gambar berikut:

V¢ Oracle VM VirtualBox Manager
File Machine Help

u Preferences... Ctrl+G
5] Import Appliance... Ctri+

(R} Export Appliance... Ctrl+E
g New Cloud VM...

EU Virtual Media Manager... Ctrl+D
::‘._-ﬂ Host Network Manager... Ctrl+H
:_, Network Operations Manager...

@ Check for Updates...

/1 Reset All Warnings

@ Exit Ctrl+Q

Tampil kotak dialog Appliance to import yang digunakan untuk memilih sumber dari
appliance yang akan di import. Klik tombol browse dari inputan parameter File: untuk
memilih file virtual appliance yang akan di import, seperti yang ditunjukkan pada

gambar berikut:

Import Virtual Appliance

Appliance to import

Please choose the source to import appliance from. This can be a local file System to import OVF archive or one of known cloud service providers to
import cloud ¥M from.

Source: |Local File System -]

Please choose a file to import the virtual appliance from. VirtualBox currently supports importing appliances saved in the Open Virtualization Format
(OVF). To continue, select the file to import below.

File: | ‘@

Expert Mode Next Cancel

Pada kotak dialog Please choose a virtual appliance file to import, arahkan ke lokasi

direktori yang menyimpan file coa-aio-newton.ova yang telah diunduh sebelumnya,
-
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sebagai contoh tersimpan di direktori D:\COA. Pilih file coa-aio-newton.ova dan klik

tombol Open, seperti ditunjukkan pada gambar berikut:

@ Please choose a virtual appliance file to import X
&« > v D ~ > ThisPC » DATA (D) » COA ~ O Search COA P
Organize ~ New folder b = - [ 0

o= DATA (D3) Name Date modified Type Size
. 2023-03 04/12/2017 14:45 Open Virtualizatio... 688.967
~ BelajarCOA
 artikel ilmiah ci-

> @ OneDrive
v [ This PC

> e Local Disk (C)

> == DATA (D3 \

File name: coa-aio-newton.ova & Open Virtualization Format (*.o

Cance'

Tampil kembali kotak dialog Appliance to import dengan nilai dari inputan File: yang

telah mengarah ke lokasi penyimpanan file .ova dari OpenStack. Klik tombol Next
untuk melanjutkan, seperti ditunjukkan pada gambar berikut:

L ? X

€ Import Virtual Appliance

Appliance to import
Please choose the source to import appliance from. This can be a local file system to import OVF archive or one of known cloud service providers to
import cloud VM from.
Source: Local File System

Please choose a file to import the virtual appliance from. VirtualBox currently supports importing appliances saved in the Open Virtualization Format
(OVF). To continue, select the file to import below.

File: ID:\CUA\COE*EiO*ﬂEMOH.WE l G |

Expert Mode Next Cancel

|
WWW.IPUTUHARIYADI.NET 13



PANDUAN PRAKTIKUM

UD COMPUTING BERBASIS OPENSTACK

Tampil kotak dialog Appliance settings yang menampilkan informasi terkait pengaturan

VirtualBox machine yang di import, seperti ditunjukkan pada gambar berikut:

s

& Import Virtual Appliance
Appliance settings

These are the virtual machines contained in the appliance and the suggested settings of the imported VirtualBox machines. You can change many of the
properties shown by double-clicking on the items and disable others using the check boxes below.

Virtual System 1
‘Z?? Name
\é‘ Product
&) Product-URL
=) Version 10
14 Guest 0S Type Ubuntu (64-bit)

&) cru 1

coa-aio-newton_2_1
Preparing for the Certified OpenStack Administrator Exam
https://github.com/PacktPublishing/Preparing-for-the-Certified-OpenStack-Administrator-Exam

'!"' Network Adapter
'!"' Network Adapter

# rRaM 8000 MB
(=) DVD a

8 Intel PRO/1000 MT Desktop (82540EM)
8 Intel PRO/1000 MT Desktop (82540EM)

<> Storage Controller (IDE)  PlIX4
<> Storage Controller (IDE)  PlIX4
v ’ Storage Controller (SATA) AHCI

@ Virtual Disk Image coa-aio-newton_2_1-disk001.vmdk
Base Folder C\Users\PUTU\VirtualBox VMs
(1al Primary Group /

Machine Base Folder: C:\Users\PUTU\VirtualBox VMs

MAC Address Policy:  Include only NAT network adapter MAC addresses -
Additional Options: (@ Import hard drives as VDI

Appliance is not signed

Cancel

Restore Defaults

Klik tombol Import. Tunggu hingga proses import selesai dilakukan. Hasil dari proses

A

import, seperti ditunjukkan pada gambar berikut:

| !} Oracle VM VirtualBox Manager

- [m] X
| File  Machine Help
1© Kaiiel
ﬁlﬁ j Tools W -
New Seftings Discard  Start
Bl ] General preview I
, l@ Powered Off Name: coa-aio-newton_2_1
Operating System: Ubuntu (64-bit}
i (] W system
(W) Powered Off .
(V) Base Memory: 8000 MB -
Boot Order:  Optical, Hard Disk coa-aio-newton_2_1
Acceleration:  VT-x/AMD-V, MNested Paging, KVM Paravirtualization
(e ;
2 () Fowered off | oisplay
Video Memory: 12 MB
Graphics Controller: VBoxVGA
Remote Desktop Server: Disabled
Recording: Disabled
@ Storage
Controller: IDE
IDE Secondary Device 0: [Optical Drive] Empty
Controller: SATA
SATA Port 0: coa-aio-newton_2_1-disk001.vdi (Normal, 80,00 GB)
{1 Audio
Disabled
& network
Adapter 1: Intel PRO/1000 MT Desktop (NAT)
Adapter 2: Intel PRO/1000 MT Desktop (Host-only Adapter, 'vboxnetd')

|
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Terlihat pada daftar dari Oracle VM VirtualBox Manager telah terdapat Virtual

Machine (VM) dengan nama pengenal coa-aio-network_2_1.

6. Mengubah pengaturan dari VM meliputi nama pengenal (name), kapasitas memori

yang digunakan dan penyesuaian jenis network adapter. Pilih coa-aio-network_2_1

pada daftar dari Oracle VirtualBox Manager dan klik Settings pada toolbar, seperti

yang ditunjukkan pada gambar berikut:

| ¢ Oracle VM VirtualBox Manager

| File  Machine Help

(W) Powered Off

Dol ]
, () Powered Off

(saE=
fJ () Powered Off

_

Pa o :

ik

New | Settings

Discard  Start

| feneral

Nanfe:
Opfrating System: Ubuntu (64-bit)

System

ase Memory: 8000 MB
Boot Order: Optical, Hard Disk

.

coa-aio-newton_2_1

Acceleration:  VT-x/AMD-V, Nested Paging, KVM Paravirtualization

B pisplay

Video Memory: 12 MB

Graphics Controller: VBOXVGA
Remote Desktop Server: Disabled
Recording: Disabled

@ Storage
Controller: IDE

IDE Secondary Device 0: [Optical Drive] Empty

Controller: SATA
SATA Port 0:

{p Audio
Disabled

= Hetwork

Adapter 1: Intel PRO/1000 MT Desktop (NAT)
Adapter 2: Intel PRO/1000 MT Desktop (Host-only Adapter, ‘vboxnet0")

coa-aio-newton_2_1-disk001.vdi (Normal, 80,00 GB)

= preview

coa-aio-newton_2_1

Tampil kotak dialog coa-aio-network_2_1 — Settings dan lakukan perubahan pada

parameter Name dari coa-aio-network_2_1 menjadi OpenStack, seperti yang

ditunjukkan pada gambar berikut:

Qu} coa-aio-newton_2_1 - Settings

B | System

? X
General
Basic Advanced Description Disk Encryption
Name:l DpenStacld I |
Type: Linux = @’
Version:  Ubuntu (64-bit) hd

Selanjutnya pada panel sebelah kiri dari kotak dialog coa-aio-network_2_1 — Settings,

pilih System. Tampil panel detail dari System dan pada parameter Base Memory dari

tab Motherboard, lakukan penyesuaian kapasitas memori yang digunakan oleh VM

OpenStack. Secara default kapasitas memori telah diatur untuk VM tersebut adalah

8000 MB, seperti yang ditunjukkan pada gambar berikut:
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Q._j coa-aio-newton_2_1 - Settings L.\s ? X
- General System
| E System Motherboard Processor Acceleration
; Base Memory: a000 MBJ >
M oisplay Vi U B
(el [ WE— 4 MB 16384 MB ‘

Namun dapat diatur kembali sesuai dengan kapasitas memori yang dimiliki oleh
komputer yang digunakan. Nilai Base Memory minimal agar OpenStack dapat berjalan
dengan baik adalah 6000 MB. Kebetulan komputer penulis memiliki kapasitas 16 GB

sehingga nilai Base Memory dibiarkan sesuai dengan nilai default yaitu 8000 MB.

Selanjutnya pada panel sebelah kiri dari kotak dialog coa-aio-network_2_1 - Settings,
pilih Network. Tampil panel detail dari Network dan pada Adapter 1 pilih bagian
Advanced serta pada parameter Adapter Type, pilih PCnet-FAST Ill (Am79C973),

seperti yang ditunjukkan pada gambar berikut:

Q,_} coa-aio-newton_2_1 - Settings ? Iq;(
- General Network
| E System l Adapter 1 | Adapter 2 Adapter 3 Adapter 4
-] Display EnableNetwork Adapter

Attached to: NAT -

| |Ls) storage

| ﬂ] e Adapter Type: | PCnet-FAST 1 (Am79ca73) | -
2 Promiscuous Mode: Deny =2
% Serial Ports .
) MAC Address: 080027D4FD28 @
i >
a'->/ uss Cable Connected
D Shared Folders Port Forwarding
H User Interface
Invalid settings detected Cancel

Terakhir pilih tab Adapter 2 dan pilih bagian Advanced serta pada parameter Adapter
Type, pilih PCnet-FAST Il (Am79C973), seperti yang ditunjukkan pada gambar berikut:
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2} coa-aio-newton_2_1 - Settings ? X
- General Network
E System Adapter 1 Adapter 3 Adapter 4
!| Display B Enable Netwafk Adapter
vany Attgfhed to: Host-only Adapter =
\ 2 /| Storage
Name: VirtualBox Host-Only Ethernet Adapter hd
e _
({)—‘ Audio .l dvanced |
ﬂ] Network Adapter Type: | PCnet-FAST I (Am79C973) | -
D, Promiscuous Mode: | Deny &7
ﬁ} Serial Ports ~
N MAC Address: 0800274C3F39 @
Q/ UsE B cable Connected
D Shared Folders Port Forwarding
ﬁ User Interface

Invalid settings detected Cancel

h

Simpan perubahan dengan menekan tombol OK.
7. Menjalankan VM OpenStack dengan memilih pada daftar dari Oracle VM VirtualBox
Manager dan memilih Start pada toolbar, seperti yang ditunjukkan pada gambar

berikut:

| N# Oracle VM VirtualBox Manager - (m] X

| Eile Machine Help l}

YA ey
i 4
New Settings Discard] Start

General Preview

9™ DEvASC-LABVM
, () Powered Off Name: OpenStack

Operating Systegg?  Ubuntu (64-bit)

@’ PHETLab 4.2.10 [8] systey
() Powered Off .
(V)] Base Mepfry: 8000 MB
Boot Ogffler:  Optical, Hard Disk OPENStaCk
Accejfration:  VT-x/AMD-V, Mested Paging, KVM Paravirtualization
?-\ PVE 7.2-1 .
o O Powered OFf Display
Video Memory: 12 MB
Graphics Controller: VBoxVGA
Remote Desktop Server: Disabled
Recording: Disabled
@ Storage

Tampil kotak dialog VM OpenStack [Running], seperti yang ditunjukkan pada gambar

berikut:

|
WWW.IPUTUHARIYADI.NET 17



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

(ﬂ OpenStack [Running] - Oracle VM VirtualBox = O X
|

File Machine View Input Devices Help

%),

The Virtual Machine reports that the guest 0S does not support mouse pointer 'nteﬁatiun in the current

Started Open3tack Image 3ervice API.
Started OpenStack MNeutron Server.

Started Open3tack Compute.

Started Open3tack Compute Console.
Started Open3tack Image 3ervice Registry.
Started OpenStack Neutron DHCP agent.
Started OpenStack Cinder Api.

Started Open3tack Compute Conductor.
Started OpenStack Cinder Backup.

Started Open3tack Cinder Scheduler.
Started Openstack Meutron Linux Bridge Agent.
Started Open3tack Meutronm L3 agent.
Started OpenStack Neutron Metadata Agent.
Started LSB: Swift object auditor.
Started L3B: Swift object reconstructor.
Started L3B: Swift object replicator.
Stopping OpenStack Cinder Scheduler...
Starting OpenStack Compute nowvncproxy...
Stopped Open3tack Cinder Scheduler.
Started OpenStack Compute nouncproxy.
Starting OpenStack Cinder Scheduler...

Boom =g #right cn
Tunggu hingga proses booting selesai dilakukan dan memperlihatkan prompt Login

dari OpenStack, seperti yang ditunjukkan pada gambar berikut:

( OpenStack [Running] - Oracle VM VirtualBox = O X
|

File  Machine View Input Devices Help

buntu 16.04.2 LT3 coa-aio-newton ttyl

oa-aio-newton login: _

8. Ujicoba login ke OpenStack menggunakan username “openstack” dengan password

default adalah “openstack”, seperti yang ditunjukkan pada gambar berikut:

( OpenStack [Running] - Oracle VM VirtualBox L — O X
I

File Machine View Input Devices Help

buntu 16.04.2 LTS coa-aio—newton ttyl

oa-aio-newton login: openstack
Password:
elcome to Ubuntu 16.04.2 LTS (GHU- Linux 4.4.0-21-generic xB6_64)

#* Documentation: https:s/help.ubuntu.con
= Management: https:~sslandscape.canonical.con
#* Support: https:/subuntu.comrsadvantage

192 packages can be updated.
1 updates are security updates.

openstack@coa-aio-—newton G

9. Memverifikasi koneksi Internet dari OpenStack CLI dengan mengakses salah satu situs
di Internet, sebagai contoh google.com melalui eksekusi perintah ping

google.com, seperti terlihat pada gambar berikut:
-
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( OpenStack [Running] - Oracle VM VirtualBox — a X “

|File Machine View Input Devices Help %

buntu 16.04.2 LTS coa-aio-newton ttyl

oa—aio-newton login: openstack
assword:
elcome to Ubuntu 16.04.2 LTS (GHU-/Linux 4.4.0-21-generic x86_64)

*= Documentation: https:srshelp.ubuntu.con
* Management: https://landscape.canonical .com
* Support: https://ubuntu.comsadvantage

192 packages can be updated.

1 updates are security updates.

openstack@coa-aio-newton:~§ ping google.con

ING google.com (74.125.24.1vs) Solo4) bpyres of data.

64 bytes from 74.125.24.102: icmp_seq=1 ttl1=54 time=77.9 ms

64 bytes from 74.125.24.102: icmp_seq=2 tt1=54 time=109 ns

64 bytes from 74.125.24.102: icmp_seq=3 ttl1=54 time=71.0 ms

C

-- google.com ping statistics ---
3 packets transmitted, 3 received, 0¥ packet loss, time 11096ns
rtt minsavg/max/mndev = 71.046,86.289,109.907,16.935 ns
openstackPcoa-aio-newton:™§

B =& R right cr
10. Untuk keluar dari penggunaan OpenStack CLI dapat mengeksekusi perintah 1ogout,

seperti terlihat pada gambar berikut:

{ﬂ OpenStack [Running] - Oracle VM VirtualBox = O X l

File Machine View Input Devices Help

buntu 16.04.2 LTS coa-aio—newton ttyl

oa-aio-newton login: openstack

Passuword:

Last login: Wed Apr 5 07:30:54 EDT 2023 on ttyl

elcone to Ubuntuw 16.04.2 LTS (GHU-Linux 4.4.0-Z21-generic x86_64)

#= Documentation: https:-sshelp.ubuntu.con
* Management: https:rs~slandscape.canonical .com
= Support: https: - ubuntu.consadvantage

192 packages can be updated.
1 updates are security updates.

openstackPcoa—aio-newton:™5 ping google.con
[P ING google.com (74.125.24.113) 56(84) bytes of data.
614 bytes from 74.125.24.113: icnp_seq=1 tt1=53 tine=90.8 ms
64 bytes from 74.125.24.113: icmp_seq=Z tt1=53 time=125 ms

C

—— google.com ping statistics ———

packets transmitted, 2 received, 0% packet loss, time 10100ms
rtt minsavg/max/mdev = 90.811-107 _990-125.169-17.179 mn=
openstackPcoa-aio-newton:”5 logout|_

W = t;__[|] [ Right curt
11. Memverifikasi koneksi dari Windows ke alamat IP dari VM OpenStack vyaitu
192.168.56.56 melalui Command Prompt. Buka Command Prompt Windows dengan
menekan tombol Windows + R dan ketik cmd pada kotak dialog yang tampil, seperti

terlihat pada gambar berikut:
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| = Run X

Type the name of a program, folder, document, or
| &= Internet resource, and Windows will open it for you.

open: [N :

Cancel Browse...

Tekan tombol OK maka akan tampil kotak dialog Command Prompt. Eksekusi perintah
ping 192.168.56.56 pada kotak dialog Command Prompt tersebut, seperti

terlihat pada gambar berikut:

CAWINDOWS\system32\cmd. X +

Microsoft Windows [Version 10.0.22621.1413]
(c) Microsoft Corporation. All rights reserved.

C:\Users\PUTUzping 192.168.56.56

Pinging 192.168.56.56 with 32 bytes of data:

Reply from 192.168.56.56: bytes=32 time<lms TTL=64
Reply from 192.168.56.56: bytes=32 time=1lms TTL=64
Reply from 192.168.56.56: bytes=32 time<lms TTL=64
Reply from 192.168.56.56: bytes=32 time<lms TTL=64

Ping statistics for 192.168.56.56:

Packets: Sent = U4, Received = U4, Lost = 0 (0% loss),
Approximate round trip times in milli-seconds:

Minimum = Oms, Maximum = 1lms, Average = Oms

C:\Users\PUTU>

Terlihat koneksi dari Windows ke VM OpenStack berhasil dilakukan. Apabila verifikasi
koneksi gagal dilakukan maka lakukan verifikasi melalui Control Panel = Network &
Sharing Center = Change adapter Settings dan pastikan interface VirtualBox Host-
Only Network menggunakan alamat IP 192.168.56.1.

E. MEMBUAT SUMBER DAYA VIRTUAL CLOUD COMPUTING MELALUI OPENSTACK HORIZON
DASHBOARD

Adapun langkah-langkah untuk membuat sumber daya cloud computing melalui

OpenStack Horizon Dashboard adalah sebagai berikut:
'
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1. Buka browser dan pada address bar masukkan alamat http://192.168.56.56/horizon, maka

akan tampil halaman OpenStack Dashboard. Pada halaman OpenStack Dashboard
tersebut, lakukan Jlogin dengan melengkapi inputan User Name dan Password

menggunakan “admin” serta tekan tombol Connect, seperti terlihat pada gambar berikut:

u Login - OpenStack Dashboard X +

& C A Notsecure |[192.168.56.56/horizonfauth/login/?next=/horizon/ =2 Y ® = 0O Q

openstack

Log in

User Name

00

Password

Tampil halaman OpenStack Project Dashboard.

2. Membuat Project bernama “belajar-NIM” dengan mengakses panel sebelah kiri dan
memilih Identity serta memilih submenu Projects maka pada panel detail sebelah kanan
akan tampil halaman Projects. Tekan tombol Create Project untuk membuat project baru,

seperti terlihat pada gambar berikut:

|
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B openstack = admin ~ & admin ~
Project >
Identity / Projects
Admin >
Projects «
Identity v
l Projects}
Project Name =+ m,.,_: + Create Project I 1@ Delete Projects
Users
Domai
Groups a Name Description Project ID N:ﬂ:m Enabled Actions
Roles 4
u) ‘h”nfz"g”;y“o” £=E 0098463de799497e94dd7e 1666822823  Default Yes Manage Members =
(m] procurement 01a169db81004f5eba3aa150126479d7  Default Yes Manage Members =+
m] legal 2ef4c7ba3fo44be38aabdf8delarff13 Default Yes Manage Members =~
O senvice Service Project 306c211172cc411d9b3ffbd4dc837757 Default Yes Manage Members

Tampil kotak dialog Create Project dan lengkapi inputan Name dengan nama project yang
akan dibuat yaitu “belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh
memiliki NIM dengan nilai 0827068001 maka nama project-nya adalah “belajar-
0827068001” dan tekan tombol Create Project untuk memproses pembuatan project

tersebut, seperti terlihat pada gambar berikut:

Create Project

Project Information * Project Members Project Groups Quota *

Domain ID default
[y
Domain Name Default
Name * belajar-0827068001

Description

Enabled ¥

Cancel Create Project

Tampil pesan notifikasi keberhasilan pembuatan project. Selain itu pada halaman Projects

menampilkan informasi keseluruhan project.

WWW.IPUTUHARIYADI.NET 22



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

Lakukan pemfilteran terhadap project yang ditampilkan dengan memasukkan kata kunci
pemfilteran di inputan pemfilteran berdasarkan Project Name. Pada inputan tersebut
masukkan nilai “belajar-NIM” dan tekan tombol Filter. Ganti NIM sesuai dengan yang
dimiliki. Sebagai contoh memiliki NIM dengan nilai 0827068001 maka nama project-nya
adalah “belajar-0827068001”, seperti terlihat pada gambar berikut:

B openstack = admin ~ & admin ~
Project ?
Identity / Projects I3
Admin > ‘
" wmp Projects ‘
Projects
Project Name =+ | belajar-0827068001 I—)I Filter I + Create Project ‘
Users _—

m} Name Description Project ID Domain Name Enabled Actions
Groups
O | belajar-0827068001 89520120004b4305aec5a84dfa0267db Default Yes Manage Members | =

Roles

Displaying 1 item
Terlihat ditemukan project sesuai dengan kata kunci pemfilteran tersebut.

3. Membuat user bernama “NIM” dengan mengakses panel sebelah kiri dan memilih Identity
serta memilih submenu Users maka pada panel detail sebelah kanan akan tampil halaman

Users. Tekan tombol Create User untuk membuat user baru, seperti terlihat pada gambar

berikut:
3 openstack = admin ~ & admn~
Project >
Identity / Users
Admin > % ‘
oty M Users |
Projects
User Name ==, """*A:I + Create User I| ‘
l Usersi— |
Domai
Groups O  User Name Description Email UserID Enabled N:::m Actions
Roles .
O swift - 0111fd06259949da89b1eaf090dfa299 Yes Default Edit
O sallyp - sallyp@example.com 10d009379e92472fa0737f05a8d17ab5 Yes Default Edit

Tampil kotak dialog Create User dan lengkapi inputan berikut:

a. User Name digunakan untuk mengatur nama login pengguna yang akan dibuat
yaitu menggunakan “NIM”. Ganti NIM sesuai dengan yang dimiliki, sebagai contoh

0827068001.

|
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b. Password digunakan untuk mengatur sandi login untuk User Name yang dibuat,
sebagai contoh “12345678".

c. Confirm Password digunakan untuk mengkonfirmasi sandi /ogin yang digunakan
untuk User Name yang dibuat. Masukkan sandi login yang sama dengan nilai yang

dimasukkan pada inputan Password, sebagai contoh “12345678".

Setelah ketiga nilai inputan tersebut dilengkapi maka geser vertical scroll bar dari kotak
dialog Create User ke bawah untuk menampilkan inputan lainnya, seperti terlihat pada

gambar berikut:

Create User

Domain ID

Description:

I Create a new user and set related properties including
Domain Name the Primary Project and Role.

default

Default

User Name *

0827068001

Description

Email

Password "

Confirm Password *

-

Selanjutnya pilih dropdown Primary Project untuk memilih project yang dapat dikelola

oleh user yang dibuat yaitu "belajar-NIM". Ganti NIM sesuai dengan yang dimiliki. Sebagai
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contoh memiliki NIM dengan nilai 0827068001 maka nama project yang dipilih adalah
“belajar-0827068001". Terakhir pilih dropdown Role untuk memilih jenis role untuk user

2.

yang dibuat, sebagai contoh “_member_". Role merupakan mekanisme otorisasi bagi
pengguna untuk menentukan apa yang dapat dilakukan oleh pengguna tersebut. Setelah
melengkapi nilai untuk kedua inputan tersebut, lakukan penekanan tombol Create User

untuk memproses pembuatan user tersebut, seperti terlihat pada gambar berikut:

Create User

Description

N
“

Email
Password *

........ . 0
Confirm Password *

........ @&
Primary Project

belajar-0827063001 - +
Role ¢

_member_ v
™ Enabled

Cancel Create User

Tampil pesan notifikasi keberhasilan pembuatan user. Selain itu pada halaman Users
menampilkan informasi keseluruhan user.
Lakukan pemfilteran terhadap user yang ditampilkan dengan memasukkan kata kunci

pemfilteran di inputan pemfilteran berdasarkan User Name. Pada inputan tersebut

|
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masukkan nilai “NIM” dan tekan tombol Filter. Ganti NIM sesuai dengan yang dimiliki,

sebagai contoh 0827068001, seperti terlihat pada gambar berikut:

3 openstack & aomin ~

& admin ~
Project >
Identity / Users
Admin >
— v Users
Projects
User Name =~ 0827068001 Filter + Create User
Users N —
a O User Name Description Email User ID Enabled Domain Name Actions
roups
)82706800 -
Roles O | 0827068001 284614b1943427a9642 1f{d8bd9da404 Yes Default Edit

Displaying 1 item
Terlihat ditemukan user sesuai dengan kata kunci pemfilteran tersebut.

4. Membuat provider network untuk project "belajar-NIM" dengan mengakses panel
sebelah kiri dan memilih Admin serta memilih submenu SYSTEM - Networks maka pada
panel detail sebelah kanan akan tampil halaman Networks. Tekan tombol Create Network

untuk membuat network baru, seperti terlihat pada gambar berikut:

3 openstack = admin ~

& admin v |
Project >
Admin / System / Networks
e Networks
Overview
Project=~ Filter I + Create Network I|
Hypervisors
DHCP Admin
ost Aggregates a Project Network Name Subnets Associated dred External Status state Actions
Instances nant-networki-d e . ¢ bosard
human- tenant-network1-de tenant-subnetl-dash 1 No No Aclive  UP Cdit Network | =

resources ashboard 192 168.1.0/24

Volumes

Displaying 1 item
Flavors

Images

Tampil kotak dialog Create Network dan lengkapi inputan berikut:

a. Name digunakan untuk mengatur nama dari network yang akan dibuat yaitu
bernama "provider-network-belajar".

b. Project digunakan untuk memilih project yang akan memiliki network yang dibuat
tersebut yaitu “belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki. Sebagai
contoh memiliki NIM dengan nilai 0827068001 maka nama project yang dipilih
pada dropdown menu adalah “belajar-0827068001".
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C.

Provider Network Type digunakan untuk memilih jenis provider network. Pada VMM
OpenStack yang digunakan telah diatur provider network type berjenis flat untuk
merepresentasikan trafik network provider tanpa enkapsulasi atau penandaaan
(tagging). Untuk itu pilih flat pada dropdown menu dari Provider Network Type.
Physical Network digunakan untuk mengatur nama pemetaan dari interface fisik
yang diasosiasikan dengan provider network yang dibuat. Pada VM OpenStack yang
digunakan telah diatur label untuk provider physical network dengan nama
“public-dashboard” yang didefinisikan pada file
/etc/neutron/plugins/ml2/linuxbridge_agent.ini. Untuk itu masukkan “public-
dashboard” pada inputan Physical Network.

Pilih checkbox External Network agar network yang dibuat adalah network

eksternal sehingga dapat digunakan untuk terkoneksi ke Internet.

Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Submit untuk

memproses pembuatan network, seperti terlihat pada gambar berikut:

|
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Create Network

Name

provider-network-belajar

Project *

belajar-0827068001 v

Flat

Provider Network Type * ©

public-dashboard

Description:

Create a new network for any project as you need.

Provider specified network can be created. You can
specify a physical network type (like Flat, VLAN, GRE,
and VXLAN) and its segmentation_id or physical
network name for a new virtual network.

In addition, you can create an external network or a
shared network by checking the corresponding

. checkbox.
Physical Network = @

Segmenfation ID * @

External Network

Tampil pesan notifikasi keberhasilan pembuatan network. Selain itu pada halaman

Network menampilkan informasi keseluruhan network termasuk provider-network-

belajar, seperti terlihat pada gambar berikut:

B openstack = admin ~ & admin ~
N
Project >
Admin / System / Networks
- . Networks
Overview
Project =+ Filter + Create Network 1l Delete Networks
Hypervisors
. . Admin B
Host Aggregates O Project Network Name Subnets Associated Shared External Status State Actions
Instances
belajar- provider-network-
] 0827068001 No Yes Active UP Edit Network
Volumes
human- tenani-network1- « tenant-subnet1-dashboard
Flavors resources dashboard 192.168.1.0/24 No No Active  UP Edit Network | »
Images Displaying 2 items
Networks
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5. Membuat subnet untuk provider-network-belajar dengan nama provider-subnet-belajar

yang memiliki network address 172.16.0.0/24 dan gateway 172.16.0.1 serta mengatur

alokasi pengalamatannya secara statik. Selain itu juga mengatur agar subnet yang dibuat

dimiliki oleh project belajar-NIM. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh

memiliki NIM dengan nilai 0827068001 maka nama project-nya adalah “belajar-

0827068001”. Pembuatan subnet tersebut dapat dilakukan dengan mengakses link atau

tautan provider-network-belajar yang terdapat di bawah kolom Network Name pada

halaman Networks, seperti terlihat pada gambar berikut:

B3 openstack = admin ~

Project >
[z ]

SYSTEM v
Overview
Hypervisors
Host Aggregates
Instances
Volumes
Flavors
Images

Networks

N

Admin / System / Networks

Project =+
m} Project Network Name Subnets Associated
o belajar- provider-network-
0827068001 belajar
o human- tenant-networki- = tenant-subnet1-dashboard
resources dashboard 192.168.1.0/24

Displaying 2 items

& admin =

Filter + Create Network [:J

Admin

Shared External Status Actions

State
No Yes Active UP Edit Network | =
No No Active UP Edit Network | «

Selanjutnya akan tampil halaman provider-network-belajar dan pilih tab Subnets, seperti

terlihat pada gambar berikut:

3 openstack & aomin ~
Project >
SYSTEM v
Qverview
Hypervisors
Host Aggregates
Instances
Volumes
Flavors
Images

Networks

&

Admin / System / Networks / provider-network-belajar

provider-network-belajar

Overview Ports

Network Overview

Name  provider-network-belajar
ID  aiccf664-5b3f-4i8f-a1d4-efc284i9edad
Project ID  89520120004b4305aec5a84dfa0267db
Status  Active
Admin State UP

DHCP Agents

Shared No
External Network  Yes
MTU 1500

Provider Network  Network Type: flat
Physical Network: public-dashboard
Segmentation ID: -

& admin ~

Edit Network  ~

|
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Pada halaman provider-network-belajar tab Subnets yang tampil, pilih tombol Create

Subnet untuk membuat subnet baru pada network tersebut, seperti terlihat pada gambar

berikut:
B openstack = admin ~ 5 & admin ~
Project >
Admin / System [ Networks / provider-network-belajar
svsTEm . provider-network-belajar Edit Network | -
QOverview
Overview Subnets Ports DHCP Agents
Hypervisors
Host Aggregates
Name CIDR IP Version Gateway IP Used IPs Free IPs Actions

Instances
No items to display.

Volumes

Flavors

Images

Networks

Tampil kotak dialog Create Subnet dan lengkapi inputan berikut untuk tab

CreateSubnetinfoAction:

a. Subnet Name digunakan untuk mengatur nama subnet yang akan dibuat yaitu
provider-subnet-belajar.
b. Network Address digunakan untuk mengatur alamat jaringan yang digunakan oleh

subnet yang dibuat yaitu 172.16.0.0/24.

Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Next >> untuk

melanjutkan pengisian Subnet Details, seperti terlihat pada gambar berikut:

|
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Create Subnet

CreateSubnetinfoAction Subnet Details

Subnet Name

provider-subnet-belajar

Network Address @

172.16.0.0/24

IP Version

IPv4 v

Gateway IP @

O Disable Gateway

Cancel « Back

Tampil tab Subnet Details dari kotak dialog Create Subnet. Hilangkan tanda centang (V)
pada checkbox Enable DHCP untuk menonaktifkan fitur DHCP pada subnet sehingga
alokasi pengalamatan IP dilakukan secara statik dan tekan tombol Create untuk memproses

pembuatan subnet tersebut, seperti terlihat pada gambar berikut:

|
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Create Subnet

CreateSubnetinfoAction Subnet Details

O] Enable DHCP

Specify additional attributes for the subnet.

DNS Name Servers @

Host Routes @

Cancel « Back Create

Tampil pesan notifikasi keberhasilan pembuatan subnet. Selain itu pada tab Subnet dari
halaman provider-network-belajar telah menampilkan informasi terkait subnet yang

dibuat yaitu provider-subnet-belajar, seperti terlihat pada gambar berikut:

n openstack & admin ~ 5 & admin ~
Project >
Admin / System / Networks / provider-network-belajar
svsEm . provider-network-belajar B Network | -

Overview
QOverview Subnets Ports DHCP Agents

Hypervisors

+ Create Subnet 1l Delete Subnets
Host Aggregates

m] Name CIDR IP Version Gateway IP Used IPs Free IPs Actions
Instances

@] Iprovider—subnet—belajar 172.16.0.0/24 IPv4 172.16.0.1 0 253 I Edit Subnet | =
Volumes

Displaying 1 item
Flavors

Images

Networks

6. Mengalokasikan dua floating IP untuk project "belajar-NIM" vyaitu 172.16.0.123 dan

172.16.0.234 dengan mengakses panel sebelah kiri dan memilih Admin serta memilih
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submenu SYSTEM -> Floating IPs maka pada panel detail sebelah kanan akan tampil
halaman Floating IPs. Tekan tombol Allocate IP To Project untuk mengalokasikan IP ke

project, seperti terlihat pada gambar berikut:

B openstack = admin ~ % & admin +

Project >

- . Floating IPs

Admin / System / Floating IPs

Overview

% Allocate IP To Project
Hypervisors

Project IP Address Mapped Fixed IP Address Pool Status Actions

Host Aggregates
No items to display.
Instances
Volumes
Flavors
Images

Networks

Routers

Floating IPs

Tampil kotak dialog Allocate Floating IP dan lengkapi inputan berikut:

a. Pool digunakan untuk memilih nama dari provider network yang sebelumnya telah
dibuat. Untuk itu pilih “172.16.0.0/24 provider-network-belajar”’ pada dropdown
menu tersebut.

b. Project digunakan untuk memilih project yang akan dialokasikan alamat floating IP
yaitu “belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh
memiliki NIM dengan nilai 0827068001 maka nama project yang dipilih pada
dropdown menu tersebut adalah “belajar-0827068001”

c. Floating IP Address (optional) digunakan untuk mencantumkan alamat IP yang

akan dialokasikan yaitu 172.16.0.123.

Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Allocate Floating
IP untuk memproses pengalokasian floating IP ke project, seperti terlihat pada gambar

berikut:
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Allocate Floating IP

Pool *

172.16.0.0/24 provider-network-belajar D escri ptl on:

From here you can allocate a floating IP to a specific
Project project.

belajar-0827068001 v

Floating IP Address (optional) @

172.16.0.123

Cancel Allocate Floating IP

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan floating IP dengan
alamat tersebut telah berhasil dilakukan. Selain itu pada halaman Floating IPs
menampilkan informasi alamat IP 172.16.0.123 yang dialokasikan untuk project “belajar-

0827068001”, seperti terlihat pada gambar berikut:

n openstack & admin ~ & admin ~

Project >
Admin / System / Floating IPs

&

S— . Floating IPs

QOverview

% Allocate IP To Project £3 Release Floating IPs
Hypervisors
a Project IP Address Mapped Fixed IP Address Pool Status Actions

Host Aggregates

Instances [m} Ibe\ajar-0827068001 172.16.0.123 - provider-network-belajar ] Down Release Floating IP

Volumes Displaying 1 item

Flavors
Images
Networks
Routers
Floating IPs

Dengan cara yang sama maka lakukan pengalokasian floating IP kembali ke project tersebut

yaitu dengan menekan tombol Allocate IP To Project, seperti terlihat pada gambar berikut:

WWW.IPUTUHARIYADI.NET 34



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

B openstack = admin ~ & admin +

Project ?>
Admin / System / Floating IPs

- . Floating IPs

Overview

I % Allocate IP To Project || ‘
Hypervisors

m] Project IP Address Mapped Fixed IP Address Pool Status Actions
Host Aggregates
Instances O  belajar-0827068001 172.16.0.123 = provider-network-belajar Down Release Floating IP
Volumes Displaying 1 item

Tampil kotak dialog Allocate Floating IP dan lengkapi inputan berikut:

a. Pool digunakan untuk memilih nama dari provider network yang sebelumnya telah
dibuat. Untuk itu pilih “172.16.0.0/24 provider-network-belajar” pada dropdown
menu tersebut.

b. Project digunakan untuk memilih project yang akan dialokasikan alamat floating IP
vaitu “belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh
memiliki NIM dengan nilai 0827068001 maka nama project yang dipilih pada
dropdown menu tersebut adalah “belajar-0827068001”

c. Floating IP Address (optional) digunakan untuk mencantumkan alamat IP yang

akan dialokasikan yaitu 172.16.0.234.

Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Allocate Floating
IP untuk memproses pengalokasian floating IP ke project, seperti terlihat pada gambar

berikut:
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Allocate Floating IP

Pool *
172.16.0.0/24 provider-network-belajar v Descnptlon .
From here you can allocate a floating IP to a specific
Project * project.
belajar-0827068001 v

Floating IP Address (optional) @

172.16.0.234

=
Cancel Allocate Floating IP

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan floating IP dengan
alamat tersebut telah berhasil dilakukan. Selain itu pada halaman Floating IPs
menampilkan informasi alamat IP 172.16.0.234 yang dialokasikan untuk project “belajar-

0827068001”, seperti terlihat pada gambar berikut:

B openstack = admin ~

& admin =

Project ?>

svsrEm . Floating IPs

Admin / System / Floating IPs

QOverview

S Allocate IP To Project £3 Release Floating IPs
Hypervisors

m} Project IP Address Mapped Fixed IP Address Pool Status Actions
Host Aggregates

Instances [m} I belajar-0827068001 172.16.0.234 - prowdel-network-be\ajarl Down Release Floating IP
Volumes O  belajar-0827068001 172.16.0.123 - provider-network-belajar Down Release Floating IP

Flavors

Displaying 2 items

Keluar dari penggunaan OpenStack Horizon Dashboard dengan mengakses dropdown

menu pada pojok kanan atas dan pilih Sign Out, seperti terlihat pada gambar berikut:
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B openstack = admin ~

Project ? £ Settings
Admin / System / Floating IPs @ Help
S— . Floating IPs Themes

Ubuntu
QOverview

% Allocate IP To Project ' Material
Hypervisors

Project IP Address Mapped Fixed IP Address Pool Status | @ Sign Opt

Host Aggregates o ) PP m.ly
Instances O  belajar-0827068001 172.16.0.234 - provider-network-belajar Down Release Floating IP
Volumes O  belajar-0827068001 172.16.0.123 - provider-network-belajar Down Release Floating IP

Flavars Displaying 2 items

7. Pada halaman Log in dari OpenStack Dashboard, lakukan /ogin dengan melengkapi inputan
User Name menggunakan “NIM”, sebagai contoh “0827068001” dan Password
menggunakan “12345678” serta tekan tombol Connect, seperti terlihat pada gambar

berikut:

openstack

Login

User Name

0827068001 0

Password

= ®

Connect

8. Memverifikasi hasil pengalokasian external network bernama “provider-network-belajar”
dengan mengakses panel sebelah kiri dan memilih Project serta memilih submenu
NETWORK - Network Topology maka pada panel detail sebelah kanan akan tampil

halaman Network Topology, seperti terlihat pada gambar berikut:

|
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3 openstack = belajar-os27068001 + & 0827068001 ~ =

Project / Network / Network Topology

COMPUTE >

NETWORK v Network TOpOIOgy

Networks

& Launch Instance + Create Network + Create Router

Topology Graph
Routers

£ Small | 83 Normal
ORCHESTRATION >
OBJECT STORE ?

Identity >

[=
]
=
a
2
3
S
E
T
o
ol
=3
2

D009l el

Terlihat telah terdapat provider network dengan nama tersebut.

9. Membuat Images menggunakan Cirros dengan mengakses panel sebelah kiri dan memilih
Project serta memilih submenu COMPUTE = Images maka pada panel detail sebelah
kanan akan tampil halaman Images. Tekan tombol Create Image untuk membuat image

baru, seperti terlihat pada gambar berikut:

n openstack & belajar-0827068001 ~ L & 0827088001 +
Project v
Images
v

Overview Q| Click here for filters + Create Image Il

Instances

m] Name * Type Status Protected Disk Format Size

Volumes

> g Public No Qcowz2 12.65 MB Launch

m] Active

Displaying 1 item
Access & Security

Tampil kotak dialog Create Image dan lengkapi inputan berikut:

a. Image Name pada bagian Image Details digunakan untuk mengatur nama image
yang akan dibuat yaitu cirros-belajar.
b. Image Description pada bagian Image Details digunakan untuk mengatur deskripsi

dari image yang dibuat sebagai contoh “Image Cirros untuk pembelajaran”.

|
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c. File pada bagian Image Source digunakan untuk mengarahkan ke lokasi
penyimpanan file image Cirros di komputer yang digunakan, sebagai contoh
ditempatkan drive D pada direktori COA (D:\COA). Apabila belum memiliki maka
image Cirros tersebut dapat diperoleh melalui Internet pada alamat

https://download.cirros-cloud.net. Sebagai contoh image Cirros yang diunduh

adalah versi 0.4.0 untuk arsitektur x86_64. Tekan tombol Browse pada inputan File,

seperti terlihat pada gambar berikut:

Create Image

- °
Image Details

Metadata Specify an image to upload to the Image Service
Image Name* Image Description

| cirms-be\ajarl e ! Image Cirros untuk pembelajaranll |

Image Source

Source Type

File

File®

Format™

Image Requirements

Kernel Ramdisk

Choose an image v Choose an image v -

% Cancel <Back Next > I I

Tampil kotak dialog Open yang digunakan untuk mengarahkan ke lokasi penyimpanan file
image Cirros yang tersimpan di D:\COA, sebagai contoh dengan nama “cirros-0.4.0-
x86_64-disk.img”. Pilih file dengan nama tersebut dan tekan tombol Open, seperti terlihat

pada gambar berikut:

|
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@ Open
&« - ~ P > ThisPC DATA (D) > COA
Organize ~ MNew folder
~
1 mp4 Name
. Campuran I@ cirros-0.4.0-x86_64-diskimg I

'e coa-aio-newton.ova
> @ OneDrive
~ [ This PC
> = Local Disk (C)
> o DATA (D)

> w= Local Disk (Z))

X
v C Search COA » |
=- 01 0
Date modified Type Size
22/12/2019 6:12 Disc Image File 12418
04/12/2017 14:45 Open Virtualizatio... 688.967

> ﬁ Network

N\

File name: | cirros-0.4.0-x86_64-diskimg

Ay All Files (**) ~

Selanjutnya pada inputan File tersebut akan memperlihatkan informasi terkait disk image

“cirros-0.4.0-x86_64-disk.img”. Geser vertical scroll bar dari kotak dialog Create Image ke

bawah untuk menampilkan pengaturan inputan lainnya, seperti terlihat pada gambar

berikut:

Create Image

Image Details * .
Image Details

Metadata Specify an image to upload to the Image Service.

Image Name®

cirros-belajar

Image Source
Source Type

‘ File ‘

File*

Image Description

Image Cirros untuk pembelajaran

cirros-0.4.0-x86_64-disk.img

Format”

Image Requirements
Kernel

Choose an image

% Cancel

Ramdisk

v Choose an image v -

Next > + Create Image

<Back

Lengkapi kembali pengaturan untuk inputan berikut:

a. Format pada bagian Image File digunakan untuk mengatur disk format dari image

yang diunggah yaitu QCOW2.
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b. Minimum Disk (GB) pada bagian Image Requirements digunakan agar mengijinkan
ukuran minimum primary disk sebesar 1GB ketika melakukan boot instance dengan
image cirros tersebut.

c. Minimum RAM (MB) pada bagian Image Requirements digunakan untuk mengatur
ukuran RAM minimum yang diijinkan ketika melakukan boot instance dengan
image cirros tersebut yaitu 512 MB.

d. Visibility pada bagian Image Sharing digunakan untuk memilih apakah image yang
dibuat hanya dapat dilihat oleh pengguna yang tercakup pada project aktif (Private)
atau tidak (Public). Pilih Private agar image tersebut hanya dapat dilihat oleh
pengguna yang tercakup pada project aktif yaitu project “belajar-0827068001".

Setelah keseluruhan inputan tersebut diatur maka lakukan penekanan tombol Create

Image untuk memproses pembuatan Image, seperti terlihat pada gambar berikut:

Create Image

File

File®
cirros-0.4.0-x86_64-disk.img

Format™

I QCOW?2 - QEMU Emulator VI

Image Requirements

Kernel Ramdisk

Choose an image Choose an image v

Architecture Minimum Disk (GB) Minimum RAM (MB)

[

Image Sharing
Visibility

Protected

Public Yes No

x Cancel + Create Image
Tampil pesan notifikasi yang menginformasikan bahwa pembuatan image dengan nama

tersebut telah berhasil dilakukan. Selain itu pada halaman Images menampilkan informasi

|
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terkait Status dari proses pembuatan image yang dibuat yaitu bernilai Saving, seperti

terlihat pada gambar berikut:

n openstack = be\aiapnazi%esom - & 0827088001 ~
|
COMPUTE v g

Overview Q| Click here for filters x + Create Imags :}

Instances
O Name “ Type Status Visibility Protected Disk Format Size

Volumes
0O > cirros Image Active Public No Qcowz2 12.65 MB Launch

Images
S W]
O |» cirros-belajar Image Private No Qcowz2
Access & Security Saving

Terkadang Status “Saving” tersebut tidak berubah menjadi “Active” meskipun proses
pembuatan image telah selesai dilakukan. Untuk itu pilih kembali sub menu Images dari
menu Project > COMPUTE yang terdapat di panel sebelah kiri dari OpenStack Dashboard,

seperti terlihat pada gambar berikut:

&3 openstack & velajar-0827068001 ~ N & 0827088001 ~ -
|
COMPUTE v g

Overview Q | Click here for filters x|+ Create Image :}

Instances
m] Name * Type Status Visibility Protected Disk Format Size

Volumes
0O > cirros Image Active Public No QCOW2 12.65 MB Launch

\Dklcwrros—be\ajar Image Active Private No QCOW2 1213 MB I Launch +

Access & Security

Displaying 2 items
NETWORK > -

Terlihat image dengan nama tersebut telah selesai dibuat dan berstatus Active.

10. Membuat internal network untuk project "belajar-NIM" dengan mengakses panel
sebelah kiri dan memilih Project serta memilih submenu NETWORK = Networks maka
pada panel detail sebelah kanan akan tampil halaman Networks. Tekan tombol Create

Network untuk membuat network baru, seperti terlihat pada gambar berikut:

|
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B3 openstack = belajar-0s27088001 + I & 0827068001 ~ (=

Project / Network / Networks

COMPUTE >

. Networks

letwork Topology

Routers 0O  Name Subnets Associated Shared External Status Admin State  Actions
ORCHESTRATION > m] provider-network-belajar « provider-subnet-belajar 172.16.0.0/24 No Yes Active uUprP Edit Network =~
OBJECT STORE > Displaying 1 item

Name = v Filter I + Create Network I i Delete Networks
>

Tampil kotak dialog Create Network dan pada tab Network lengkapi inputan Name yang

digunakan untuk mengatur nama dari network yang akan dibuat yaitu berna

ma

"network1-belajar" dan tekan tombol Next >> untuk melanjutkan pengisian Subnet,

seperti terlihat pada gambar berikut:

Create Network

Subnet Subnet Details

Network Name Create a new network. In addition, a subnet associated

with the network can be created in the following steps of
this wizard.

network1-belajar

Admin State @

UpP -

O Shared @

™ Create Subnet

Cancel « Back

Tampil kotak dialog Create Network untuk tab Subnet dan lengkapi inputan berikut:

a. Subnet Name digunakan untuk mengatur nama subnet yang akan dibuat yaitu

subnetl-belajar.

b. Network Address digunakan untuk mengatur alamat jaringan yang digunakan oleh

subnet yang dibuat yaitu 192.168.123.0/24.
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Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Next >> untuk

melanjutkan pengisian Subnet Details, seperti terlihat pada gambar berikut:

Create Network

Network Subnet Details

Subnet Name Creates a subnet associated with the network. You need

subnet1-belajar to enter a valid "Network Address” and "Gateway IP". If
you did not enter the "Gateway IP", the first value of a
Network Addressx network will be assigned by default. If you do not want
gateway please check the "Disable Gateway" checkbox.
192 168.123.0/24 Advanced configuration is available by clicking on the

"Subnet Details” tab.

IP Version

IPv4

Gateway IP @

O Disable Gateway

Tampil kotak dialog tab Subnet Details dari kotak dialog Create Network dan lengkapi

inputan berikut:

a. Pastikan checkbox “Enable DHCP” telah tercentang (V) yang digunakan untuk
mengaktifkan fitur DHCP pada subnet sehingga alokasi pengalamatan IP ke instance
dilakukan secara dinamis.

b. Allocation Pools digunakan untuk menentukan rentang atau jangkauan alamat IP
yang didistribusikan secara dinamis oleh server DHCP ke client DHCP vyaitu dari
192.168.123.50 sampai dengan 192.168.123.75. Nilai yang dituliskan inputan
tersebut adalah 192.168.123.50,192.168.123.75. Tanda koma (,) digunakan

sebagai pemisah antar nilai yang bermakna “sampai dengan”.

|
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c. DNS Name Servers digunakan untuk mengatur alamat IP dari Name Server yang
berperan untuk mentranslasikan nama domain ke alamat IP dan sebaliknya, sebagai

contoh digunakan alamat IP Google DNS yaitu 8.8.8.8.

Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Create untuk

memproses pembuatan network dengan subnet tersebut, seperti terlihat pada gambar

berikut:

Create Network

Network Subnet Subnet Details

& Enable DHCP

Specify additional attributes for the subnet.
Allocation Pools @

192.168.123.50,192.168.123.75

Host Routes @

Cancel « Back | Create
Tampil pesan notifikasi keberhasilan pembuatan network. Selain itu pada halaman
Networks telah menampilkan informasi terkait network yang dibuat yaitu networkl-
belajar dengan subnet 192.168.123.0/24 yang diasosiasikan ke network tersebut dan
lakukan pembuatan network baru kembali dengan menekan tombol Create Network,

seperti terlihat pada gambar berikut:
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3 openstack = velajar-0827068001 ~ & 0827068001 ~

Project / Network / Networks

COMPUTE >

NETWORK v Networks

Network Topology

Name =+ Filter + Create Network i Delete Networks
Networks

Routers O Name Subnets Associated Shared External Status Admin State  Actions
ORCHESTRATION > O  provider-network-belajar + provider-subnet-belajar 172.16.0.0/24 No Yes Active up Edit Network ~ +
OBJECT STORE > m} Inetwork1-belajar * subneti-belajar 192.168.123.0/24 No No Active  UP I Edit Network  +
. Identity > Displaying 2 items ~)

Tampil kotak dialog Create Network dan pada tab Network lengkapi inputan Name yang
digunakan untuk mengatur nama dari network yang akan dibuat yaitu bernama
"network2-belajar" dan tekan tombol Next >> untuk melanjutkan pengisian Subnet,

seperti terlihat pada gambar berikut:

Create Network

Subnet Subnet Details

Network Name Create a new network. In addition, a subnet associated

network2-belajar with the network can be created in the following steps of
this wizard.

Admin State @
UP -
O Shared @

™ Create Subnet

Cancel « Back

Tampil kotak dialog Create Network untuk tab Subnet dan lengkapi inputan berikut:

a. Subnet Name digunakan untuk mengatur nama subnet yang akan dibuat yaitu
subnet2-belajar.
b. Network Address digunakan untuk mengatur alamat jaringan yang digunakan oleh

subnet yang dibuat yaitu 192.168.234.0/24.
'
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Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Next >> untuk

melanjutkan pengisian Subnet Details, seperti terlihat pada gambar berikut:

Create Network

Network Subnet Details

Subnet Name Creates a subnet associated with the network. You need

subnet2-belajar to enter a valid "Network Address” and "Gateway |P". If
you did not enter the "Gateway IP", the first value of a
Network Address¥ network will be assigned by default. If you do not want
gateway please check the "Disable Gateway" checkbox.
192 168.234.0/24 Advanced configuration is available by clicking on the
"Subnet Details” tab.
IP Version
IPv4 v
Gateway IP @

O Disable Gateway

Cancel « Back

Tampil kotak dialog tab Subnet Details dari kotak dialog Create Network dan lengkapi

inputan berikut:

a. Pastikan checkbox “Enable DHCP” telah tercentang (V) yang digunakan untuk
mengaktifkan fitur DHCP pada subnet sehingga alokasi pengalamatan IP ke instance
dilakukan secara dinamis.

b. Allocation Pools digunakan untuk menentukan rentang atau jangkauan alamat IP
yang didistribusikan secara dinamis oleh server DHCP ke client DHCP vyaitu dari
192.168.234.225 sampai dengan 192.168.234.250. Nilai yang dituliskan inputan
tersebut adalah 192.168.234.225,192.168.234.250. Tanda koma (,) digunakan
sebagai pemisah antar nilai yang bermakna “sampai dengan”.

c. DNS Name Servers digunakan untuk mengatur alamat IP dari Name Server yang
berperan untuk mentranslasikan nama domain ke alamat IP dan sebaliknya, sebagai

contoh digunakan alamat IP Google DNS yaitu 8.8.8.8.
-
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Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Create untuk

memproses pembuatan network dengan subnet tersebut, seperti terlihat pada gambar

berikut:

Create Network

Network Subnet Subnet Details

o4
IC Enable DHCPI Specify additional attributes for the subnet.
Allocation Pools 9\

[ 192.168.234.225,192.168.234.250

DNS Nam ers @

8888

Host Routes @

Cancel « Back

Tampil pesan notifikasi keberhasilan pembuatan network. Selain itu pada halaman
Networks telah menampilkan informasi terkait network yang dibuat yaitu network2-

belajar dengan subnet 192.168.234.0/24 yang diasosiasikan ke network tersebut, seperti
terlihat pada gambar berikut:
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0 openstack = bepar-0z27088001 ~

Project / Network / Networks

COMPUTE >

NETWORK . Networks

& 0827068001 +

Network Topology
Name =+ Filter + Create Network 1 Delete Networks
Networks
Routers O Name Subnets Associated Shared External Status Admin State  Actions
ORCHESTRATION > m] InetworkZ—belaJar « subnet2-belajar 192.168.234.0/24 No No Active UP] Edit Network ~ +
OBJECT STORE > O provider-network-belajar « provider-subnet-belajar 172.16.0.0/24 No Yes Active upP Edit Network ~ +
(dentity ’ O network1-belajar + subneti-belajar 192.168 123.0124 No No Acive  UP EditNewiork =

Displaying 3 items

Selanjutnya lakukan verifikasi hasil keseluruhan network pada project yang aktif saat ini

dengan memilih Network Topology pada panel sebelah kiri, seperti terlihat pada gambar

berikut:

3 openstack = vegjar-0827088001 ~

Project / N%fgvork I Network Topology

COMPUTE >

NETWORK . Network TOpOIOgy

Network Topology

Networks
Topology Graph
Routers

‘ #iSmall | 23 Normal
ORCHESTRATION ?

OBJECT STORE >

Identity >

S
o
=
a
&
F]
s
H
]
o
o
=
=3
2

S rziooalell

3
@
g
g
=
N
-3
=
=
[}

Fe/0 PEZ 891 THL

3
o
g
g
3|
&
e
=
]

& Launch Instance + Create Network + Create Router

PTIOET 1891 TE)

& 0827068001 +

Terlihat telah terdapat 3 (tiga) network pada project aktif yaitu provider-network-belajar

(ditandai dengan vertical bar berwarna biru), network1-belajar (ditandai dengan vertical

bar berwarna hijau) dan network2-belajar (ditandai dengan vertical bar berwarna

oranye).
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11. Membuat router bernama “router-belajar” dengan mengakses panel sebelah kiri dan
mengakses submenu Network Topology dari menu Project > NETWORK maka pada
panel detail sebelah kanan akan tampil halaman Network Topology. Tekan tombol Create

Router untuk membuat router baru, seperti terlihat pada gambar berikut:

n openstack 2 belajar-0827068001 ~ & 0827068001 v

Project / Nqigvork [ Network Topology

COMPUTE >
NETWORK . Network TOpOIOgy
I Network Topoloqyl
+ aunch Instance + Create Network
Networks

Topology Graph
Routers

£ Small | 83 Normal
ORCHESTRATION >

Tampil kotak dialog Create Router dan lengkapi inputan Router Name dengan nama
router yang akan dibuat, sebagai contoh “router-belajar”. Selain itu lengkapi pula inputan
External Network dengan memilih “provider-network-belajar” pada dropdown yang
merupakan network yang digunakan untuk mengkoneksikan ke Internet dan tekan tombol

Create Router untuk memproses pembuatan router, seperti terlihat pada gambar berikut:

Create Router

Router Name

router-belajar

Admin State

] -

External Network

provider-network-belajar A

Cancel Create Router

Tampil pesan notifikasi keberhasilan pembuatan router. Selain itu pada halaman Network
Topology menampilkan “router-belajar” yang telah dibuat dan terhubung ke provider-

network-belajar, seperti terlihat pada gambar berikut:
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n openstack & belajar-0827068001 +
Project ‘u v
Project / Network / Network Topology
COMPUTE >
wwore  ~  Network Topology
Network Topology
@ Launch Instance
Networks
Topology Graph
Routers
ORCHESTRATION >
OBJECT STORE >
Identity >

Router

Ielejag-yiomyau-lapiaoid

3 F
2 2
g Ef
3 3
= =
e =
-3 o
o o
& &
e =

+ Create Network

& 0827068001 v -

+ Create Router

Terlihat pula informasi alamat IP yang digunakan oleh interface pada router-belajar yang

terhubung ke provider-network-belajar yaitu 172.16.0.3.

Lakukan penambahan interface pada router agar terhubung ke setiap subnet dari

internal network yaitu subnetl-belajar dan subnet2-belajar. Tempatkan kursor mouse

diatas simbol dari router dengan nama “router-belajar” maka akan tampil kotak dialog

yang menampilkan informasi terkait Interfaces dan didalamnya memuat 3 (tiga) tombol

Add Interface dan Delete Interface serta Delete Router. Tekan tombol Add Interface

untuk menambahkan interface baru, seperti terlihat pada gambar berikut:

3 openstack = veigjar-0827068001

Project / Network / Network Topology

COMPUTE >
wmwore  +  Network Topology
Network Topology
& Launch Instance
Networks
Topology Graph
Routers
ORCHESTRATION ?
OBJECT STORE >
Identity > |

\

Router

lomyeu-1epinoid
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@ ACIVE

Interfaces

<+ Add Interfa fe

-,
172.16.0.3 router_gateway Active Jals= Al 10

» View Router Details

e7278952-1fa.

Delete Router

i

+ Create Network

& 0827068001 +

+ Create Router

51




PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

Tampil kotak dialog Add Interface dan pilih networkl-belajar 192.168.123.0/24
(subnetl-belajar) pada dropdown Subnet serta tekan tombol Submit untuk memproses

penambahan interface tersebut, seperti terlihat pada gambar berikut:

Add Interface

Subnet *

Description:

You can connect a specified subnet to the router

network1-belajar: 192 168.123.0/24 (subnet1-... =

IP Address (optional) @ e default IP address of the interface created is a
gateway of the selected subnet. You can specify
anothe address of the interface here. You must
select a subwgt to which the specified IP address

Router Name * _
belongs to fro e above list

router-belajar

Router ID *

78216d1c-6119-4fae-b0ed-4fb12fbi6542

Cancel b

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan interface telah
berhasil dilakukan dan pengguna akan diarahkan ke halaman router-belajar. Pada panel
sebelah kiri pilih sub menu Network Topology untuk mengakses kembali halaman

tersebut, seperti terlihat pada gambar berikut:

3 openstack = velgjar-0827088001 ~ & 0827068001 +

Project

I

Project / Network / Routers / router-belajar

COMPUTE >
router-belajar -
NETWORK v = J Iy
Network Topology
Overview Interfaces Static Routes
Networks Name router-belajar
ID 782f6d1c-6f19-4fae-b0ed-4fb12fbf6542
Routers Description
Project ID  89520120004b4305aec5ad4dfa0267db
ORCHESTRATION > Status  Active
Admin State UP
OBJECT STORE > Availability Zones * nova
Identity > External Gateway

Network Name  provider-network-belajar
Network ID  aiccf664-5b31-418f-a1d4-efc284i9edad
External Fixed IPs + Subnet ID 06ac8af4-9e96-44a0-b7f9-571233c61366
+ IP Address 172.16.0.3
SNAT  Enabled

Pada halaman Network Topology menampilkan “router-belajar” yang telah terhubung ke

network1-belajar, seperti terlihat pada gambar berikut:
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3 openstack & belajar-0827088001 ~

Project / Network / Network Topology

COMPUTE >

NETWORK . Network Topology "

& 0827068001 ~ -

Network Topology

& Launch Instance + Create Network + Create Router
Networks

Topology Graph
Routers

&2 Small | 82 Normal
ORCHESTRATION >
OBJECT STORE >

Identity >

]
o
= 3 =]
g H H
3 e E
e = =
Z ® 2
3 g g
2 H H
i e 0
3 2 2
.
2

Terlihat pula informasi alamat IP yang digunakan oleh interface pada router-belajar yang

terhubung ke network1-belajar yaitu 192.168.123.1.

Dengan cara yang sama maka lakukan kembali penambahan interface pada router agar
terhubung ke subnet2-belajar dari internal network. Tempatkan kursor mouse diatas
simbol dari router dengan nama “router-belajar’” maka akan tampil kotak dialog yang
menampilkan informasi terkait Interfaces dan didalamnya memuat 4 (empat) tombol
yaitu Add Interface dan Delete Interface serta Delete Router. Tekan tombol Add

Interface untuk menambahkan interface baru, seperti terlihat pada gambar berikut:

3 openstack = belajar-os27088001 +

Project / Network / Network Topology

COMPUTE >

NETWORK . Network TOpOIOgy

& 0827068001 +

Network Topology

& Launch Instance + Create Network + Create Router
Networks

Topology Graph
Routers

22 Small | 83 Normal
ORCHESTRATION >
OBJECT STORE >

Identity >

7
117 150 K
\

outer-he

[\
Router ’
—”

821601c-6M19-4fae-b0ed-4M 1216542

Interfaces

+ Add Interface

a63b1cf3-b9. 192.168.123.1 router_interface Active JDS(= RNk Y
©7278952-1fa... 172.16.0.3 router_gateway Active MR CHNGIERC

» View Router Details Delete Router

[g-y10m38U-18pIACId
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Tampil kotak dialog Add Interface dan pilih network2-belajar 192.168.234.0/24
(subnet2-belajar) pada dropdown Subnet serta tekan tombol Submit untuk memproses

penambahan interface tersebut, seperti terlihat pada gambar berikut:

Add Interface

Subnet *

Description:

You can connect a specified subnet to the router.

network2-belajar: 192.168.234.0/24 (subnet2-... «

IP Address (optional) @ e default IP address of the interface created is a
gat y of the selected subnet. You can specify
anothe address of the interface here You must
select a subwet to which the specified IP address

Router Name * i
belongs to fro e above list.

router-belajar

Router ID *

782i6d1c-6f19-4fae-b0ed-4fb 126542

Cancel b

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan interface telah
berhasil dilakukan dan pengguna akan diarahkan ke halaman router-belajar. Pada panel
sebelah kiri pilih sub menu Network Topology untuk mengakses kembali halaman

tersebut, seperti terlihat pada gambar berikut:

n ownstack = belajar-0827068001 + & 0827068001 «

I

Project
Project / Network / Routers / router-belajar

COMPUTE >

i Clear Gat -
NETWORK v I’OUter-be|ajar
Network Topology
Overview Interfaces Static Routes
Networks Name router-belajar
ID 782f6d1c-6f19-4fae-b0ed-4fb12fbf6542
Routers Description
Project ID  89520120004b4305aec5ad4dfa0267db
ORCHESTRATION > Status  Active
Admin State UP
OBJECT STORE > Availability Zones * nova
Identity > External Gateway

Network Name  provider-network-belajar
Network ID  aiccf664-5b31-418f-a1d4-efc284i9edad
External Fixed IPs + Subnet ID 06ac8af4-9e96-44a0-b7f9-571233c61366
+ IP Address 172.16.0.3
SNAT  Enabled

Pada halaman Network Topology menampilkan “router-belajar” yang telah terhubung ke

network2-belajar, seperti terlihat pada gambar berikut:

|
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3 openstack = belajar-os27068001 + & 0827068001 ~ =
Project / Network / Network Topology
COMPUTE >

NETWORK v Network TOpOIOgy

Network Topology

& Launch Instance + Create Network + Create Router
Networks

Topology Graph
Routers

#2Small | 83 Normal

ORCHESTRATION >
OBJECT STORE ?
Identity >

(:2) 192.168.234 1
outerbe..[eRSEE=—

Router
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Terlihat pula informasi alamat IP yang digunakan oleh interface pada router-belajar yang

terhubung ke network2-belajar yaitu 192.168.234.1.

12. Membuat 2 (dua) security group yaitu dengan nama "allow-ping" yang memiliki rule
untuk mengijinkan akses ICMP ke instance dan "allow-ssh" yang memiliki rule untuk
mengijinkan akses SSH ke instance dengan alamat IP sumber darimana pun. Pembuatan
security group tersebut dapat dilakukan dengan mengakses panel sebelah kiri dari
OpenStack Dashboard dan memilih Project serta memilih submenu COMPUTE - Access
& Security maka pada panel detail sebelah kanan akan tampil halaman Access & Security.
Tekan tombol Create Security Group untuk membuat security group baru, seperti terlihat

pada gambar berikut:

n openstack & belajar-0827088001 ~ & 0827068001 ~

I

Project

l COMPUTEI v
oenew  ACCESS & Security

Project / Computely Access & Security

Instances

Security Groups Key Pairs Floating 1Ps AP| Access
Volumes

Images | + Create Security Group | @ Delete Security Groups

Y =
Access & Security =) L Description Actions
NETWORK > 0O default Default security group Manage Rules
ORCHESTRATION > Displaying 1 item
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Tampil kotak dialog Create Security Group dan lengkapi inputan Name dengan nama
security group yang akan dibuat yaitu “allow-ping” serta tekan tombol Create Security
Group untuk memproses pembuatan security group tersebut, seperti terlihat pada

gambar berikut:

Create Security Group

Name *

Description:

Security groups are sets of IP filter rules that are applied
Description to the network settings for the VM. After the security group
is created, you can add rules to the security group.

allow-ping

Cancel eate Se oup

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan security group telah
berhasil dilakukan. Tekan tombol Manage Rules yang berada dibawah kolom Actions dari
security group “allow-ping” untuk menambahkan rule pada security group tersebut,

seperti terlihat pada gambar berikut:

n ogenstack 2 belajar-0827068001 v & 0827068001
Project / Compute / Access & Security

COMPUTE v

oeen ACCESS & Security

Instances

Security Groups Key Pairs Floating IPs AP Access
Volumes

Images + Create Security Group @ Delete Security Groups

Access & Security O Name Description Actions
NETWORK > O l aIIDW—pmg: > ! Manage Rules l -
ORCHESTRATION > O  default Default security group Manage Rules
OBJECT STORE >

Displaying 2 items

Tampil halaman Manage Security Group Rules: allow-ping dan tekan tombol Add Rule,

seperti terlihat pada gambar berikut:
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n openstack = belajar-0827068001 + & 0827068001 «
Project wh v
Project / Compute / Access & Security / Manage Security Group Rul
COMPUTE v

weves  Manage Security Group Rules: allow-ping
(bcO5bc7e-e757-4994-9955-b6857305a251)

Instances

Volumes

| +Add Rule I }
Images
O  Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group Actions
Access & Security
O  Egress 1Pvd Any Any 0.0.0.0/0 = Delete Rule
NETWORK >
ORCHESTRATION > O Egress IPv6 Any Any 10 - Delete Rule
OBJECT STORE > Displaying 2 items

Tampil kotak dialog Add Rule dan lengkapi inputan berikut:

a. Rule digunakan untuk mendefinisikan trafik yang diijinkan ke instance. Pilih ALL
ICMP pada dropdown untuk mengijinkan keseluruhan Internet Control Message
Protocol (ICMP).

b. Direction digunakan untuk menentukan arah pemfilteran yaitu pilih Ingress pada
dropdown sehingga mengijinkan trafik ICMP yang masuk ke instance.

c. Remote digunakan untuk menentukan sumber dari trafik yang diijinkan yaitu pilih
CIDR pada dropdown.

d. CIDR digunakan untuk mengijinkan ping dari alamat IP sumber mana pun, yaitu

0.0.0.0/0.

Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Add untuk

memproses pembuatan rule tersebut, seperti terlihat pada gambar berikut:

|
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Add Rule
Rule *
o one . Description:
Rules define which traffic is allowed to instances assigned
Direction to the security group. A security group rule consists of
three main parts:
Ingress v

Rule: You can specify the desired rule template or use
Remote * © custom rules, the options are Custom TCP Rule, Custom
UDP Rule, or Custom ICMP Rule.

CIDR v

Open Port/Port Range: For TCP and UDP rules you may
choose to open either a single port or a range of ports
Selecting the "Port Range” option will provide you with
@ space to provide both the starting and ending ports for the
range. For ICMP rules you instead specify an ICMP type

and code in the spaces provided

CIDR@

Remote: You must specify the source of the traffic to be
allowed via this rule. You may do so either in the form of
an |IP address block (CIDR) or via a source group

rity Group). Selecting a security group as the source
will allow her instance In that security group access
to any other instan wafhis rule

Cancel

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan rule telah berhasil
dilakukan. Selain itu pada halaman Manage Security Group Rules: allow-ping
menampilkan informasi terkait rule yang dibuat dengan Direction Ingress dan IP Protocol

ICMP serta Remote IP Prefix 0.0.0.0/0, seperti terlihat pada gambar berikut:

n openstack & belajar-0827088001 ~ & 0827068001 ~

Success: Successfully added rule:

Project / Compute / Access & Security / Manage Security Group Rul
ALLOW [Pv4 icmp from 0.0.0.0/0

o Manage Security Group Rules: allow-ping
(bcO5bc7e-e757-4994-9955-b6857305a251)

Instances

Volumes
+ Add Rule i Delete Rules
Images
O  Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group Actions
Access & Security|
O  Egress 1Pvd Any Any 0.0.0.0/0 = Delete Rule
NETWORK >
ORCHESTRATION > LY, Egress IPv6 Any Any 10 - Delete Rule
OBJECT STORE > O |ingress IPv4 ICMP Any 0.0.0.0/q - Delete Rule
Identity > Displaying 3 items

Dengan cara yang sama, lakukan kembali pembuatan security group baru dengan
memilih submenu Access & Security pada panel sebelah kiri dari menu Project >

COMPUTE maka pada panel detail sebelah kanan akan tampil halaman Access & Security.
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Tekan tombol Create Security Group untuk membuat security group, seperti terlihat pada

gambar berikut:

n openstack & belajar-0827068001 & 0827068001 +
k
Project / Compute / Access & Security
COMPUTE v

oenew  ACCESS & Security

Instances

Security Groups Key Pairs Floating IPs AP| Access
Volumes

Images > ! + Create Security Group I ' Delete Security Groups

Access & Security| (I Description Actions
NETWORK > DO allow-ping Manage Rules | ~
ORCHESTRATION > O default Default security group Manage Rules
OBJECT STORE >

Displaying 2 items

Tampil kotak dialog Create Security Group dan lengkapi inputan Name dengan nama
security group yang akan dibuat yaitu “allow-ssh” serta tekan tombol Create Security

Group untuk memproses pembuatan security group tersebut, seperti terlihat pada

gambar berikut:

Create Security Group

Name *

allow-ssh Description:

Security groups are sets of P filter rules that are applied
Description to the network settings for the VM. After the security group
is created, you can add rules to the security group.

Cancel eate Se oup

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan security group telah
berhasil dilakukan. Tekan tombol Manage Rules yang berada dibawah kolom Actions dari
security group “allow-ssh” untuk menambahkan rule pada security group tersebut,

seperti terlihat pada gambar berikut:
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n openstack = belajar-0827068001 + & 0827068001 «
w Project / Compute / Access & Security Success: Successfully created security
group: allow-ssh
COMPUTE v
oenew  ACCESS & Security
Instances
Security Groups Key Pairs Floating IPs APl Access
Volumes
Images + Create Security Group 1l Delete Security Groups.
Access & Security O Name Description Actions
NETWORK > O allow-ping Manage Rules |+
ORCHESTRATION > o @ 3| Manage Rules | «
OBJECT STORE >
0O  default Default security group Manage Rules

Identity

Displaying 3 items

Tampil halaman Manage Security Group Rules: allow-ping dan tekan tombol Add Rule,

seperti terlihat pada gambar berikut:

3 openstack = veiajar-0827068001 & 0827068001 ~

I}
Project / Compute / Access & Security / Manage Security Group Rul

COMPUTE v

oewew  Manage Security Group Rules: allow-ssh
s (8€D09b6f-affa-4917-b92a-67523h5e2718)

Volumes

+ Add Rule i Delete Rules

Images

m} Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group Actions
Access & Security
m] Egress IPv6 Any Any 10 - Delete Rule
NETWORK >
ORCHESTRATION > O Earess 1Pv4 Any Any 0.0.0.000 - Delete Rule
OBJECT STORE > Displaying 2 items

Tampil kotak dialog Add Rule dan lengkapi inputan berikut:

a. Rule digunakan untuk mendefinisikan trafik yang diijinkan ke instance. Pilih SSH
pada dropdown untuk mengijinkan trafik Secure Shell (SSH) yang masuk ke
instance.

b. Remote digunakan untuk menentukan sumber dari trafik yang diijinkan yaitu pilih
CIDR pada dropdown.

c. CIDR digunakan untuk mengijinkan ping dari alamat IP sumber mana pun, yaitu

0.0.0.0/0.

Hasil dari pengisian keseluruhan inputan tersebut dan penekanan tombol Add untuk

memproses pembuatan rule tersebut, seperti terlihat pada gambar berikut:
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Add Rule

Rule *
oy Description:
Rules define which traffic 1s allowed to instances assigned
Remote @ to the security group. A security group rule consists of
three main parts:
CIDR v
Rule: You can specify the desired rule template or use
CIDR @ custom rules, the options are Custom TCP Rule, Custom
UDP Rule, or Custom ICMP Rule.
0000/0
Open Port/Port Range: For TCP and UDP rules you may

choose to open either a single port or a range of ports.
Selecting the "Port Range” option will provide you with
space to provide both the starting and ending ports for the
range. For ICMP rules you instead specify an ICMP type
and code in the spaces provided.

Remote: You must specify the source of the traffic to be

ed via this rule. You may do so either in the form of
an IP ss block (CIDR) or via a source group
(Security Gro electing a security group as the source
will allow any other in e in that security group access
to any other instance via this

Cancel Add

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan rule telah berhasil
dilakukan. Selain itu pada halaman Manage Security Group Rules: allow-ssh
menampilkan informasi terkait rule yang dibuat dengan Direction Ingress, IP Protocol TCP
dan Port Range 22 (SSH) serta Remote IP Prefix 0.0.0.0/0, seperti terlihat pada gambar

berikut:

3 openstack = belajar-0827088001 ~ & 0827068001 ~

S
. Suc § lar
Project / Compute / Access & Security / Manage Security Group Rul Success: Successiully added rule

COMPUTE o ALLOW IPv4 22/tcp from 0.0.0.0/0

oenen  Manage Security Group Rules: allow-ssh
(8¢509b6f-affa-4917-b92a-67523b5e2718)

Instances

Volumes
+Add Rule
Images
a Direction Ether Type IP Protocol Port Range Remote IP Prefix Remote Security Group Actions
Access & Security
m] Egress IPv6 Any Any 10 - Delete Rule

NETWORK >

ORCHESTRATION > O Egress 1Pv4 Any Any 0.0.0.00 - Delete Rule

OBJECT STORE > O |ingress IPvd TCP 22 (SSH) 0.0.0.000 | = Delete Rule

Identity > Displaying 3 items
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13. Membuat 2 (dua) instance bernama “instance123” dan “instance234” dengan dengan
mengakses panel sebelah kiri dan memilih Project serta memilih submenu COMPUTE >
Instances maka pada panel detail sebelah kanan akan tampil halaman Instances. Tekan

tombol Launch Instance untuk membuat instance baru, seperti terlihat pada gambar

berikut:
u opensta(k = belajar-0827068001 ~ & 0827068001 ~
Project / Compute / Inst%]ces
COMPUTE v
oewen INStANCES
I Insiancesl

BRI R Ellter & Launch Instance

Volumes
Instance Image IP . Key Availability Power Time since .

Images

. Name Name Address Size Pair Status Zone Task State created Actions

Access & Security No items to display.

Tampil kotak dialog Launch Instance untuk tab Details dan lengkapi inputan Instance
Name dengan nama instance yang akan dibuat yaitu insancel23 serta pada vertical bar
sebelah kiri pilih Source untuk melanjutkannya proses pembuatan instance, seperti

terlihat pada gambar berikut:

I+
Launch Instance

. Please provide the initial hostname for the instance, the availability zone where it will be deployed, and the instance 9
Details . )
count Increase the Count to create multiple instances with the same settings
Instance Name * Total Instances (10 Max)
instance123
*
Flavor 10%

Availability Zone
Networks *

nova v
M 0 Current Usage
Network Ports
Count ® 1 Added .
9 Remaining

Security Groups 1
Key Pair
Configuration
Server Groups
Scheduler Hints
Metadata
x Cancel < Back MNext » & Launch Instance
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Tampil kotak dialog Launch Instance dari tab Source untuk memilih template image yang
digunakan oleh instance yang akan dibuat. Lakukan penekanan tombol + pada image
dengan nama cirros-belajar yang terdapat di bagian Available untuk menambahkan

image tersebut ke bagian Allocated, seperti terlihat pada gambar berikut:

Launch Instance

Instance source is the template used to create an instance You can use a snapshot of an existing instance, an 9
Details . y . R

image, or a volume (if enabled). You can also choose to use persistent storage by creating a new volume

seIeCt BOOt Source
Image v
Flavor *
Networks * Allocated
Name Updated Size Type Visibility
Network Ports
Select an item from Available items below

Security Groups

+ Available Select one
Key Pair Q  Click here for filters x
Configuration Name Updated size Type Visibility
Server Groups > ciros-belajar 3/29/23 8:50 AM 1213 MB qcow? Private
Scheduler Hints

> cirros 3M6/M17 3:19 AM 12.65 MB qcow2 Public +

Metadata
X Cancel < Back Next » & Launch Instance

Hasil dari penambahan image tersebut ke bagian Allocated dari tab Source dan pemilihan

tab Flavor pada vertical bar sebelah kiri untuk melanjutkan proses pembuatan instance,

seperti terlihat pada gambar berikut:

Launch Instance

Details

Source

Instance source is the template used to create an instance. You can use a snapshot of an existing instance, an 9
image, or a volume (if enabled). You can also choose to use persistent storage by creating a new volume.

Select Boot Source

Image
Networks * Allocated
Name Updated Size Type Visibility
Network Poris
> |cirros-belajar 3/29/23 8:50 AM 12.13 MB qgcow?2 Private -
Security Groups
v Available Select one
Key Pair
Q | Click here for filters. x
Configuration
Name Updated Size Type Visibility
Server Groups
> cirros 3M16/17 3:19 AM 12.65 MB qecow2 Public +
Scheduler Hints
Metadata
x Cancel < Back Next > & Launch Instance
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Tampil kotak dialog Launch Instance dari tab Flavor untuk memilih flavor yang digunakan
oleh instance yang akan dibuat. Flavor memuat konfigurasi perangkat keras (hardware)
yang didefinisikan meliputi jumlah Virtual Central Processing Units (VPCUS), ukuran
Random Access Memory (RAM) dan disk drive yang dialokasikan untuk instance. Lakukan
penekanan tombol + pada flavor dengan nama ml.tiny yang terdapat di bagian Available
untuk menambahkan flavor tersebut ke bagian Allocated, seperti terlihat pada gambar

berikut:

Launch Instance

Flavors manage the sizing for the compute, memory and storage capacity of the instance. 9
Details

Allocated
Source Name VCPUS RAM Total Disk Root Disk Ephemeral Disk Public

Select an item from Available items below
Networks * + Available Select one
Network Ports Q | Click here for filters x
Name VCPUS RAM Total Disk Root Disk Ephemeral Disk Public
Security Groups
) > mitiny 1 512MB 1GB 1GB 0GB Yes B

Key Pair
Configuration > mismall 1 2GB 20 GB 20 GB 0GB Yes +
Server Groups > mimedium 2 4GB 40 GB 40 GB 0GB Yes +
Scheduler Hints > milarge 4 8 GB 80 GB 80 GB 0GB Yes +
Metadata > mixage 8 16GB 160 GB 160 GB 0GB Yes +
% Cancel < Back Next » | ‘

Hasil dari penambahan flavor tersebut ke bagian Allocated dari tab Flavor dan pemilihan
tab Networks pada vertical bar sebelah kiri untuk melanjutkan proses pembuatan

instance, seperti terlihat pada gambar berikut:

|
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Launch Instance

Details

Source

Flavors manage the sizing for the compute, memory and storage capacity of the instance. 9
Allocated
Name VCPUS RAM Total Disk Root Disk Ephemeral Disk Public

>Im1tiny 1 512MB  1GB 1GB 0GB Yesl -

Network Ports
Security Groups
Key Pair
Configuration
Server Groups
Scheduler Hints

Metadata

x Cancel

v Available Select one
Q  Click here for filters. x
Name VCPUS RAM Total Disk Root Disk Ephemeral Disk Public
> m1small 1 2GB 20 GB 20 GB 0GB Yes +
> mimedium 2 4GB 40 GB 40 GB 0GB Yes +
> milarge 4 8 GB 80 GB 80 GB 0GB Yes +
> m1.xlarge 8 16 GB 160 GB 160 GB 0GB Yes +

< Back Next > & Launch Instance

Tampil kotak dialog Launch Instance dari tab Networks untuk memilih network yang

digunakan oleh instance yang akan dibuat. Lakukan penekanan tombol + pada network

dengan nama network1-belajar yang terdapat di bagian Available untuk menambahkan

network tersebut ke bagian Allocated, seperti terlihat pada gambar berikut:

g’

Launch Instance

Details

Source

Flavor

Network Ports

Security Groups

Key Pair

Configuration

Server Groups

Scheduler Hints

Metadata

x Cancel

Networks provide the communication channels for instances in the cloud. 9
w Allocated Select networks from those listed below:

Network Subnets Associated Shared Admin State Status

Select an item from Available items below

w Available Select at least one network
Q  Click here for filters. x
Network Subnets Associated Shared Admin State Status
> network2-belajar subnet2-belajar No Up Active +
> provider-network-belajar provider-subnet-belajar No Up Active +
> network1-belajar subneti-belajar No Up Active B

< Back Next > & Launch Instance
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Hasil dari penambahan network tersebut ke bagian Allocated dari tab Networks dan
pemilihan tab Security Group pada vertical bar sebelah kiri untuk melanjutkan proses

pembuatan instance, seperti terlihat pada gambar berikut:

Launch Instance

Networks provide the communication channels for instances in the cloud 9
Details

+ Allocated Select networks from those listed below.
Source Network Subnets Associated Shared Admin State Status
Flavor %1 I > network1-belajar subneti-belajar No Up Actwe] -

Networks
v Available Select at least one network

Network Ports Q| Click here for filters x
Network Subnets Associated Shared Admin State Status

Key Pair > network2-belajar subnet2-belajar No Up Active +

Configuration > provider-network-belajar provider-subnet-belajar No Up Active +

Server Groups
Scheduler Hints

Metadata

X Cancel <Back Next > & Launch Instance

Tampil kotak dialog Launch Instance dari tab Security Groups untuk memilih security
group yang digunakan oleh instance yang akan dibuat. Lakukan penekanan tombol + pada
security group dengan nama allow-ssh dan allow-ping yang terdapat di bagian Available
untuk menambahkan kedua security group tersebut ke bagian Allocated, seperti terlihat

pada gambar berikut:
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Launch Instance

Select the security groups to launch the instance in
Details yareue 9
w Allocated
Source Name Description
Flavor > default Default security group -
Networks
w Available Select one or more
Network Ports Q | Click here for filters. *

Name peseription
Key Pair > allow-ssh B

Configuration > allow-ping

Server Groups
Scheduler Hints

Metadata

x Cancel < Back Next > & | aunch Instance

Hasil dari penambahan kedua security group tersebut ke bagian Allocated dari tab
Security Groups dan penekanan tombol Launch Instance untuk melanjutkan proses

pembuatan instance dengan pengaturan tersebut, seperti terlihat pada gambar berikut:

Launch Instance

Select the security groups to launch the instance in.
Details ygroup 9
v Allocated
Source Name Description
Flavor > default Default security group -
Networks s [alow-ssh _
Network Ports
¥ |allow-ping -
Security Groups
~ Available Select one or more
Key Pair
Q  Click here for filters. x
Configuration
g Name scription
Server Groups No a ble items
Scheduler Hints
Metadata
x Cancel < Back Next >

Tampil pesan notifikasi yang menginformasikan bahwa pembuatan instance dengan

nama tersebut telah berhasil dilakukan. Selain itu pada halaman Instances menampilkan
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informasi terkait Status dari proses pembuatan instancel23, seperti terlihat pada gambar

berikut:

n openstack & belajar-0827068001 ~ & 0827068001 ~

Project / Compute / Instances
COMPUTE v

oenew INStAnces

Instances
Instance Name =+ Filter & Launch Instance More Actions +
Volumes
Instance Image P R Key Availability Power Time since N
Images Size Status Task Actions
Name Name Address Pair Zone State created
Access & Security
instance12  cirros- No
m] 3 e mitiny - Build nova - State 0 minutes Associate Floating IP | =
NETWORK > L SEawning
NRCHEQTRATINM A D‘Sp‘aylng 1 item

Terlihat Status dari instance123 masih bernilai Build yang menandakan bahwa instance

tersebut masih dalam proses pembuatan. Selain itu Task dari instance123 masih bernilai

Spawning.

Setelah Power State dari instancel23 bernilai Running maka pilih dropdown menu yang
terdapat di sebelah kanan tombol Create Snapshot dari instance tersebut dan pilih

Associate floating IP, seperti terlihat pada gambar berikut:

3 openstack & velgjar-0s27088001 ~

Project / Compute / Instances

COMPUTE v

oeven INStANCES

& 0827068001 ~

Instances
Volumes Instance Name = ~ Filter & Launch Instance More Actions =
Time
Images Instance Image Ke Availabili Power
(m] g IP Address Size y Status ty Task since Actions
Name Name Pair Zone State created
Access & Security
1 1 -
NETWORK N o \2n35 ance EZ:J; e 192.168.123.57 mitiny - Active  nova None 1 minute Create Snapshat 9
ORCHESTRATION > Displaying 1 item Associate Floating IfJ

Attach Interface

Tampil kotak dialog Manage Floating IP Associations dan lengkapi inputan IP Address
dengan memilih pilihan “172.16.0.123” pada dropdown menu serta “instancel23:
192.168.123.57” sebagai pilihan pada dropdown menu Port to be associated. Setelah
kedua inputan tersebut dilengkapi maka lakukan penekanan tombol Associate untuk

memproses asosiasi floating IP ke instance tersebut, seperti terlihat pada gambar berikut:
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Manage Floating IP Associations

IP Address *

Select the IP address you wish to associate with the

172.16.0.123 - = selected instance or port.

Port to be associated *

instance123: 192 168 123 .57

Tampil pesan notifikasi keberhasilan pengasosiasian alamat IP tersebut. Selain itu pada
halaman Instances telah menampilkan informasi terkait instance123 yang menggunakan
floating IP 172.16.0.123 dan penekanan tombol Launch Instance untuk membuat kembali

instance baru, seperti terlihat pada gambar berikut:

3 openstack = vegjar-0827088001 ~

:
Project / Compute / Instances Success: IP address 172.16.0.123

COMPUTE v associated

oevenINStANCES

& 0827068001 «

Instances

Instance Name =~ Filter
Volumes

& Launch Instance 1l Delete Instances More Actions «

Instance Image . Key Power Time since R
Images 3
g Name Name IP Address Size Stat Zone Task state created Actions
Access & Security . 102168 123 57
instance12  cirros-
NETWORK > 3 belajar Floating IPs Active  nova None Running 4 minutes Create Snapshot | «
o [172.16.0.123
ORCHESTRATION >

Displaying 1 item

Tampil kotak dialog Launch Instance untuk tab Details dan lengkapi inputan Instance
Name dengan nama instance yang akan dibuat yaitu insance234 serta pada vertical bar

sebelah kiri pilih Source untuk melanjutkannya proses pembuatan instance, seperti

terlihat pada gambar berikut:
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Launch Instance
Please provide the initial hostname for the instance, the availability zone where it will be deployed, and the instance 9
Details I N .
count. Increase the Count to create multiple instances with the same settings.
Instance Name * Total Instances (10 Max)
instance234 -
Flavor *

20%
Availability Zone
Networks *
nova

W 1 Current Usage

Network Ports Count * 1 Added
8 Remaining

Security Groups 1
Key Pair

Configuration

Server Groups

Scheduler Hints

Metadata

x Cancel < Back Next » & Launch Instance

Tampil kotak dialog Launch Instance dari tab Source untuk memilih template image yang
digunakan oleh instance yang akan dibuat. Lakukan penekanan tombol + pada image
dengan nama cirros-belajar yang terdapat di bagian Available untuk menambahkan
image tersebut ke bagian Allocated, seperti terlihat pada gambar berikut:

[

Launch Instance

Instance source is the template used to create an instance. You can use a snapshot of an existing instance, an 9
image, or a volume (if enabled). You can also choose to use persistent storage by creating a new volume.

seIeCt BDOt source

Details

Image v
Flavor *
Networks * Allocated
Name Updated Size Type Visibility

Network Ports
Select an item from Available items below

Security Groups

w Available Select one

Key P:

ey Q | Click here for filters. %
Configuration Name Updated Size Type Visibility
Server Groups > cirros-belajar 3/29/23 850 AM 12.13 MB qeow? Private B
Scheduler Hints .

¥ cirros 31617 319 AM 12.65 MB qcow2 Public +

Metadata
x Cancel < Back Next > & Launch Instance
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Hasil dari penambahan image tersebut ke bagian Allocated dari tab Source dan pemilihan
tab Flavor pada vertical bar sebelah kiri untuk melanjutkan proses pembuatan instance,

seperti terlihat pada gambar berikut:

Launch Instance [}

Instance source is the template used to create an instance. You can use a snapshot of an existing instance, an 9
image, or a volume (if enabled). You can also choose to use persistent storage by creating a new volume

seleCt Boo'. source

Details

Image v
Networks * Allocated
Name Updated Size Type Visibility
Network Ports
> | cirros-belajar 3/29/23 8:50 AM 12.13 MB qrow2 Private I -
Security Groups
w Available Select one
Key Pair
Q | Click here for filters. x
Configuration
Name Updated Size Type Visibility
Server Groups
> cirros 3/16/17 3:19 AM 12.65 MB qcow2 Public +
Scheduler Hints
Metadata
% Cancel < Back Next > I I

Tampil kotak dialog Launch Instance dari tab Flavor untuk memilih flavor yang digunakan
oleh instance yang akan dibuat. Flavor memuat konfigurasi perangkat keras (hardware)
yang didefinisikan meliputi jumlah Virtual Central Processing Units (VPCUS), ukuran
Random Access Memory (RAM) dan disk drive yang dialokasikan untuk instance. Lakukan
penekanan tombol + pada flavor dengan nama ml.tiny yang terdapat di bagian Available
untuk menambahkan flavor tersebut ke bagian Allocated, seperti terlihat pada gambar

berikut:
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Launch Instance

Flavors manage the sizing for the compute, memory and storage capacity of the instance.

Details
Allocated
Source Name VCPUS RAM Total Disk Root Disk Ephemeral Disk
Select an item from Available items below
Networks * w Available

Network Ports Q  Click here for filters

Name VCPUS RAM Total Disk Root Disk Ephemeral Disk

Security Groups

> m1tiny 1 512MB  1GB 1GB 0GB
Key Pair
Configuration > m1.small 1 2GB 20GB 20GB 0GB
Server Groups > m1medium 2 4GB 40 GB 40 GB 0GB
Scheduler Hints > milarge 4 8GB 80 GB 30 GB 0GB
Metadata > mixarge 8 16GB 160 GB 160 GB 0GB
x Cancel < Back Next >

Public
Select one
x

Public
Yes
Yes +
Yes +
Yes +
Yes +

& L aunch Instance

Hasil dari penambahan flavor tersebut ke bagian Allocated dari tab Flavor dan pemilihan

tab Networks pada vertical bar sebelah kiri untuk melanjutkan proses pembuatan

instance, seperti terlihat pada gambar berikut:

Ly
Launch Instance

Flavors manage the sizing for the compute, memory and storage capacity of the instance.

Details
Allocated
Source Name VCPUS RAM Total Disk Root Disk Ephemeral Disk Public
Flavor mitiny 1 512MB  1GB 1GB 0GB Yes | -
w Available Select one
Network Ports Q  Click here for filters. x
Security Groups Name VCPUS RAM Total Disk Root Disk Ephemeral Disk Public
Key Pair ? mismall 1 2GB 20GB 20 GB 0GB Yes +
Configuration > mimedium 2 4GB 40GB 40 GB 0GB Yes +
Server Groups
> milarge 4 8 GB 80 GB 80 GB 0GB Yes +
Scheduler Hints
> mixlarge 8 16 GB 160 GB 160 GB 0GB Yes +
Metadata
x Cancel < Back Next > & Launch Instance

Tampil kotak dialog Launch Instance dari tab Networks untuk memilih network yang

digunakan oleh instance yang akan dibuat. Lakukan penekanan tombol + pada network
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dengan nama network2-belajar yang terdapat di bagian Available untuk menambahkan

network tersebut ke bagian Allocated, seperti terlihat pada gambar berikut:

Laun% Instance

Networks provide the communication channels for instances in the cloud. 9
Details
+ Allocated Select networks from those listed below.
Source Network Subnets Associated Shared Admin State Status
Flavor Select an item from Available items below
v Avalable Seectatieastons netuork
Network Ports Q | Click here for filters. x
Network Subnets Associated Shared Admin State Status
Security Groups
X > network2-belajar subnet2-belajar No Up Active B
Key Pair
Configuration > provider-network-belajar provider-subnet-belajar No Up Active +
Server Groups > network1-belajar subnet1-belajar No Up Active +
Scheduler Hints
Metadata
® Cancel < Back Next » & Launch Instance

Hasil dari penambahan network tersebut ke bagian Allocated dari tab Networks dan
pemilihan tab Security Group pada vertical bar sebelah kiri untuk melanjutkan proses

pembuatan instance, seperti terlihat pada gambar berikut:

Launch Instance

Networks provide the communication channels for instances in the cloud 9
Details

+ Allocated Select networks from those listed below.
Source Network Subnets Associated Shared Admin State Status
Flavor a1 > [network2-belajar subnet2-belajar No Up Active | -

Available Select at least one network

Network Ports Q | Click here for filters. x
Network Subnets Associated Shared Admin State Status

Key Pair 2> provider-network-belajar provider-subnet-belajar No Up Active +

Configuration » network1-belajar subneti-belajar No Up Active +

Server Groups
Scheduler Hints

Metadata

x Cancel < Back Next > & | aunch Instance
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Tampil kotak dialog Launch Instance dari tab Security Groups untuk memilih security

group yang digunakan oleh instance yang akan dibuat. Lakukan penekanan tombol + pada

security group dengan nama allow-ssh dan allow-ping yang terdapat di bagian Available

untuk menambahkan kedua security group tersebut ke bagian Allocated, seperti terlihat

pada gambar berikut:

Launch Instance

Details
 Allocated

Source Name
Flavor > default
Networks
w Available
Network Ports Q | Click here for filters

Security Groups Name

Key Pair > allow-ssh
Configuration > allow-ping
Server Groups
Scheduler Hints

Metadata

x Cancel

Select the security groups fo launch the instance in

Default security group

< Back

Select one or more

x

&
=

Next > & Launch Instance

Hasil dari penambahan kedua security group tersebut ke bagian Allocated dari tab

Security Groups dan penekanan tombol Launch Instance untuk melanjutkan proses

pembuatan instance dengan pengaturan tersebut, seperti terlihat pada gambar berikut:
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%aunch Instance

Select the security groups to launch the instance in
Details v aroup 9
v Allocated
Source Name Description
Flavor > default Default security group -
Networks 3 [alow-ssh _
Network Ports
> |allow-ping -
Security Groups
+ Available Select one or more
Key Pair
Q  Click here for filters. x
Configuration
g Name scription
Server Groups No & hle items
Scheduler Hints
Metadata
% Cancel < Back Next »

Tampil pesan notifikasi keberhasilan pembuatan instance. Selain itu pada halaman
Instances menampilkan informasi keseluruhan instance yang terdapat pada project aktif

termasuk instance234, seperti terlihat pada gambar berikut:

n openstack = belajar-0827088001 & 0827068001 +

Project / Compute / Instances
COMPUTE v

oeenINStANces

Instances
Instance Name =+ Filter & Launch Instance 1l Delete Instances. More Actions »
Volumes
Images Instance Image Key Availability Power Time
o IP Address Size © Status Task since Actions
Name Name Pair Zone State ted
Access & Security create
i - N
NETWORK > o ;;fnce ;g;;r mitiny - Build nova Scheduling S:)ate 0 minutes Associate Floating IP | =
ORCHESTRATION > . 192.168.123.57
I¥ - N
a nstance - aimos Floating IPs mi.tiny - Active  nova None Running 15 minutes Create Snapshot =+
OBJECT STORE > 123 belajar

= 172160123

Identity > Displaying 2 items

Terlihat kolom Status dari instance234 masih bernilai Build yang menandakan bahwa

instance tersebut masih dalam proses pembangunan.

Setelah Power State dari instance234 bernilai Running maka pilih dropdown menu yang
terdapat di sebelah kanan tombol Create Snapshot dari instance tersebut dan pilih

Associate floating IP, seperti terlihat pada gambar berikut:

|
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3 openstack = belajar-os27088001 +

Project / Compute / Instances

COMPUTE v

oeven INStANCES

& 0827068001 +

Instances

Instance Name = v Filter & Launch Instance i Delete Instances More Actions =
Volumes
Instance  Image Ke: Availabili Power Time since
Images a o IP Address Size y Status v Task Actions
Name Name Pair Zone State created

Access & Security

g |nstanceZ CiMOs- o) 168234226 mitiy - Active  nova None @ 0 minutes Create Snapshot
34 belajar
NETWORK >

Associate fploating IP
* 192.168.123.57

=
- Attach Interface
ORCHESTRATION 4 (m] nstance C\UDIS Floating IPs m1.tiny - Active  nova None Running 15 minutes ‘
23 belajar Detach Interface
OBJECT STORE > + 172.16.0.123 Edit Instance
— N Displaying 2 items Attach Volume

Tampil kotak dialog Manage Floating IP Associations dan lengkapi inputan IP Address
dengan memilih pilihan “172.16.0.234” pada dropdown menu serta “instance234:
192.168.234.226" sebagai pilihan pada dropdown menu Port to be associated. Setelah
kedua inputan tersebut dilengkapi maka lakukan penekanan tombol Associate untuk

memproses asosiasi floating IP ke instance tersebut, seperti terlihat pada gambar berikut:

Manage Floating IP Associations

IP Address *

Select the IP address you wish to associate with the
172.16.0.234 - + selected instance or port.

Port to be associated *

instance234: 192 168 234 226 v

Cancel Associate

Tampil pesan notifikasi keberhasilan pengasosiasian alamat IP tersebut. Selain itu pada

halaman Instances telah menampilkan informasi terkait instance234 yang menggunakan

floating IP 172.16.0.234, seperti terlihat pada gambar berikut:
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3 openstack = belajar-o827088001 ~ & 0827068001 ~
Project v~h .
Project / Compute / Instances Success: IP address 172.16.0.234
associated
COMPUTE v
oees INStANCES
Instances
Instance Name =~ Filter & Launch Instance 1@ Delete Instances. More Actions =
Volumes
Images a Instance Image |P Address size Ke.y status Availability Task Power Time since Actions
Name Name Pair Zone State created
Access & Security . 192 168 234 296
instance?  cirros- -
NETWORK > m} 34 belajar Floating IPs mitiny - Active  nova None Running 3 minutes Create Snapshot | =
o |172.16.0.234]
ORCHESTRATION ?
* 192.168.123.57
OBJECT STORE > [m] ;;tanceﬂ EZ:;; Floating IPs m1.tiny - Active  nova None Running 19 minutes Create Snapshot |
« 172.16.0.123
Identity >
Displaying 2 items

14. Mengakses console dari instancel23 dengan mengakses tab OpenStack Dashboard pada
browser. Pada panel menu sebelah kiri dari OpenStack Dashboard, pilih sub menu
Instances dari menu Project & COMPUTE maka pada panel detail sebelah kanan akan
menampilkan halaman Instances. Lakukan pengaksesan console dariinstancel123 dengan
menekan dropdown menu di sebelah kanan dari tombol Create Snapshot yang berada
dibawah kolom Actions dari instance tersebut dan memilih Console, seperti terlihat pada

gambar berikut:

a openstack = belajar-0827088001 + & 0827068001 v
Project / Compute / Instances
COMPUTE v

oewen INStances

Instances

Instance Name =~ Filter & Launch Instance 1 Delete Instances More Actions +
Volumes
Images a Instance Image |P Address size Ke.y status Availability Task Power Time since Actions
Name Name Pair Zone State created
Access & Security . 102 168 234 276
instance?  cirros- .
NETWORK > (u] 34 belajar Floating IPs mitiny - Active  nova None Running 3 minutes Create Snapshot =~

¢ 172.16.0.234
ORCHESTRATION >

* 192.168.123.57
Cirmos- .
OBJECT STORE > o @ I Floating IPs mi tiny - Active  nova None Running 19 minutes Create Snapshot .
e 172.16.0.123

Identity > Disassociate Floating IP

Displaying 2 items Attach Interface
Detach Interface
Edit Instance
Attach Volume

Detach Volumg

Update Metaflata

Groups

View Log

|
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Pada tab Console dari halaman instancel23 yang tampil, lakukan klik kanan pada link
atau tautan Click here to show only console dan pada popup menu yang tampil, pilih

Open link in new tab, seperti terlihat pada gambar berikut:

n openstack & belajar-0827068001 ~ & 0827068001 ~
Project / Compute / Instances / instance123
COMPUTE v
i Create Snapshot |
Overview Instance1 23 reate snapsnos
Instances
Overview Log Console Action Log
Volumes
mages INStance Console
Access & Security If console is not responding to keyboard input: click the grey status bar be\owlchck here to show only cawv“‘"
To exit the fullscreen mode, click the browser's back button *'Open link in new tab l N
NETWORK > Open link in new window

Open link in incognito window

ORCHESTRATION >

Save link as...
OBJECT STORE > Copy link address
Identity > 3 Download with Free Dawnload Manager

Terbuat tab baru pada browser yang menampilkan halaman noVNC console untuk
instancel23. Terlihat pada console tersebut terdapat inputan login yang meminta
penggunakan untuk memasukkan akun otentikasi. Apabila pada halaman noVNC hanya
menampilkan layar hitam maka tempatkan kursor ke dalam layar hitam tersebut dan
lakukan klik kiri pada mouse sehingga akan menampilkan inputan login. Pada inputan
login tersebut masukkan cirros sebagai nama user dan tekan Enter maka akan tampil
inputan Password: yang meminta pengguna untuk memasukkan sandi login. Masukkan

gocubsgo sebagai sandi dan tekan Enter, seperti terlihat pada gambar berikut:

n instance123 - OpenStack Dashl X I instance123(cc854e81- b-4a X I +

C A Not secure | 192.168.56.56:6080/vnc_auto.html?token=f8fca532-f3f7-483e-9e9c-59008060f9be&ititle=instance123(cc854e8... 1©2 v N = 0O @

Send CirlAitDel

’5, O devices found

ite protecting the k a:
b 1-1: new ful 3 d b uhci_hcd
1 Freeing unused ker 62f000 - ffrf86000

29191 Freeing unused kernel memory: 168K (ffff8600014dd6000 - ff{fE80001

further output written to sdev/tty
random: dd urandom with 22 bits of entropy available

s’ user. defau l: "gocubsgo’. use udo’ for root.
: nonblocking po is initialized

' gocubsgo’ . use ’sudo’ for root.

Apabila proses otentikasi login berhasil dilakukan maka akan tampil prompt $.
-
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Memverifikasi pengalamatan IP yang digunakan oleh instancel23 melalui console
dengan mengeksekusi perintah ip address. Selain itu memverifikasi alamat default
gateway dengan mengeksekusi ip route dan server DNS dengan mengeksekusi

perintah cat /etc/resolv.conf, sepertiterlihat pada gambar berikut:

B instance123 - OpenStack Dashbe X instance123(cc854e81-

C' A Notsecure | 192.168.56.56:6080/vnc_auto.htmli?token=f8fca532-f9f7-483e-9e9c-590080609be’title=instance123(cc854e8... 1©# Y M = O @

Send CtrlAltDel

ER_UP> mtu

Hasil eksekusi perintah ip address menunjukkan informasi yaitu alamat IP dari

interface ethO instancel23 yang diperoleh secara dinamis dari DHCP Server adalah
192.168.123.57. Sedangkan dari hasil eksekusi perintah ip route diperoleh informasi
yaitu default gateway yang digunakan instance123 adalah 192.168.123.1. Terakhir dari
hasil eksekusi perintah cat /etc/resolv.conf memperlihatkan alamat IP
Nameserver yang digunakan untuk mentranslasi nama domain ke alamat IP dan

sebaliknya yaitu 8.8.8.8.

Memverifikasi koneksi Internet dari Console instance123 ke salah satu situs di Internet,
sebagai contoh ke google.com dengan mengeksekusi perintah ping google.com,

seperti terlihat pada gambar berikut:

|
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r al
v _

B instance123 - OpenStack Dashbe X instance123(cc854e81-696b-4a1: X +
C A Not secure | 192.168.56.56:6080/vnc_auto.html?token=f8fca532-f3f7-483e-9e9c-59008060f9be&title=instance123(cc854e8... 1©2 v N = 0O @

Send CirlAitDel

isc pfifo_fast glen 1000
ff
global eth®

68.123.1 dev etho

Slping go

Terlihat verifikasi koneksi dari instancel23 ke google.com berhasil dilakukan. Tekan

CTRL+C untuk menghentikan ping.

15. Mengakses console dari instance234 dengan mengakses tab OpenStack Dashboard pada
browser. Pada panel menu sebelah kiri dari OpenStack Dashboard, pilih sub menu
Instances dari menu Project & COMPUTE maka pada panel detail sebelah kanan akan
menampilkan halaman Instances. Lakukan pengaksesan console dari instance234 dengan
menekan dropdown menu di sebelah kanan dari tombol Create Snapshot yang berada
dibawah kolom Actions dari instance tersebut dan memilih Console, seperti terlihat pada

gambar berikut:

r ]
In nstances - OpensStack Dashboar X | instance123(cc854e81-696b4a1. X | + M o 3
< c Not secure | 192.168.56.56/horizon/project/instances/ =2 Yy R = 0O @
n openstack | = belajar-0827068001 = & 0827068001 ~

Project / Compute / Instances
COMPUTE v
oeves  INStANCES
pstance Name = = Filter & Launch Instance More Actions =
Volumes
Images 0 Instance  Image |P Address size S v Availability Task Power Time since Actions
Name Name Pair ofre State created

Access & Security

* 192.168.234.226
cirros-
NETWORK > O belajar Floating IPs mi.tiny - Active  nova None Running 21 minutes Create Snapshot n
« 172.16.0.234

ORCHESTRATION >

Disassaciate Floating IR,

+ 192168.123 57 Attach Interface
OBJECT STORE > [m) fta el ;g;:r Floating IPs mi tiny - Active  nova None Running 37 minute ~ Detach Interface
P )
. 172160123 Edit Instance
Identity > Attach Volume
Displaying 2 items Detach Volume

Update Metagiata
Edit SecurifggGroups

Consoley
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Pada tab Console dari halaman instance234 yang tampil, lakukan klik kanan pada link
atau tautan Click here to show only console dan pada popup menu yang tampil, pilih

Open link in new tab, seperti terlihat pada gambar berikut:

r al
~ - [m] x
B instance234 - OpenStack Dashbe X instance123(cc854e81-696b-4a1: X ‘ ar
< C A Not secure | 192.168.56.56/horizon/project/instances/faf431d8-4709-4afc-812b-f593ca786219/?tab=instance details_con... |®# ¥r & = O @
u openstack = belajar-0827068001 + & 0827088001 ~
Project / Compute / Instances / instance234
COMPUTE v
i Create Snapshot |
oenen  INStANCE234 rate Snapsh
Instances
Overview Log Console Action Log
Volumes
mages INStance Console
Access & Security If console is not responding to keyboard input: click the grey status bar below]Click here to show only cops~~
To exit the fullscreen mode, click the browser's back button Open link in new tab
NETWORK > Open link in new window

Open link in incognito window
ORCHESTRATION ?
Save link as

OBJECT STORE > Copy link address

Terbuat tab baru pada browser yang menampilkan halaman noVNC console untuk
instance234. Terlihat pada console tersebut terdapat inputan login yang meminta
penggunakan untuk memasukkan akun otentikasi. Apabila pada halaman noVNC hanya
menampilkan layar hitam maka tempatkan kursor ke dalam layar hitam tersebut dan
lakukan klik kiri pada mouse sehingga akan menampilkan inputan login. Pada inputan
login tersebut masukkan cirros sebagai nama user dan tekan Enter maka akan tampil
inputan Password: yang meminta pengguna untuk memasukkan sandi login. Masukkan

gocubsgo sebagai sandi dan tekan Enter, seperti terlihat pada gambar berikut:

r 5]

v _

B instance234 - OpenStack Dashbe X instance123(cc854e81-696b-4a1 X I instance234(faf431d8-4709-4a XI +

c A Notsecure | 192.168.56.56:6080/vnc_auto.html?token=7fd5e4fd-3b19-4019-beba-62068009dfaadititle=instance234(faf431... 12 Y M = 0O @

Send CtrlAltDel

N

4.5014541
tem clock to 2023-03-29 01:58:23 UTC (

uhci_hcd
0 devices found

Freeing = 7 fEEFFEFFB1F42000 - £EFEFFEFE

Write protecting the kernel read-o dat 14336k
Freeing unused ke f 000182f000 — ffff8¢

Freeing unused kernel memory: 168K (ffff880001dd66000 - ffffB880001

written to sdevs/ttySe
random: dd urandom read with 21 bits of entropy available

login as 'cirros’ user. default : ! S . use 'sudo’ for root.
ins 234 login: [ 433.5175361 random: is initialized

‘cirros’ use default p ord: 'gocubsgo’. use 'sudo’ for root.
login: |cirros
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Apabila proses otentikasi login berhasil dilakukan maka akan tampil prompt $.

Memverifikasi pengalamatan IP yang digunakan oleh instance234 melalui console
dengan mengeksekusi perintah ip address. Selain itu memverifikasi alamat default
gateway dengan mengeksekusi ip route dan server DNS dengan mengeksekusi

perintah cat /etc/resolv.conf, sepertiterlihat pada gambar berikut:

r -]

- .
B instance234 - OpenStack Dashbc X \nstar1ce123[cc854es1769%745 X l instance234(faf431d8-4709-4af xl +

c A Not secure | 192.168.56.56:6080/vnc_auto.html?token=7fd5e4fd-3b19-4019-beba-62068009dfaadtitle=instance234(faf431... 12 ¥ N = O @

Send CtriAtDel

login as ’cirros’ use def t ! . use 'sudo’ for root.
234 login: cirros

st glen 1000

dev eth®
8.234.226

Hasil eksekusi perintah ip address menunjukkan informasi yaitu alamat IP dari
interface ethO instance234 yang diperoleh secara dinamis dari DHCP Server adalah
192.168.234.226. Sedangkan dari hasil eksekusi perintah ip route diperoleh informasi
yaitu default gateway yang digunakan instance234 adalah 192.168.234.1. Terakhir dari
hasil eksekusi perintah cat /etc/resolv.conf memperlihatkan alamat IP
Nameserver yang digunakan untuk mentranslasi nama domain ke alamat IP dan

sebaliknya yaitu 8.8.8.8.

Memverifikasi koneksi Internet dari Console instance234 ke salah satu situs di Internet,
sebagai contoh ke google.com dengan mengeksekusi perintah ping google.com,

seperti terlihat pada gambar berikut:

|
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v _

B instance234 - OpenStack Dashbe X m instance123(cc854e81-696b-4a1: X Im instance?234(faf431d8-4709-4af XI +

(&) A NcL%se(ure 192.168.56.56:6080/vnc_auto.html?token=7fd5e4fd-3b19-4019-beba-62068009dfaadtitle=instance234(fafd31.. & ¥ #* = O @

Send CirlAtDel

B gqdisc pfifo_fast gqlen 1000

ype global eth®
valid_1f
inetb fa
valid_Ift fo
S ip rout

g c ping
4 pac cansmitt
round-trip minsavg/max

Terlihat verifikasi koneksi dari instance234 ke google.com berhasil dilakukan. Tekan

CTRL+C untuk menghentikan ping.

Memverifikasi koneksi dari Console instance234 ke alamat IP dari instancel23 yang
terhubung ke internal network dengan mengeksekusi perintah ping

192.168.123.57, seperti terlihat pada gambar berikut:

B instance234 - OpenStack Dashbc X m instance123(cc854e81-696b-4a7 X I m instance234(faf431d8-4709-4a XI +

C' A Notsecure | 192.168.56.56:6080/vnc_auto.html|?token=7fd5e4fd-3b19-4019-beba-62068009dfaadtitle=instance234(faf431... 1&# Y N = 0O @

5 onnected e pted) to e 0000b Send CtrlAltDel
192.168 y 9 6

cat
h openst

~-- google.com
4 packets transmitt
round-trip min

Slping 192.168
P IRG 1bo. 14
om 1

from 1

from 1

t mi
round-trip minsav

Terlihat verifikasi koneksi dari instance234 ke instancel23 berhasil dilakukan. Tekan

CTRL+C untuk menghentikan ping.

Tutup tab pada browser yang digunakan untuk mengakses Console dari instancel23 dan

instance234, seperti terlihat pada gambar berikut:

|
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r
B instance234 - OpenStack Dashbe X instance123(cc854e81-696b-4a instance234(faf431d8-4709-4af E +
192.168.56.56:6080/vnc_auto.html?token=7fd5e4fd-3b19-4019-beba-62068009dfaadtitle=instance234(fafd31.. | ¥ #* = O @

ol ted : 1 0000000b

Send CirlAtDel

C' A Notsecure

$ ping google
PING google 216.239.

64 bytes from 2 . 0 e=47.
64 bytes from 216.2° . e time=44.¢
64 bytes from 216.2° . 2 tim

64 bytes from : time=36. ¢

C
statistic

, 4 packet packet

round- ms
S ping 1 .
9 . 56 data bytes

from 19
from 19
from 19

% packet

16. Menghentikan kedua instance yang aktif yaitu instancel23 dan instance234 dengan

mengakses panel menu sebelah kiri dari OpenStack Dashboard dan memilih sub menu

Instances dari menu Project > COMPUTE maka pada panel detail sebelah kanan akan

tampil halaman Instances. Lakukan penghentian instance234 dengan menekan

dropdown menu di sebelah kanan dari tombol Create Snapshot yang berada dibawah

kolom Actions dari instance tersebut dan memilih Shutt Off Instance, seperti terlihat pada

gambar berikut:

-
s = (m] X
B Instances - OpenStack Dashboar X ar
< C A Not secure | 192.168.56.56/horizon/project/instances/ 2 Y & = 0O @
n openstack = belajar-0827068001 « & 0827068001 «
Instance Name = = Filter & Launch Instance More Actions ~
COMPUTE v PR .
Inst: | K Availabilit P Ti
O nstance mage IP Address Size e.y Status varabiity Task ower 'me since Actions
Name Name Pair Zone State created
Overview
+ 192.168.234.226
== = >
Iml @] Ij_:ta =2 ;g;]sar Floating IPs: m1 tiny - Active  nova None Running 30 minutes Create Snapshot
Volumes + 17216.0.234 Disassociate Floating IP
« 192.168.123 57 Attach Interface
Images instancel  cirros-
o . belajar Floating IPs: miftiny - Active  nova None Running 46 minute  Detach Interface
23 "
Access & Security . 172.16.0.123 Edit Instance
Attach Volume
NETWORK > Displaying 2 items Detach Volume
Update Metadata
ORCHESTRATION > Edit Security Groups
OBJECT STORE > Consele
View Log
Identity > Pause Instance
Suspend Instance
Shelve Instance

Resize Instance
Lock Instance
Unlock Instance

Soft Reboot Instan

Hard Reboot Instal

Shut Off Instwe

Rebuild Instance

1
84

WWW.IPUTUHARIYADI.NET



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

Tampil kotak dialog konfirmasi terkait penghentian instances dengan nama tersebut,

seperti terlihat pada gambar berikut:

Confirm Shut Off Instance

You have selected: "instance234". Please confirm your selection. The instance(s) will be shut off.

Cancel Shut Off Instance

Tekan tombol Shut Off Instance untuk melanjutkan proses penghentian instance. Tampil
pesan notifikasi yang menginformasikan bahwa penghentian instance dengan nama
tersebut telah berhasil dilakukan. Pada kolom Task, terlihat progress bar yang
menunjukkan proses penghentian instance dan pesan Power Off untuk instance234,

seperti terlihat pada gambar berikut:

n openstack = sl & 0827068001 ~
Project / Compute / Instances

COMPUTE v

oewes INStances

Instances
Instance Name =~ Filter & Launch Instance 1@ Delete Instances. More Actions =
Volumes
Images o Instance  Image 1P Address size Ke.y Status Availability Task Power Time since Actions
Name Name Pair Zone State created
Access & Security . 102 168 234 295 -
instance2 cirros- Floati 1P .
NETWORK > m] 34 belajar oating IPs: mitiny - Active  nova Powering Running 33 minutes Create Snapshot | =
. 172.16.0.234 off
ORCHESTRATION >
s 192.168.123.57
OBJECT STORE > [m] \ZnSStanr.eﬂ tc)g:j:r Floating IPs m1.tiny - Active  nova None Running 49 minutes Create Snapshot | =
« 172.16.0123
Identity >
Displaying 2 items

Instance234 telah berhasil dihentikan yang ditandai pesan Status bernilai Shutoff dan

Power State bernilai Shut Down, seperti terlihat pada gambar berikut:

|
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& 0827068001 ~ |

3 openstack = belajar-os27088001 +

Project / Compute / Instances

COMPUTE v

oevenINStANCES

Instances
Filter & Launch Instance 1l Delete Instances. More Actions v

Instance Name =+

Volumes
Images o Instance Image |P Address size Ke_y Status Availability Task Power Time since Actions
Name Name Pair Zone State created
Access & Security . 102 168 234 296
instance?  cirros-
NETWORK > m] 2 belajar Floating IPs m1itiny - nova None 34 minutes Start Instance | =
¢ 172.16.0.234
ORCHESTRATION >
* 192.168.123.57
OBJECT STORE > [m] ;;tanceﬂ Eg:;r Floating IPs m1tiny - Active  nova None Running 49 minutes Create Snapshot |

172.16.0.123

Identity
Displaying 2 items

Dengan cara yang sama, lakukan penghentian instance123 melalui penekanan dropdown

menu di sebelah kanan tombol Create Snapshot pada kolom Actions dari instance

tersebut dan memilih Shutt Off Instance, seperti terlihat pada gambar berikut:

& 0827068001 +

u openstack = belajar-0827068001 ~
ains namne van cune i vicaisu
« 192.168.234.226
instance2  cirros- Shut
COMPUTE v u] Floating IPs mitiny - Shutoff  nova None 34 minutes Start Instance
34 belajar Down
. ¢ 172.16.0.234
QOverview
* 192.168.123.57
Instances ;;tanceﬂ Egg;r Floating IPs. m1.tiny Active  nova None Running 49 minutes Create Snapshot n
Volumes ° TRBE Disassociate Floating IP
i Attach Interface
Images Displaying 2 items
Detach Interface
Access & Security Edit Instance
Attach Volume
NETWORK > Detach Volume
Update Metadata
ORCHESTRATION > Edit Security Groups
OBJECT STORE > Console
View Log
> Pause Instance
Suspend Instance
Shelve Instance

Identity
Resize Instance

Lock Instance
Unlock Instance

Soft Reboot Instanfe

Hard Reboot Instd

Shut Off Instance
Rebuild Instance

Tampil kotak dialog konfirmasi terkait penghentian instances dengan nama tersebut,

seperti terlihat pada gambar berikut:
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Confirm Shut Off Instance

You have selected: "instance123". Please confirm your selection. The instance(s) will be shut off.

Cancel Shut Off Instance

Tekan tombol Shut Off Instance untuk melanjutkan proses penghentian instance. Tampil

pesan notifikasi yang menginformasikan bahwa penghentian instance dengan nama

tersebut telah berhasil dil

akukan.

Instance123 telah berhasil dihentikan yang ditandai pesan Status bernilai Shutoff dan

Power State bernilai Shut Down, seperti terlihat pada gambar berikut:

n openstack & betajar-0827068001 I & 0827068001 ~ |
Project /| Compute / Instances
COMPUTE v
aenew  INStANCES
Instances
Instance Name =~ Filter & Launch Instance @ Delete Instances More Actions ~
Volumes
Images a Instance Image |P Address size Key Status Availability Task Power Time since Actions
Name Name Pair Zone State created
Access & Security . 102 168 234 296
instance23  cirros- Shut
NETWORK > (m] 4 Bl Floating IPs m1.tiny - Shutoff nova None Down 37 minutes Start Instance | »
+ 172.16.0.234
ORCHESTRATION >
* 192.168.123.57
OBJECT STORE > o gwstance‘\? E‘ef::l:r Floating IPs mitiny - nova Nune 53 minutes Start Instance | ¥
* 172.16.0.123
Identity >

Displaying 2 items

Keluar dari penggunaan OpenStack Horizon Dashboard dengan mengakses dropdown

menu pada pojok kanan atas dan pilih Sign Out, seperti terlihat pada gambar berikut:

I8 openstack = belejar-0s27088001
Project /| Compute / Instances
COMPUTE v
e INStANCES
Instances
Volumes Instance Name =~
Images o |Instance Image o iress size K&V
Name Name Pair
Access & Security . 192 168 234226
instance23  cirros- B
NETWORK Py (@] 4 belajar Floating IPs: mitiny -
» 172.16.0.234
ORCHESTRATION >
+ 102.168.123.57
OBJECT STORE > o nstancet? clrros- Floating IPs* mitiny -
3 belajar
» 172.16.0.123
Identity >

Displaying 2 items

£ Settings
@ Help

Themes:

Ubuntu

Material

Filter & Launch Instance 1 Delete Instan

Availability Power  Time since ® Sign Out
Status Zone Task State created @
Shut
Shutoff  nova None ; 37 minutes Start Instance | +
Down
Shutoff  nova None g‘;:,t 53 minutes Start Instance |~

& 0827068001 v |
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F. MENGHAPUS SUMBER DAYA CLOUD COMPUTING MELALUI OPENSTACK HORIZON
DASHBOARD

Adapun langkah-langkah untuk menghapus sumber daya cloud computing melalui

OpenStack Horizon Dashboard adalah sebagai berikut:

1. Buka browser dan pada address bar masukkan alamat http://192.168.56.56/horizon, maka

akan tampil halaman OpenStack Dashboard. Pada halaman OpenStack Dashboard
tersebut, lakukan login dengan melengkapi inputan User Name menggunakan “NIM”,
sebagai contoh “0827068001” dan Password menggunakan “12345678” serta tekan

tombol Connect, seperti terlihat pada gambar berikut:

u Login - OpenStack Dashboard X +

o
%
»

= 0@ :

& C' A Notsecure | 192.168.56.56/horizon/auth/login/?next=/horizon/

openstack

Login

User Name

0827068001

Connect

2. Menghapus keseluruhan instance yang terdapat pada Project yang aktif saat ini dengan
memilih menu Project pada panel sebelah kiri dan memilih sub menu Compute -
Instances maka pada panel detail sebelah kanan akan tampil halaman Instances. Pilih
checkbox di sebelah kiri kolom Instance Name dan tekan tombol Delete Instances, seperti

terlihat pada gambar berikut:

|
WWW.IPUTUHARIYADI.NET 88


http://192.168.56.56/horizon

PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

3 openstack = belajar-os27088001 + & 0827068001 » |

Project
Project / Compute / Instances
v

e INStANCES

Instance Name =~ Filter & Launch Instance 1 Delete Instances More Actions v

Volumes
a B Key Availability Power Time since "
Images
g Name Name IP Address Size Pair Status Zone Task state created Actions
Access & Security . 192 168.234.226
4 IEEEPS  Ees Floating IPs: m1_tin Shutoff nova None i 43 minutes Start Instance =
NETWORK > 4 belajar W= U Down
¢ 172.16.0.234
ORCHESTRATION ?
* 192.168.123.57
OBJECT STORE ? I nstancet? clros- Floating IPs: mitiny - Shutoff nova None Shut 59 minutes Start Instance  +
3 belajar Down
* 172.16.0.123
Identity >

Displaying 2 items

Tampil kotak dialog konfirmasi terkait penghapusan instances dengan nama-nama

tersebut, seperti terlihat pada gambar berikut:

Confirm Delete Instances

You have selected: "instance234", "instance123". Please confirm your selection. Deleted instances are not recoverable.

Cancel Delete Instances

Tekan tombol Delete Instances untuk melanjutkan proses penghapusan instances. Tampil
pesan notifikasi yang menginformasikan bahwa penghapusan instances dengan nama-

nama tersebut telah berhasil dilakukan.

Keseluruhan instance telah berhasil dihapus, seperti terlihat pada gambar berikut:

n openstack = belajar-0827088001 + & 0827068001 +
Project / Compute / Instances
COMPUTE v

oewes INStances

Instances
Instance Name =+ Filter & Launch Instance 1l Delete Instances More Actions -
Volumes
Instance Image IP N Key Availability Power Time since .
Images 3 Stat Task Acti
= Name Name Address 128 Pair ats Zone s State created ctions

Access & Security No items to display.

NETWORK >

3. Menghapus image dengan nama “cirros-belajar” yang terdapat pada Project yang aktif

saat ini yaitu dengan memilih menu Project pada panel sebelah kiri dan memilih sub menu
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COMPUTE - Images maka pada panel detail sebelah kanan akan tampil halaman Images.
Pilih checkbox di sebelah kiri image dengan nama “cirros-belajar” dan tekan tombol Delete

Images, seperti terlihat pada gambar berikut:

3 openstack = belajar-os27068001 + & 0827068001 ~ |

Project

Images

Overview Q| Click here for filters x + Create Image 1@ Delete Images

Instances

Name = Type Status Visibility Protected ormat Size

> cirros Image Public No Qcowz2 12.65 MB Launch

cirros-belajar Image Active Private No Qcow2 12.13 MB Launch | =

Displaying 2 items

Tampil kotak dialog konfirmasi terkait penghapusan image dengan nama tersebut, seperti

terlihat pada gambar berikut:

Confirm Delete Image

You have selected "cirros-belajar”. Deleted image is not recoverable.

Cancel Delete Image

Tekan tombol Delete Image untuk melanjutkan proses penghapusan image. Tampil pesan
notifikasi yang menginformasikan bahwa penghapusan image dengan nama tersebut telah

berhasil dilakukan.

Image telah berhasil dihapus, seperti terlihat pada gambar berikut:

n openstack = belajar-0827068001 + & 0827068001 «
|
COMPUTE v g

Overview Q| Click here for filters x | + Create Image :}

Instances
a Name + Type Status Visibility Protected Disk Format Size

Volumes
O » cirros Image Active Public No Qcowz2 12.65 MB Launch

Images
Displaying 1 item

4. Menghapus security groups dengan nama “allow-ping” dan “allow-ssh” yang terdapat

pada Project yang aktif saat ini yaitu dengan memilih menu Project pada panel sebelah kiri
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dan memilih sub menu COMPUTE - Access & Security maka pada panel detail sebelah
kanan akan tampil halaman Access & Security. Pada tab Security Groups, pilih checkbox di
sebelah kiri dari security group dengan nama “allow-ping” dan “allow-ssh” serta tekan

tombol Delete Security Groups, seperti terlihat pada gambar berikut:

8 openstack = betajar.082783s001 - & 0827068001 +

Project

Project / Compute / Access & Security

v
oo ACCESS & Security

Instances

Security Groups Key Pairs Floating IPs AP Access
Volumes

Images + Create Security Group | [ RNl TS

Access & Security

NETWORK > allow-ping

O Name Description Actions

Manage Rules | +

ORCHESTRATION > =5 Manage Rules | =
OBJECT STORE >
0O  default Default security group Manage Rules
Identity >

Displaying 3 items

Tampil kotak dialog konfirmasi terkait penghapusan security group dengan nama-nama

tersebut, seperti terlihat pada gambar berikut:

Confirm Delete Security Groups

You have selected: "allow-ping”, "allow-ssh”. Please confirm your selection. This action cannot be undone.

Cancel Delete Security Groups

Tekan tombol Delete Security Groups untuk melanjutkan proses penghapusan security
group. Tampil pesan notifikasi yang menginformasikan bahwa penghapusan security

dengan nama-nama tersebut telah berhasil dilakukan.

Security groups telah berhasil dihapus, seperti terlihat pada gambar berikut:

WWW.IPUTUHARIYADI.NET 91



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

3 openstack = belajar-os27088001 + L & 0827068001 ~

Project / Compute / Access & Security

COMPUTE v

oenew  ACCESS & Security

Instances

Security Groups Key Pairs Floating IPs APl Access

Volumes
Images + Create Security Group
Access & Security O Name Description Actions
NETWORK > 0O default Default security group Manage Rules
ORCHESTRATION ?> Displaying 1 item

5. Menghapus floating IP dengan alamat “172.16.0.123” dan “172.16.0.234” yang terdapat
pada Project yang aktif saat ini yaitu dengan memilih menu Project pada panel sebelah kiri
dan memilih sub menu COMPUTE - Access & Security maka pada panel detail sebelah
kanan akan tampil halaman Access & Security. Selanjutnya pilih tab Floating IPs dan
centang checkbox di sebelah kiri dari kolom IP Address untuk menseleksi keseluruhan
alamat floating IP serta tekan tombol Release Floating IPs, seperti terlihat pada gambar

berikut:

L |
3 openstack = belajar-0a27088001 ~ & 0827068001 ~

Project
Project / Compute / Access & Security

oenew ACCESS & Security

Instances

Security Groups Key Pair: Floating IPs APl Access
Volumes
Images % Allocate IP To Project [EEXTEILEELRSLEILL NI
Access & Securit: Wapped Fixed IP Address Pool Status Actions
NETWORK > & 172160234 = - Down Associate |+
ORCHESTRATION ? & 172.16.0.123 - - Down Associate | =

OBJECT STORE > Displaying 2 items

Tampil kotak dialog konfirmasi terkait penghapusan Floating IPs dengan alamat terpilih,

seperti terlihat pada gambar berikut:

Confirm Release Floating IPs

You have selected: "172.16.0 234", "172.16.0 123" Please confirm your selection. Once a floating IP I1s released, there is

no guarantee the same IP can be allocated again.
Cancel Release Floating IPs
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Tekan tombol Release Floating IPs untuk melanjutkan proses penghapusan floating IP.
Tampil pesan notifikasi yang menginformasikan bahwa penghapusan floating IP dengan

alamat tersebut telah berhasil dilakukan.

Floating IPs telah berhasil dihapus, seperti terlihat pada gambar berikut:

3 openstack = velgjar-0827088001 ~ & 0827068001 +
Project / Compute / Access & Security
COMPUTE v

oemen ACCESS & Security

Instances

Security Groups Key Pairs Floating IPs APl Access
Volumes

Images % Allocate |P To Project

Access & Security IP Address Mapped Fixed IP Address Pool Status Actions

NETWORK bS No items to display.

6. Menghapus router dengan nama “router-belajar” yang terdapat pada Project aktif saat ini
yaitu dengan memilih menu Project pada panel sebelah kiri dan memilih sub menu
NETWORK - Network Topology maka pada panel detail sebelah kanan akan tampil

halaman Network Topology.

Sebelum router tersebut dapat dihapus maka diperlukan penghapusan setiap interface
dari router yang terhubung ke setiap subnet dari internal network yaitu subnetl-belajar
dan subnet2-belajar. Tempatkan kursor mouse diatas dari simbol router dengan nama
“router-belajar” maka akan tampil kotak dialog yang menampilkan informasi terkait
Interfaces dan didalamnya memuat 3 (tiga) tombol Delete Interface dan Delete Router.
Tekan tombol Delete Interface pertama atau yang paling atas yaitu dengan alamat IP

192.168.234.1, seperti terlihat pada gambar berikut:
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3 openstack = belajar-os27088001 + & 0827068001

Project

Project / Network / Network Topology
COMPUTE

. Network Topology

& Launch Instance + Create Network + Create Router
Networks

Topology Graph
Routers

#2Small | 83 Normal ‘
ORCHESTRATION >

OBJECT STORE >

Identity >

8‘_
17216 0 £3

outer-be

782f601¢-611 9-4fae-b0ed-41b121bf6542
Active

Interfaces

<+ Add Interface

19d44b73-83... 192.168.234.1 router_interface Active JRSSENTEHET

a63b1cf3-b9. 192.168.123.1 router_interface Active JBEIENNE T

e7278952-1fa... 172.16.0.3 router_gateway Active JBE NG i

» View Router Details Delete Router

fejag-yJomjau-1aplaoid

Interface tersebut berhasil dihapus.

Lakukan penekanan tombol Delete Interface kembali pada kotak dialog Interfaces saat ini

yaitu dengan alamat IP 192.168.123.1, seperti terlihat pada gambar berikut:

-

Router 782f6d1c-6M19-4fae-b0ed-4M12ibfG542

@ Active

Interfaces + Add Interface

4 Delete Interface ’

e7278952-1fa... 172.16.0.3 router_gateway Active @MEEENN )7 R

» View Router Details Delete Router

a63b1cf3-bs 192.168.123.1 router_interface Acti

g-}Jomgau-1apiaoid

Interface tersebut juga berhasil dihapus.

Selanjutnya lakukan penghapusan router-belajar dengan menekan tombol Delete Router

pada kotak dialog Interfaces, seperti terlihat pada gambar berikut:
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x

Router T8216d1c-6M 9-4fae-b0ed-41b121bf5542
@ Active

Interfaces <+ Add Interface
=
2
o e7278952-1fa... 172.16.0.3 router_gateway Active MR EINE i =E
o
5 - -
% » View Router Details Delete Router
2 H 3

Router tersebut telah berhasil dihapus. Pada halaman Network Topology hanya
memperlihatkan simbol terkait 3 (tiga) network yaitu provider-network-belajar dan
networkl-belajar serta network2-belajar yang berdiri sendiri atau terpisah, seperti

terlihat pada gambar berikut:

B3 openstack = belajar-0827088001 + & 0827068001 ~ (=
Project / Network / Network Topology
COMPUTE >

NETWORK . Network TOpOIOgy

Network Topology

& Launch Instance + Create Network + Create Router
Networks

Topology Graph
Routers

#:Small | 22 Normal
ORCHESTRATION >
OBJECT STORE >

Identity >

=
o
= =l =]
% © o
g g ES
= B =
o = =
g ) z
g = :
3 o o
& 2. =3
[ 2 2
2.

8

7. Menghapus keseluruhan network yang terdapat pada Project aktif saat ini dengan memilih
menu Project pada panel sebelah kiri dan memilih sub menu Network - Networks maka
pada panel detail sebelah kanan akan tampil halaman Networks. Pilih checkbox di sebelah

kiri kolom Name dan tekan tombol Delete Networks, seperti terlihat pada gambar berikut:
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3 openstack = belajar-os27088001 + b & 0827068001 ~

Project
Project / Network / Networks

COMPUTE

Networks

Name =+ Filter + Creak
Routers Subnets Associated Shared External Status Admin State  Actions
ORCHESTRATION > &  network2-belajar * subnet2-belajar 192.168.234.0/24 No No Active upP Edit Network | =
OBJECT STORE b4 &  provider-network-belajar  » provider-subnet-belajar 172.16.0.0/24 No Yes Active  UP Edit Network | =
Identity b4 &  networki-belajar + subneti-belajar 192.168.123.0/24 No No Active  UP Edit Network | =

Displaying 3 items

Tampil kotak dialog konfirmasi terkait penghapusan network dengan nama-nama tersebut,

seperti terlihat pada gambar berikut:

Confirm Delete Networks

You have selected: "network2-belajar”, "provider-network-belajar”, "network1-belajar”. Please confirm your selection. This
action cannot be undone.

Cancel Delete Networks

Tekan tombol Delete Networks untuk melanjutkan proses penghapusan network.

Terlihat pesan notifikasi yang menginformasikan bahwa penghapusan network dengan

nama-nama tersebut telah berhasil dilakukan.

3 openstack = belajar-os27088001 + & 0827068001 ~

Project / Network / Networks
COMPUTE >

NETWORK v Networks

Network Topology

Name =+ Filter + Create Network
Networks

Routers Name Subnets Associated Shared External Status Admin State Actions

No items to display.

ORCHESTRATION >
Terlihat keseluruhan network telah berhasil dihapus.
8. Keluar dari penggunaan OpenStack Horizon Dashboard dengan mengakses dropdown

menu pada pojok kanan atas dan pilih Sign Out, seperti terlihat pada gambar berikut:
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3 openstack = belajar-os27068001 +

@ setinos
Project / Network / Networks © Help

COMPUTE >

NETWORK v NetWO rkS Themes:

Ubuntu

Network Topology
Material

@ Sign Out

N =~ Filte
Networks ame el

Routers Name Subnets Associated Shared External Status Admin State

No items to display.

ORCHESTRATION >

9. Pada halaman OpenStack Dashboard, lakukan /ogin sebagai user “admin” dengan
melengkapi inputan User Name dan Password menggunakan “admin” dan tekan tombol

Connect, seperti terlihat pada gambar berikut:

openstack

Log in

User Name

admin 0

Password

Tampil halaman OpenStack Project Dashboard.

10. Menghapus user dengan nama “NIM” dengan mengakses panel sebelah kiri dan memilih
Identity serta memilih submenu Users maka pada panel detail sebelah kanan akan tampil
halaman Users. Lakukan pemfilteran terhadap user yang ditampilkan dengan
memasukkan kata kunci pemfilteran di inputan pemfilteran berdasarkan User Name.
Pada inputan tersebut masukkan nilai “NIM” dan tekan tombol Filter. Ganti NIM sesuai

dengan yang dimiliki, sebagai contoh 0827068001, seperti terlihat pada gambar berikut:

|
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B openstack = admin ~ & admin ~ |
L
Project ?>
Identity / Users
Admin >
Projects
Lisechl ==3p-1 0827068001 Filter + Create User 1l Delete Users
G O  User Name Description Email User ID Enabled Domain Name Actions |
roups
0O 0827068001 - 284614b1943427296421fd8bd9dad04 Yes Default Edit =

Roles

Displaying 1 item

Terlihat ditemukan user sesuai dengan kata kunci pemfilteran tersebut. Pilih checkbox di
sebelah kiri kolom User Name dan tekan tombol Delete Users, seperti terlihat pada

gambar berikut:

|
&3 openstack & aomin ~ & admin ~
Project >
Identity / Users
Admin >

Users

Projects

User Name =~ 0827068001 Filter + Create s 1 Delete Users
Users

acham = ption Email User ID Enabled Domain Name Actions
Groups
Roles & 0827068001 - 284614b1943427a9642 1f{d8bd9da404 Yes Default Edit | =
Displaying 1 item

Tampil kotak dialog konfirmasi terkait penghapusan user dengan nama tersebut, seperti

terlihat pada gambar berikut:

Confirm Delete Users

You have selected: "0827068001". Please confirm your selection. This action cannot be undone.

Cancel Delete Users

Tekan tombol Delete Users untuk melanjutkan proses penghapusan user. Tampil pesan
notifikasi yang menginformasikan bahwa penghapusan user dengan nama tesebut telah

berhasil dilakukan.

Terlihat hasil pemfilteran Users dengan nama “0827068001” kosong yang menandakan
bahwa user dengan nama tersebut tidak ditemukan karena telah dihapus, seperti terlihat

pada gambar berikut:
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B3 openstack = admin ~ 5 & admin +
Project >

Identity / Users
Admin >

Users

Projects

User Name =~ 0827068001 Filter + Create User
Users

5 User Name Description Email User ID Enabled Domain Name Actions
roups

No items to display.
Roles

11. Menghapus Project dengan nama “belajar-NIM” dengan mengakses panel sebelah kiri
dan memilih Identity serta memilih submenu Projects maka pada panel detail sebelah
kanan akan tampil halaman Projects. Lakukan pemfilteran terhadap project yang
ditampilkan dengan memasukkan kata kunci pemfilteran di inputan pemfilteran
berdasarkan Project Name. Pada inputan tersebut masukkan nilai “belajar-NIM” dan
tekan tombol Filter. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh memiliki NIM
dengan nilai 0827068001 maka nama project-nya adalah “belajar-0827068001", seperti
terlihat pada gambar berikut:

3 openstack = agin ~ & admin ~

Project >
Identity / Projects

Admin >

Projects
Projects|

f - .
Profect: belajar-0827068001 l——) Filter + Create Project :}
Users ! I ]

m} Name Description Project ID Domain Name Enabled Actions

Groups

Roles O  belajar-0827088001 89520120004b4305aec5a84dia0267db Default Yes Manage Members | =

Displaying 1 item
Terlihat ditemukan project sesuai dengan kata kunci pemfilteran tersebut.

Pilih checkbox di sebelah kiri kolom Name dan tekan tombol Delete Projects, seperti

terlihat pada gambar berikut:
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B openstack = admin ~ & admin +

Y

Project ?>
Identity / Projects

Admin >

Projects

Projects

Project Name =~ | belajar-0827068001 Filter |+ Creaic Drcjachy- i IVEEEIGGEEE
Users
l@!__" Description Project ID Domain Name Enabled  Actions
Groups
Roles &  belajar-0827068001 89520120004b4305aec5a84dfa0267db Default Yes Manage Members | =

Displaying 1 item

Tampil kotak dialog konfirmasi terkait penghapusan project dengan nama tersebut,

seperti terlihat pada gambar berikut:

Confirm Delete Projects

You have selected: "belajar-0827068001". Please confirm your selection. This action cannot be undone.

Cancel Delete Projects

Tekan tombol Delete Projects untuk melanjutkan proses penghapusan project. Tampil
pesan notifikasi yang menginformasikan bahwa penghapusan project dengan nama

tesebut telah berhasil dilakukan.

Terlihat hasil pemfilteran Projects dengan nama “belajar-0827068001” kosong yang
menandakan bahwa project dengan nama tersebut tidak ditemukan karena telah

dihapus, seperti terlihat pada gambar berikut:

n openstack admin ~ & admin ~
Project >

Identity / Projects
Admin >

Projects

Projects

Project Name = = belajar-0827068001 Filter + Create Project
Users

Name Description Project ID Domain Name Enabled Actions
Groups

No items to display.
Roles

12. Keluar dari penggunaan OpenStack Horizon Dashboard dengan mengakses dropdown

menu pada pojok kanan atas dan pilih Sign Out, seperti terlihat pada gambar berikut:
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B openstack = admin -

Project > ¥ Settings
Identity / Projects @ Help

Admin >

XIS PO
Ibuntu
Projects

Project Name =~ || belajar-0827068001 Fite ~ Matenal
Users

. Name Description Project ID Domain Name Enabled @
roups

No items to display.
Roles

G. MEMBUAT SUMBER DAYA VIRTUAL CLOUD COMPUTING MELALUI OPENSTACK CLI

Di dalam home directory dari user “openstack” yaitu /home/openstack telah terdapat
file openrc yang didalamnya memuat informasi terkait otentikasi. Informasi tersebut
diperlukan untuk berinteraksi dengan OpenStack melalui CLI. Adapun langkah-langkah

membuat sumber daya virtual cloud computing melalui OpenStack CLI adalah sebagai berikut:

1. Eksekusi perintah 1s untuk menampilkan informasi isi dari direktori dimana saat ini

berada.

Terlihat terdapat file dengan nama openrc.

2. Menampilkan isi dari file openrc dengan mengeksekusi perintah cat openrc.
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Terlihat dari output eksekusi perintah tersebut terdapat 4 (empat) bagian pada konten file

openrc yaitu:

a. Bagian variable yang mengatur lingkungan OpenStack meliputi:

OS AUTH URL=http://192.168.56.56:5000/v3, menyimpan
lokasi Uniform Resource Locator (URL) dari Keystone APl daemon vyaitu
http://192.168.56.56:5000/v3.

OS PROJECT DOMAIN NAME=default, menyimpan nama domain dari
project yang digunakan yaitu default. Domain merupakan wadah logical
tingkat tinggi yang digunakan untuk users, groups dan project di OpenStack.
Project berada di dalam domain dan merupakan istilah yang digunakan oleh
OpenStack untuk merepresentasikan area dimana sumber daya virtual dibuat.
OS USER DOMAIN NAME=default, menyimpan nama domain dari user
yang digunakan yaitu default.

OS USERNAME=admin, menyimpan username atau nama login pengguna
yang digunakan login ke Keystone yaitu admin.

OS_PASSWORD=admin, menyimpan sandi dari username “admin” yang
digunakan login ke Keystone yaitu admin.

OS PROJECT NAME=admin, menyimpan nama project yang digunakan

yaitu admin.

b. Bagian variable yang menyimpan nilai untuk mengatur cakupan tenant bernama

“admin” sebagai tenant aktif bagi clients OpenStack versi sebelumnya vyaitu

OS TENANT NAME=admin. Tenant merupakan istilah pada OpenStack versi

sebelumnya yang merepresentasikan area dimana sumber daya virtual dibuat. Tenant

sama dengan Project di OpenStack versi newton yang digunakan saat ini.

c. Bagian variable yang menyimpan nilai untuk mengatur agar python-openstackclient

menggunakan Keystone v3 API yaitu variable OS_ IDENTITY API VERSION=3.

d. Bagian variable yang menyimpan nilai untuk mengatur agar python-swiftclient

menggunakan Keystone v3 APl yaitu OS AUTH VERSION=3.

3. Mengeksekusi perintah untuk mengatur kredensial di sesi Bash saat ini agar menggunakan

project “admin” dengan mengeksekusi perintah source openrc.

|
WWW.IPUTUHARIYADI.NET 102



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

openstack@coa-aio-newton:~5|source openrc

4. Memverifikasi variable yang telah diatur dengan mengeksekusi perintah export | grep
0S yang menampilkan keseluruhan variable dan melakukan pipeline agar hasil eksekusi
dari perintah sebelumnya dijadikan inputan untuk operasi grep sehingga dapat memfilter

berdasarkan prefix OS.

5. Menggunakan python-openstackclient untuk memverifikasi keberhasilan otentikasi
terhadap Keystone dan telah memperoleh token dengan cakupan project admin melalui

eksekusi perintah openstack token issue.

6. Memastikan project_id pada output token tersebut memiliki nilai ID yang sama dengan

project admin melalui eksekusi perintah openstack project list.
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Terlihat nilai project_id pada token sama dengan ID dari project admin.

7. Membuat project dengan nama “belajar-NIM”. Ganti nilai NIM dengan yang dimiliki.
Sebagai contoh memiliki NIM 0827068001 maka nama project adalah “belajar-
0827068001". Perintah yang dieksekusi untuk membuat project dengan nama tersebut

adalah openstack project create belajar-0827068001.

8. Memverifikasi hasil pembuatan project dengan nama “belajar-NIM” dimana sesuai contoh
NIM yang digunakan adalah 0827068001 maka nama project-nya adalah “belajar-
0827068001".

|
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Terlihat project dengan nama tersebut telah berhasil dibuat.

9. Membuat user baru pada domain “default” dengan nama Jlogin "NIM" dengan sandi
"12345678" dan project yang dapat dikelola oleh user tersebut adalah "belajar-NIM".
Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh memiliki NIM dengan nilai
0827068001 maka perintah yang dieksekusi adalah openstack user create --
domain default --project belajar-0827068001 --password
12345678 0827068001.

10. Memverifikasi hasil pembuatan user dengan nama “NIM” dimana sesuai contoh NIM

yang digunakan adalah 0827068001 dengan mengeksekusi perintah openstack user

list.

|
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Terlihat user dengan nama tersebut telah berhasil dibuat.

« n

11. Mengatur agar user “NIM” memiliki role “_member_” untuk project “belajar-NIM”.
Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh memiliki NIM dengan nilai
0827068001 maka nama project-nya adalah “belajar-0827068001”. Perintah yang
dieksekusi adalah openstack role add --user 0827068001 --project

belajar-0827068001 member .

12. Memverifikasi hasil pengaturan role pada user “NIM” dimana sesuai contoh NIM yang
digunakan adalah 0827068001 dengan mengeksekusi perintah openstack role

assignment list --names —--project belajar-0827068001.
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13. Mengatur agar user “admin” memiliki role “admin” untuk project “belajar-NIM”. Ganti
NIM sesuai dengan yang dimiliki. Sebagai contoh memiliki NIM dengan nilai 0827068001
maka nama project-nya adalah “belajar-0827068001”. Perintah yang dieksekusi adalah
openstack role add --user admin --project belajar-0827068001

admin.

coa—aio-newton:~$ openstack role add ——user admin --project belajar-08

14. Memverifikasi hasil pengaturan role pada user “admin” dengan mengeksekusi perintah

openstack role assignment 1list --names --project belajar-

0827068001.

admin@Default

1@Defau

15. Membuat provider network untuk project "belajar-NIM" agar dapat mengkoneksikan ke
Internet atau external dengan nama "provider-network-belajar" dan subnet "provider-
subnet-belajar" dengan alamat "172.16.0.0/24" serta alokasi pengalamatan ke instance
secara manual atau statik. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh
memiliki NIM dengan nilai 0827068001 maka nama project-nya adalah “belajar-
0827068001". Pada VM OpenStack yang digunakan telah diatur provider network type
berjenis flat untuk merepresentasikan trafik network provider tanpa enkapsulasi atau
penandaaan (tagging). Selain itu juga telah diatur label untuk provider physical network
dengan nama “public-dashboard” yang didefinisikan pada file

/etc/neutron/plugins/ml2/linuxbridge_agent.ini. Perintah yang dieksekusi adalah
openstack network create --provider-physical-network public-
dashboard --provider-network-type flat --project belajar-

0827068001 provider-network-belajar --external.

|
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16. Memverifikasi hasil pembuatan provider network dengan mengeksekusi perintah

openstack network list.

Terlihat provider-network-belajar telah berhasil dibuat. Sedangkan untuk menampilkan
informasi field-field lainnya dari provider network maka dapat mengeksekusi perintah

openstack network list --long.
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Sebaliknya untuk menampilkan detail informasi dari provider network tertentu sebagai

contoh provider-network-belajar maka dapat mengeksekusi perintah openstack

network show provider-network-belajar.

17. Membuat subnet untuk provider-network-belajar dengan nama provider-subnet-belajar
yang memiliki network address 172.16.0.0/24 dan gateway 172.16.0.1 serta dialokasikan
secara statik pengalamatannya. Selain itu juga mengatur agar subnet yang dibuat dimiliki
oleh project belajar-NIM. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh memiliki
NIM dengan nilai 0827068001 maka nama project-nya adalah “belajar-0827068001".
Perintah yang dieksekusi adalah openstack subnet create --network
provider-network-belajar --project belajar-0827068001 --
subnet-range 172.16.0.0/24 --gateway 172.16.0.1 --no-dhcp

provider-subnet-belajar.

|
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18. Memverifikasi hasil pembuatan provider subnet dengan mengeksekusi perintah

openstack subnet list.

Terlihat provider-subnet-belajar telah berhasil dibuat. Sedangkan untuk menampilkan
informasi field-field lainnya dari provider subnet maka dapat mengeksekusi perintah

openstack subnet list --long.

|
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19.

20.

21.

Mengubah nilai dari OpenStack environment variable pada sesi Bash saat ini yaitu
OS_PROJECT_NAME dan OS_TENANT_NAME agar menggunakan project dengan nama
“belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh memiliki NIM
dengan nilai 0827068001 maka nama project-nya adalah “belajar-0827068001". Perintah

yang digunakan untuk mengubah kedua nilai dari variable tersebut adalah:
export OS PROJECT NAME=belajar-0827068001

export OS TENANT NAME=belajar-0827068001

Sehingga hasil eksekusi perintah tersebut akan terlihat seperti pada gambar berikut:

Memverifikasi hasil pengubahan variable tersebut dengan mengeksekusi perintah
export | grep OSyang menampilkan keseluruhan variable dan melakukan pipeline
agar hasil eksekusi dari perintah sebelumnya dijadikan inputan untuk operasi grep

sehingga dapat memfilter berdasarkan prefix OS.

Terlihat nilai dari kedua variable tersebut telah berhasil diubah.

Mengalokasikan floating IP dengan alamat 172.16.0.123 dan 172.16.0.234 ke project
dengan nama “belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki. Sebagai contoh
memiliki NIM dengan nilai 0827068001 maka nama project-nya adalah “belajar-
0827068001". Perintah yang dieksekusi untuk mengalokasikan floating IP 172.16.0.123
ke project “belajar-0827068001” adalah openstack floating ip create --

floating-ip-address 172.16.0.123 provider-network-belajar.
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Sedangkan perintah yang dieksekusi untuk mengalokasikan floating IP 172.16.0.234 ke
project yang sama adalah openstack floating ip create --floating-ip-

address 172.16.0.234 provider-network-belajar.

22. Memverifikasi hasil pengalokasian floating IP dengan mengeksekusi perintah

openstack floating ip list.

|
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23.

Melakukan login ke OpenStack melalui CLI menggunakan akun otentiasi berupa user
dengan nama login “NIM” yang telah dibuat sebelumnya dan password “12345678" serta
project “belajar-NIM”. Untuk menyediakan informasi otentikasi dengan akun tersebut ke
OpenStack CLI maka digunakan variable Bash yang disimpan pada file dengan nama
openrc-project-NIM. Untuk mempercepat pembuatan file tersebut maka akan dilakukan
penyalinan dari file openrc yang telah ada. Ganti NIM sesuai dengan yang dimiliki. Sebagai
contoh memiliki NIM dengan nilai 0827068001 maka nama project-nya adalah “belajar-
0827068001

Perintah yang digunakan untuk menyalin file openrc dengan nama openrc-belajar-

0827068001 adalah cp openrc openrc-belajar-0827068001.

25.

Terlihat telah terdapat file dengan nama openrc-belajar-0827068001.

Mengubah nilai dari empat variable yang terdapat di dalam file openrc-belajar-
0827068001 menggunakan editor nano vyaitu OS_USERNAME, OS_PASSWORD,
OS_PROJECT_NAME dan OS_TENANT_NAME dengan mengeksekusi perintah nano

openrc-belajar-0827068001.

Pada editor nano, lakukan penyesuaian pada nilai dari empat variable berikut:
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a. OS_USERNAME=0827068001 merupakan nama user yang digunakan untuk /ogin ke
OpenStack yaitu 0827068001.

b. OS_PASSWORD=12345678 merupakan sandi dari nama login user 0827068001
yaitu 12345678.

c. OS_PROJECT_NAME=belajar-0827068001 merupakan nama project yang akan
diakses atau digunakan yaitu belajar-0827068001.

d. OS_TENANT_NAME=belajar-0827068001 merupakan nama project yang akan
diakses atau digunakan yaitu belajar-0827068001. Variable ini digunakan oleh

OpenStack service based client versi sebelumnya

Sehingga hasil penyesuaiannya akan terlihat seperti pada gambar berikut:

GNU nano 2.5.3 File: openrc-belajar-0827068001 Modified

Tekan tombol CTRL+0 untuk menyimpan perubahan pada file tersebut. Sedangkan untuk

keluar dari editor nano maka tekan tombol CTRL+X.

26. Memverifikasi hasil penyesuaian dengan mengeksekusi perintah cat openrc-

belajar-0827068001.
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27. Mengeksekusi perintah untuk mengatur kredensial di sesi Bash saat ini dengan

mengeksekusi perintah source openrc-belajar-0827068001.

openstac alo-newton:~5 source openrc-bel:

28. Memverifikasi variable yang telah diatur dengan mengeksekusi perintah export |
grep OS yang menampilkan keseluruhan variable dan melakukan pipeline agar hasil
eksekusi dari perintah sebelumnya dijadikan inputan untuk operasi grep sehingga dapat

memfilter berdasarkan prefix OS.

L
L
L
L
L
L
L

29. Menggunakan python-openstackclient untuk memverifikasi keberhasilan otentikasi
terhadap Keystone dan telah memperoleh token dengan cakupan project belajar-

0827068001 melalui eksekusi perintah openstack token issue.
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30. Memverifikasi apakah provider network dengan nama provider-network-belajar dapat
digunakan pada project yang digunakan saat ini dengan mengeksekusi perintah

openstack network list.

Terlihat provider-network-belajar sebagai output dari eksekusi perintah tersebut

sehingga provider network tersebut dapat digunakan pada project yang aktif saat ini.
Sedangkan untuk menampilkan detail informasi dari provider network tertentu sebagai
contoh provider-network-belajar maka dapat mengeksekusi perintah openstack

network show provider-network-belajar.
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31. Menampilkan informasi subnet yang telah terdapat di dalam project yang aktif saat ini

dengan mengeksekusi perintah openstack subnet list.

32. Membuat Glance image menggunakan image Cirros. Sebelum membuat Glance image

pada OpenStack maka pastikan terlebih dahulu telah memiliki image Cirros yang disimpan
di home directory dari user openstack yaitu di fhome/openstack. Apabila belum memiliki
maka image Cirros tersebut dapat diperoleh melalui Internet pada alamat

https://download.cirros-cloud.net. Sebagai contoh untuk mengunduh image Cirros versi

0.4.0 untuk arsitektur x86_64 melalui CLI dari OpenStack maka dapat menggunakan
utilitas wget dengan mengeksekusi perintah wget https://download.cirros-
cloud.net/0.4.0/cirros-0.4.0-x86 64-disk.img --no-check-
certificate.

|
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Tunggu hingga proses unduh selesai dilakukan. Jika telah selesai maka dapat diverifikasi

menggunakan perintah 1s.

openrc openrc-bel:

Selanjutnya dilakukan pembuatan image baru dengan nama cirros-belajar dan deskripsi
“Image Cirros untuk pembelajaran” serta menggunakan file image Cirros yang telah
diunduh sebelumnya yaitu cirros-0.4.0-x86_64-disk.img dengan format QCOW?2. Selain
itu image baru yang dibuat diatur agar mengijinkan ukuran minimum primary disk
sebesar 1GB dan minimum RAM sebesar 512MB ketika melakukan boot instance dengan
image cirros tersebut. Perintah yang dieksekusi untuk pembuatan image dengan
ketentuan tersebut adalah openstack image create --file cirros-
0.4.0-x86 64-disk.img --disk-format gcow2 --min-disk 1 --
min-ram 512 --property description="Image Cirros untuk

pembelajaran" cirros-belajar.
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33. Memverifikasi hasil pembuatan image dengan mengeksekusi perintah openstack

image list.

Terlihat telah terdapat image dengan nama cirros-belajar. Sedangkan untuk
menampilkan informasi detail terkait image cirros-belajar maka dapat mengeksekusi

perintah openstack image show cirros-belajar.

34, Membuat dua internal network yaitu masing-masing dengan nama “network1-belajar”

dan “network2-belajar”. Perintah yang dieksekusi untuk membuat network1-belajar

adalah openstack network create networkl-belajar.
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Sedangkan perintah yang dieksekusi untuk membuat network2-belajar adalah

openstack network create network2-belajar.
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35.

Memverifikasi hasil pembuatan kedua network dengan mengeksekusi perintah

openstack network list.

36.

Terlihat kedua network tersebut telah berhasil dibuat.

Membuat subnet untuk setiap internal network yang telah dibuat pada langkah
sebelumnya. Internal network "network1-uas" memiliki subnet dengan nama "subnet1-
belajar" dan alamat subnet 192.168.123.0/24 serta mengalokasikan alamat ke
instance secara DHCP mulai dari 192.168.123.50 sampai dengan 192.168.123.75. Selain
itu mengatur agar server DNS menggunakan alamat IP 8.8.8.8. Perintah yang dieksekusi

untuk membuat subnet dengan ketentuan tersebut adalah:

openstack subnet create --network networkl-belajar --
subnet-range=192.168.123.0/24 subnetl-belajar --allocation-
pool start=192.168.123.50,end=192.168.123.75 —--dns-

nameserver 8.8.8.8
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Sedangkan internal network "network2-uas" memiliki subnet dengan nama "subnet2-

uas" dan alamat subnet 192.168.234.0/24 serta mengalokasikan alamat ke
instance  secara DHCP  mulai dari  192.168.234.225 sampai  dengan
192.168.234.250. Selain itu mengatur agar server DNS menggunakan alamat IP 8.8.8.8.

Perintah yang dieksekusi untuk membuat subnet dengan ketentuan tersebut adalah:

openstack subnet create --network network2-belajar --
subnet-range=192.168.234.0/24 subnet2-belajar --allocation-
pool start=192.168.234.225,end=192.168.234.250 --dns-

nameserver 8.8.8.8
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37. Memverifikasi hasil pembuatan dua subnet tersebut dengan mengeksekusi perintah

openstack subnet list.

subnet 1

Terlihat keseluruhan subnet telah berhasil dibuat. Sedangkan untuk menampilkan

informasi field-field lainnya dari subnet maka dapat mengeksekusi perintah openstack

subnet list --long.

|
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38. Membuat router dengan nama "router-belajar" untuk menghubungkan ke external
network dan ke dua internal network yang telah dibuat sebelumnya dengan

mengeksekusi perintah openstack router create router-belajar.

39. Memverifikasi router yang telah dibuat dengan mengeksekusi perintah openstack

router list.

40. Menghubungkan ke dua internal network ke router-belajar yang telah dibuat dengan

menggunakan nama dari setiap subnet pada internal network tersebut yaitu subnetl-

belajar untuk networkl-belajar dan subnet2-belajar untuk network2-belajar. Perintah

|
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yang dieksekusi untuk menghubungkan subnetl-belajar ke router-belajar adalah

openstack router add subnet router-belajar subnetl-belajar.

openstack@coa-aio-newton:~$ openstack router add subnet router-belajar subnetl-b

Sedangkan perintah yang dieksekusi untuk menghubungkan subnet2-belajar ke router-
belajar adalah openstack router add subnet router-belajar subnet2-

belajar.

add subnet router-belajar subnet2-b

41. Memverifikasi hasil menghubungkan ke dua subnet dari internal network ke router dapat
dilakukan dengan mengeksekusi perintah openstack port 1list --router

router-belajar.

Terlihat router telah terhubung ke dua subnet dari internal network. Sebaliknya untuk
menghubungkan router ke external network dengan nama “provider-network-belajar”
dilakukan dengan menggunakan service-based client, python-neutronclient. Hal ini
karena python-openstackclient yang digunakan pada VM OpenStack adalah 2.7.12 dan
tidak mendukung pengaturan gateway pada router. Perintah yang dieksekusi untuk
mengatur gateway pada router dengan python-neutronclient adalah neutron

router-gateway-set router-belajar provider-network-belajar.
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42. Memverifikasi hasil menghubungkan external network ke router dapat dilakukan dengan

mengeksekusi perintah openstack port list --router router-belajar.

Terlihat router telah terhubung ke external network.

43. Membuat 2 (dua) security group yaitu dengan nama "allow-ping" yang memiliki rule
untuk mengijinkan akses ICMP ke instance dan "allow-ssh" yang memiliki rule untuk
mengijinkan akses SSH ke instance dengan alamat IP sumber darimana pun. Perintah yang
dieksekusi untuk membuat security group dengan nama “allow-ping” adalah

openstack security group create allow-ping.
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Sedangkan perintah yang dieksekusi untuk membuat security group dengan nama

“allow-ssh” adalah openstack security group create allow-ssh.

44. Memverifikasi hasil pembuatan kedua security group tersebut dengan mengeksekusi

perintah openstack security group list.

|
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45. Membuat rule pada security group allow-ping untuk mengijinkan akses ICMP ke instance
dengan alamat IP sumber darimana pun melalui eksekusi perintah openstack
security group rule create --protocol icmp --ingress --src-

ip 0.0.0.0/0 allow-ping.

46. Memverifikasi hasil pembuatan rule pada security group allow-ping dengan
mengeksekusi perintah openstack security group rule list allow-ping

--lonag.

Sedangkan untuk membuat rule pada security group allow-ssh untuk mengijinkan akses

SSH ke instance dengan alamat IP sumber darimana pun melalui eksekusi perintah
'
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openstack security group rule create --protocol tcp --ingress

--dst-port 22 --src-ip 0.0.0.0/0 allow-ssh.

47. Memverifikasi hasil pembuatan rule pada security group allow-ssh dengan mengeksekusi

perintah openstack security group rule list allow-ssh --long.

48. Membuat 2 (dua) instance masing-masing dengan nama instancel23 pada networkl-
belajar dan instance234 pada network2-belajar. Kedua instance tersebut wajib
menggunakan image cirros-belajar, flavor ml.tiny dan security group allow-icmp serta
allow-ssh. Perintah pembuatan instance tersebut memerlukan informasi network ID dari
network1-belajar dan network2-belajar yang dapat diperoleh dengan mengeksekusi

perintah openstack network list.
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Terlihat network ID dari networkl-belajar adalah 2a80246f-280f-4645-a773-
6chaB8alafld5. Sedangkan network ID dari networkl-belajar adalah 93004274-
75ba-42ef-9242-29c5793039d8. Sesuaikan nilai ID tersebut dengan yang dimiliki.
Perintah yang dieksekusi untuk membuat instancel23 dengan ketentuan tersebut

adalah:

openstack server create --image cirros-belajar --flavor
ml.tiny --security-group allow-ping --security-group allow-
ssh --nic net-1d=2a80246f-280f-4645-a773-6cbaB8alafld5

instancel?23

{u'name":

Sedangkan untuk membuat instance234, perintah yang dieksekusi adalah:

|
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openstack server create --image cirros-belajar --flavor
ml.tiny --security-group allow-ping --security-group allow-
ssh --nic net-id=93004274-75ba-42ef-9242-29c5793039d8

instance?234

F
-
.
.
-

49. Memverifikasi kedua instance yang telah dibuat dengan mengeksekusi perintah

openstack server list

.
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Selain itu mengatur asosiasi floating IP 172.16.0.123 untuk instancel23 dengan
mengeksekusi perintah openstack server add floating ip instancel23
172.16.0.123. Sedangkan perintah yang dieksekusi untuk mengatur asosiasi floating
IP 172.16.0.234 untuk instance234 adalah openstack server add floating

ip instance234 172.16.0.234.

g ip instance

ip instanc

50. Memverifikasi hasil asosiasi floating IP ke dua instance dengan mengeksekusi perintah

openstack server list.

Terlihat instancel23 telah menggunakan floating IP 172.16.0.123 dan instance234

menggunakan floating IP 172.16.0.234.

51. Menampilkan informasi console log dari instance123 untuk melihat log dari proses boot
instance dengan mengeksekusi perintah openstack console log show
instancel23. Cuplikan hasil eksekusi dari perintah tersebut, seperti terlihat pada

gambar berikut:

WWW.IPUTUHARIYADI.NET 132



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

Sedangkan untuk menampilkan informasi console log dari instance234 sehingga
memperlihatkan log dari proses boot instance dapat dilakukan dengan mengeksekusi
perintah openstack console log show instance234. Cuplikan hasil eksekusi

dari perintah tersebut, seperti terlihat pada gambar berikut:

52. Mengambil informasi console URL dari instancel23 dengan mengeksekusi perintah

openstack console url show instancel23.
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Salin bagian value dari field url dan tempelkan pada browser untuk melakukan akses
console ke instancel23 maka akan tampil halaman noVNC yang menampilkan inputan
login. Apabila pada halaman noVNC hanya menampilkan layar hitam maka tempatkan
kursor ke dalam layar hitam tersebut dan lakukan klik kiri pada mouse sehingga akan
menampilkan inputan login. Pada inputan login tersebut masukkan cirros sebagai nama
user dan tekan Enter maka akan tampil inputan Password: yang meminta pengguna
untuk memasukkan sandi login. Masukkan gocubsgo sebagai sandi dan tekan Enter,

seperti terlihat pada gambar berikut:

noVNC X o+
< C A Not secure | 192.168.56.56:6080/vnc_auto.html?token=149b0b94-447e-4afa-9779-f0fec4c611d0 = Y *» 0O @

Send CtrlAltDel

1t written to ~d >
51 random: dd urandom read with 26 bits of entropy available

login as 'cirros’ user. default pas *d: ’gocubsgo’. use ’‘sudo’ for root.
instancelZd login: [ 345.1598611] r : nonblocking pool is initialized

login as ‘cirros’ user. default password: ’gocubsgo’. use ’sudo’ for root.
i } login: [Cirros

erred_1ft forever

red_1ft forever
, LOWE O gqdisc pfifo_fast glen 1000
o
ope global eth®

Pada prompt $ dari instance, eksekusi perintah ip address untuk menampilkan
informasi alamat IP dari interface eth0. Terlihat alamat IP yang diperoleh secara dinamis

pada instancel23 adalah 192.168.123.57.

Lakukan verifikasi informasi default gateway yang diperoleh instancel23 dengan
mengeksekusi perintah ip route dan verifikasi alamat IP Nameserver dengan
mengeksekusi perintah cat /etc/resolv.conf, seperti terlihat pada gambar

berikut:

|
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L al

R rounc x 4+
&

53.

c A Not secure | 192.168.56.56:6080/vnc_auto.html?token=149b0b94-447e-4afa-9779-f0fecdc611d0 [~ 4 » 0O @

ed_Ift forever

v etho

PING goog
64 byte

“C

—-- google.com ping statis

Z packets tra , cke rece i 7. packet loss
round-trip min‘av 7 4

Terlihat hasil verifikasi ip route memperlihatkan alamat IP default gateway untuk
instancel23 adalah 192.168.123.1. Sedangkan IP Nameserver adalah 8.8.8.8. Selain itu
lakukan verifikasi koneksi Internet dari instancel23 dengan mengeksekusi perintah ping
ke salah satu situs di Internet, sebagai contoh ping google.com. Terlihat pula
verifikasi koneksi ke Internet berhasil dilakukan. Tekan CTRL+C untuk menghentikan

verifikasi koneksi menggunakan perintah ping tersebut.

Kembali ke OpenStack CLI yang diakses melalui Putty SSH Client dan lakukan
pengambilan informasi console URL dari instance234 dengan mengeksekusi perintah

openstack console url show instance234.

Salin bagian value dari field url dan tempelkan pada browser untuk melakukan akses

console ke instance234 maka akan tampil halaman noVNC yang menampilkan inputan
login. Apabila pada halaman noVNC hanya menampilkan layar hitam maka tempatkan
kursor ke dalam layar hitam tersebut dan lakukan klik kiri pada mouse sehingga akan
menampilkan inputan login. Pada inputan login tersebut masukkan cirros sebagai nama

user dan tekan Enter maka akan tampil inputan Password: yang meminta pengguna
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untuk memasukkan sandi login. Masukkan gocubsgo sebagai sandi dan tekan Enter,

seperti terlihat pada gambar berikut:

B novNC x[s [l novnC X +

< (¢ A Not secure | 192.168.56.56:6080/vnc_auto.htm|?token=89800dee-e7b4-4853-ach7-d33b

Send CtrlAltDel

t written to sdev
] random: dd urandom read with 22 bits of entropy available

login as ’cirros’ user. default password: ’gocubsgo’. use ’sudo’ for root.
instanceZ234 login: [ 384 .6597791 random: nonblocking pool i initialized
login as ’cirros’ user. default password: ’gocubsgo’. use ’sudo’ for root

instance234 login:[cirros
1 -

scope host lo
preferred_1ft forever

rred_I1ft forever
LOWER_UP> mtu 1450 gdisc pfifo_fast glen 1000
ff:ff:ff:ff
’S5 scope global eth®

inetb feB80::f816: 8 2764 s link
valid_Ift forever preferred_Ift forever

Pada prompt $ dari instance, eksekusi perintah ip address untuk menampilkan
informasi alamat IP dari interface ethO. Terlihat alamat IP yang diperoleh secara dinamis

pada instance234 adalah 192.168.234.229.

Lakukan verifikasi informasi default gateway yang diperoleh instance234 dengan
mengeksekusi perintah ip route dan verifikasi alamat IP Nameserver dengan
mengeksekusi perintah cat /etc/resolv.conf, seperti terlihat pada gambar

berikut:

B novne % Hl novne x  +

< C' A Notsecure | 192.168.56.56:6080/vnc_auto.htmI?token=89800dee-e7b4-4853-ach7-d33b3fbddf80 e % ®» 0O @

% o ted (U nted) to: U (instance-00000009 Send CtriAltDel

1 1000

WWW.IPUTUHARIYADI.NET 136



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

Terlihat hasil verifikasi ip route memperlihatkan alamat IP default gateway untuk
instance234 adalah 192.168.234.1. Sedangkan IP Nameserver adalah 8.8.8.8. Selain itu
lakukan verifikasi koneksi Internet dari instance234 dengan mengeksekusi perintah ping
ke salah satu situs di Internet, sebagai contoh ping google.com. Terlihat pula
verifikasi koneksi ke Internet berhasil dilakukan. Tekan CTRL+C untuk menghentikan

verifikasi koneksi menggunakan perintah ping tersebut.

54. Memverifikasi koneksi dari instancel23 ke instance234 dengan mengeksekusi perintah

ping 192.168.123.57.

B novne x [ novnc X -+
<« C' A Notsecure | 192.168.56.56:6080/vnc_auto.html?token=89800dee-e7b4-4853-ach7-d33b3fbddfs0 = Y *» 0O @

\nce-00000009 Send CtrlAltDel

68.2 .1 dev etho
src 192.168.234.229

J8): 56 data bytes
seq=0 tt1=100 time=51.025 ms
=1 tt1=100 time=116.872 ms

64 bytes from 1

64 bytes from 1
~c

--- 192.168.

ved, 02 packet loss
.359 ms

Terlihat hasil verifikasi koneksi dari instancel23 ke instance234 berhasil dilakukan.
Kembali ke kotak dialog aplikasi Putty yang digunakan untuk mengakses terminal dari

OpenStack.

55. Memuverifikasi koneksi dari OpenStack CLI sebagai external network ke instancel23
menggunakan referensi alamat floating IP 172.16.0.123 dengan mengeksekusi perintah
ping 172.16.0.123 dan ke instance234 menggunakan referensi alamat floating IP
172.16.0.234 dengan mengeksekusi perintah ping 172.16.0.234.

|
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56.

time 1000ms

Terlihat koneksi ke dua instance tersebut berhasil dilakukan.

Memverifikasi koneksi SSH dari OpenStack CLI sebagai external network ke instance123
menggunakan referensi alamat floating IP 172.16.0.123 dan login menggunakan user

cirros dengan mengeksekusi perintah ssh cirros@172.16.0.123. Tampil pesan

Are you sure you want to continues connecting (yes/no)?, ketik yes dan tekan Enter

maka akan terlihat prompt $ sebagai penanda akses SSH ke instance berhasil dilakukan.

57.

Ketik ex it untuk keluar dari akses SSH pada instance tersebut.

Dengan cara yang sama lakukan verifikasi koneksi SSH dari OpenStack CLI sebagai
external network ke instance234 menggunakan referensi alamat floating IP 172.16.0.234
dan login menggunakan user cirros dengan mengeksekusi perintah ssh

cirros@172.16.0.234. Tampil pesan Are you sure you want to continues

connecting (yes/no)?, ketik yes dan tekan Enter maka akan terlihat prompt $ sebagai

penanda akses SSH ke instance berhasil dilakukan.

|
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Ketik ex it untuk keluar dari akses SSH pada instance tersebut.

58. Menghentikan instancel23 dengan mengeksekusi perintah openstack server
stop instancel23 dan instance234 dengan mengeksekusi perintah openstack

server stop instance234.

59. Memverifikasi kedua instance tersebut telah dihentikan dengan mengeksekusi perintah

openstack server list.

Terlihat status dari instancel23 dan instance234 bernilai SHUTOFF yang menandakan

bahwa kedua instance tersebut telah berhasil dihentikan.

H. MENGHAPUS SUMBER DAYA VIRTUAL CLOUD COMPUTING MELALUI OPENSTACK CLI

Adapun langkah-langkah untuk menghapus sumber daya virtual cloud computing

melalui OpenStack CLI adalah sebagai berikut:

1. Mengakses terminal dari VM OpenStack dan mengatur kredensial di sesi Bash saat ini agar
menggunakan cakupan project “belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki.
Sebagai contoh memiliki NIM dengan nilai 0827068001 maka nama project-nya adalah
“belajar-0827068001”. Perintah yang dieksekusi untuk mengubah cakupan ke project

dengan nama tersebut adalah source openrc-belajar-0827068001.
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2. Memverifikasi variable yang telah diatur dengan mengeksekusi perintah export | grep
0S yang menampilkan keseluruhan variable dan melakukan pipeline agar hasil eksekusi
dari perintah sebelumnya dijadikan inputan untuk operasi grep sehingga dapat memfilter

berdasarkan prefix OS.

3. Menggunakan python-openstackclient untuk memverifikasi keberhasilan otentikasi
terhadap Keystone dan telah memperoleh token dengan cakupan project belajar-

0827068001 melalui eksekusi perintah openstack token issue.

4. Menampilkan informasi instance pada project yang aktif saat ini sebagai referensi untuk

proses penghapusan dengan mengeksekusi perintah openstack server list.
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Terlihat terdapat dua instance yaitu masing-masing dengan nama instancel23 dan

instance234.

5. Menghapus dua instance yaitu dengan nama instancel23 melalui mengeksekusi perintah

openstack server delete instancel23 dan instance234 melalui

mengeksekusi perintah openstack server delete instance234.

6. Memverifikasi apakah kedua instance dengan nama tersebut telah berhasil dihapus

dengan mengeksekusi perintah openstack server list.

openstack@coa-aio-newton:~$ openstack server lis

openstack@coa-aio-newton:~3 D
Kedua instance telah berhasil dihapus.

7. Menampilkan informasi image pada project yang aktif saat ini sebagai referensi untuk

proses penghapusan dengan mengeksekusi perintah openstack image list.

8. Menghapus image dengan nama cirros-belajar dengan mengeksekusi perintah

openstack image delete cirros-belajar.

openstack@coa-aio-newton:~$ openstack image delete cirre

9. Memverifikasi apakah image dengan nama tersebut telah berhasil dihapus dengan

mengeksekusi perintah openstack image list.
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Terlihat image dengan nama cirros-belajar telah berhasil dihapus.

10. Menampilkan informasi security group pada project yang aktif saat ini sebagai referensi

untuk proses penghapusan dengan mengeksekusi perintah openstack security

group list.

Terlihat terdapat security group dengan nama allow-ssh dan allow-ping.

11. Menghapus dua security group yaitu dengan nama allow-ping melalui mengeksekusi
perintah openstack security group delete allow-ping dan allow-ssh
dengan mengeksekusi perintah openstack security group delete allow-

ssh.

12. Memverifikasi apakah security group dengan nama tersebut telah berhasil dihapus

dengan mengeksekusi perintah openstack security group list.

Security group dengan nama tersebut telah berhasil dihapus.

13. Menampilkan informasi floating IP pada project yang aktif saat ini sebagai referensi untuk

proses penghapusan dengan mengeksekusi perintah openstack floating ip list.
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Terlihat terdapat dua floating IP Address yaitu 172.16.0.123 dan 172.16.0.234.

14. Menghapus floating IP dengan alamat 172.16.0.123 dan 172.16.0.234 melalui eksekusi

perintah openstack floating ip delete 172.16.0.123 172.16.0.234.

openstack@coa-aio-newton:~5 openstack floating ip delete 172.16.0.234 172.16.0.123

15. Memverifikasi apakah floating IP tersebut telah berhasil dihapus dengan mengeksekusi

perintah openstack floating ip list.

5 Jopenstack floating 1ip list

s []

Keseluruhan floating IP telah berhasil dihapus.

16. Menghapus gateway dari router dengan nama router-belajar melalui eksekusi perintah

neutron router-gateway-clear router-belajar.

17. Menampilkan informasi subnet yang terdapat pada project yang aktif saat ini sebagai
referensi untuk proses penghapusan subnet dari router dengan mengeksekusi perintah

openstack subnet list.

Terlihat terdapat subnet dengan nama subnetl-belajar dan subnet2-belajar.
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18. Menghapus kedua subnet dari internal network yaitu dengan nama subnetl-belajar
dengan mengeksekusi perintah openstack router remove router-belajar
subnetl-belajar dan dengan nama subnetl-belajar dengan mengeksekusi

perintah openstack router remove router-belajar subnet2-belajar.

subnet router-belajar subnetl-belajar

subnet router-belajar subnet2-belajar

19. Menghapus router dengan nama router-belajar dengan mengeksekusi perintah

openstack router delete router-belajar.

openstack@lcoa-aio-newton:~5 openstack router delete router-belajar

20. Memverifikasi apakah router tersebut telah berhasil dihapus dengan mengeksekusi

perintah openstack router list.

openstack@coa-aio-newton:~5|openstack router list

openstackflcoa-aio-newton:~5 D

Router tersebut telah berhasil dihapus.

21. Menghapus dua internal network vyaitu dengan nama networkl-belajar dengan
mengeksekusi perintah openstack network delete networkl-belajar dan

network2-belajar dengan mengeksekusi perintah openstack network delete

network2-belajar.

22. Menghapus external network dengan nama provider-network-belajar dengan

mengeksekusi perintah openstack network delete provider-network-

belajar.

23. Memverifikasi apakah keseluruhan network tersebut telah berhasil dihapus dengan

mengeksekusi perintah openstack network list.
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openstack@coa-aio-newton:~$ Jopenstack network list

openstack@coa-aio-newton:~5
Keseluruhan network telah berhasil dihapus.

24. Mengubah cakupan project dari project “belajar-NIM”, sebagai contoh memiliki NIM
dengan nilai 0827068001 maka nama project-nya adalah “belajar-0827068001” ke

project “admin” dengan mengeksekusi perintah source openrc.

openstack@coa-aio-newton:~$[50urce openrc

25. Memverifikasi variable yang telah diatur dengan mengeksekusi perintah export |
grep OS yang menampilkan keseluruhan variable dan melakukan pipeline agar hasil
eksekusi dari perintah sebelumnya dijadikan inputan untuk operasi grep sehingga dapat

memfilter berdasarkan prefix OS.

26. Menghapus user dengan nama “NIM”. Ganti NIM sesuai dengan yang dimiliki, sebagai
contoh bernilai 0827068001 sehingga perintah yang harus dieksekusi adalah

openstack user delete 0827068001".

openstackfcoa-aio-newton:~$ openstack user delete 082

27. Memverifikasi apakah user tersebut telah berhasil dihapus dengan mengeksekusi

perintah openstack user list.

WWW.IPUTUHARIYADI.NET 145



PANDUAN PRAKTIKUM CLOUD COMPUTING BERBASIS OPENSTACK

ain admin

User dengan nama tersebut telah berhasil dihapus.

28. Menghapus project dengan nama “belajar-NIM”. Ganti NIM sesuai dengan yang dimiliki.
Sebagai contoh memiliki NIM dengan nilai 0827068001 maka nama project-nya adalah
“belajar-0827068001”. Perintah yang dieksekusi untuk menghapus project tersebut

adalah openstack project delete belajar-0827068001.

29. Memverifikasi apakah project tersebut telah berhasil dihapus dengan mengeksekusi

perintah openstack project list.

|
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Project dengan nama tersebut telah berhasil dihapus.

|
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